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What’s new in MxMC 2.4?

SSL certificates for cameras
SSL is the standard technology for securing an Internet connection by encrypting the data sent between a 
website and a browser (or between two servers). This function allows an administrator to upload or create a 
SSL certificate to the selected cameras. 
See Managing SSL Certificates, p. 262.

New Histogram
The histogram can now be used horizontally in the bottom bar according to its purpose. The functions are 
the same. 
See The Histogram: Graphical Representation Of The Frequency Distribution Of Events, p. 188.

P7 Apps as Smart Data Source
In MxMC2.4 you are able to detect license plates with the P7 Apps from Vaxtor and FF Group as well as faces 
with the P7 App from Visage.
If a license plate or face is recognized, the user can see the result in a list in the MxMC Smart Data Search 
View.
See Smart Data Settings, p. 250

Custom color schemes and logo
This setting enables you to adapt MxMC optically to your needs. You user can freely select the primary color 
of the headers and the font displayed there. You also can add an individual logo.
See Program Settings, p. 230

What’s new in MxMC 2.4?
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Basics/Introduction
MxManagementCenter- Function Overview

Basics/Introduction 
This chapter provides an overview of the features in MxMC and provides guidance on using the online help. 
You will also find explanations of the program structure and operating concept of MxMC.

MxManagementCenter- Function Overview
MxManagementCenter is a video management software for setting up and using a complete video sur-
veillance system that offers a variety of features for different tasks and user groups:

Area Features

Camera Man-
agement

Unlimited number of cameras, definition of hierarchical camera groups, different system envir-
onments (e.g., with different network addresses)

Live Video 
Surveillance

Display of individual cameras and freely definable grid views (with up to 80 cameras sim-
ultaneously), user-defined graphics and info views, automatic camera switching (camera 
sequencer and group sequencer), multi-monitor support (number of available display devices 
can be further extended with MxThinClient devices), manual recording of live images (live 
recorder)

Alarm Pro-
cessing

Visual and audible alerting to new events, alarm filtering (specific alarms for specific types of 
alarms), background monitoring of cameras

Research, 
Analysis and 
Recording 
Playback

Search and playback for individual cameras in the Playback view, time-synchronized search 
for several cameras simultaneously (grid playback), special search view with the latest alarm 
images of selected cameras, research and playback of data directly using the camera or via dir-
ect connection to the file server, fast display of the latest alarm images during live display 
(instant playback), subsequent distortion correction of hemispheric camera images, special 
search functions (subsequent video motion detection, histogram, Smart Data System) 

Data Export Export of single or multiple time ranges in the recording at the same time, export of the data 
by the camera or via direct connection to the file server, export of individual image areas (sub-
sequent PTZ), export at variable frame rates, resolution with and without audio

Door Station 
Functions

Bell signaling and live two-way communication, open doors and switch lights, play back mail-
box messages

Security 
Functions

Definition of users and user rights, supervisor function (dual control), system security check, 
health check 

Special Pro- Softbuttons for executing special functions, action logs, remote control
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gram Func-
tions

Program 
Operation

Fast switching between different views with different functions, fast display of cameras via 
drag & drop, touchscreen operation supported, various program behavior settings

Camera Feature Overview
MxMC allows MOBOTIX MOVE cameras and third-party cameras providing an ONVIF-compatible interface to 
be integrated and operated. However, the full range of MxMC features is not available for all camera types.
The following table briefly lists the functions that be used with the different camera types.

Function MOBOTIX 
Camera

MOBOTIX MOVE Camera ONVIF Camera

Camera Configuration yes no no

Alarm Processing yes no no

Recording Access unlimited only via MOBOTIX NAS only via MOBOTIX NAS

Recording Playback unlimited only forward playback only forward playback

Export unlimited only as MJPEG and H.264 (H.264 
with corresponding license)

only as MJPEG and H.264 (H.264 
with corresponding license)

Research View yes only for marked events only for marked events

Special Search Functions
        (post-VM, histogram, 
Smart Data)

yes no no

Check System Security yes no no

PTZ Camera 
PTZ

mechanical PTZ mechanical PTZ

Subsequent Equalization of 
Hemispherical Images

yes no no

Live Recorder yes no no

Camera Groups unlimited group functions group functions

Door Station Functions and 
        Switching Functions

yes no no

MxThinClient Devices yes no no

Snapshots yes no no

Basics/Introduction
MxManagementCenter- Function Overview
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Working With The Live View
The Live view allows you to control the live images of individual cameras. This also includes switching vari-
ous functions, e.g, opening doors or switching lights.

Showing Cameras

Fig. 1: Showing cameras

To view a camera, you can use the Device or Camera bar. To do this, either drag and drop the desired camera 
from the Device bar into the display area or click on the desired camera in the Camera bar. The displayed 
camera is marked with a yellow bar in the Device bar as well as in the Camera bar.
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Customizing Image Settings

Fig. 2: Customizing image settings

Use the Brightness  and Contrast  controls to adjust the image display of the displayed camera to the 
current environment.
Move the corresponding slider upwards or downwards. The new settings are stored automatically for the cur-
rent camera. The default values can be restored by double-clicking on the corresponding slider.

Note:
Adjusting the image settings does not have any effect on the camera settings. These will not be changed

Performing PTZ Actions

Basics/Introduction
MxManagementCenter- Function Overview
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Fig. 3: Performing PTZ actions

Note
On a secondary monitor, a single camera image can only be zoomed with the mouse wheel or panned with 
the mouse button pressed down. PTZ controls are only available on the MxMC main screen or on the sec-
ondary monitor in Grid View.

To better identify objects in an image section, you can zoom the live image and move the resulting image 
area around (PTZ). To facilitate quick loading of these image sections, several image positions are already 
pre-configured for loading using the slider .
The program also shows the  slider on Dual cameras. Use this slider to show the live images of either the 
right, the left or both image sensors.
When showing the live images of hemispheric cameras, you can configure different display modes (slider 

Zooming and Moving Image Sections
You can zoom using the slider  or the mouse wheel. Zooming with the slider takes place only on the com-
puter. This means that only the image section of the current live image is modified.
To see other image sections, you can move the live image using the mouse.
If you want to execute the PTZ actions on the camera, you can also switch to camera PTZ. In this case, the 
PTZ actions are applied to the camera's live image and also influence the recordings (but only if the camera 
does not record the full image). To use this feature, click on the slider  and keep it pressed until it starts 
flashing. You can now adjust the zoom level as needed. To store the setting, click again on the slider and 
keep it pressed until the slider stops flashing.

Selecting and Adjusting Image Sections

Selecting Image Sections

To quickly focus on a specific image section, you can use one of the factory default image positions that are 
predefined in the camera. 

 n Preview , detail , overview  and point of interest

 n Top , bottom , left , right

The camera will then move to the selected position. Note that the PTZ actions are executed on the camera 
and also influence the recordings (only if the camera does not record the full image).   Move the  slider to 
the next position or until you have found a suitable position.

Adjusting Image Sections

You can adjust the pre-defined image positions of the factory default. Select a position and modify it as 
needed. Keep the slider on this position until it flashes once. The new image section has been stored.
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Choosing a Sensor
If you want to show the live images of only the right or the left image sensor, you can move the  slider to 

the right to  (left sensor) or further to the right to  (right sensor).

Correcting The Distortion Of Hemispherical Images
When showing the live images of hemispheric cameras or cameras with the lenses L12/B016, L23/B036, 
L25/B041, you can select different display modes. This requires that you enabled OpenGL in the settings 
(Mac: MxManagementCenter > Settings > General menu; Windows: File > Settings > General menu). In 
order to get naturally-looking images, the camera will automatically correct the distortion in these modes. 
This distortion correction can be refined even further when using the panorama correction. The selection of 
a display mode is always done locally and thus does not influence the camera settings. However, the selec-
tion is also applied to the other program views. When selecting a display mode in the live view for a specific 
camera, this mode is also applied if the camera shows up in the focus window of the Grid view as well as in 
the live images of the Graphic view. Consequently, the alarm images in the Alarm bar and in the Research 
view are also shown in the selected display mode.

Selecting The Distortion Correction Mode

 n Full image: Shows the entire (distorted) full image.

 n Normal: Shows a distortion-corrected image and allows executing PTZ actions. 

 n Panorama: Shows the entire distortion-corrected image (corrected 180° panorama) from the left to 

the right border. The aspect ratio (width to height) is 8:3. 

 n Surround: This option shows four image sections (one for each cardinal direction: N, E, S, W) in one 

joint view. Note that you can use PTZ actions to modify all four views independently from one 
another.

 n Double panorama: This mode shows a panorama view for the North half of the image and a second 

panorama view of the South half of the image using an aspect ratio (width to height) of 4:3. This mode 
makes sense for a hemispheric camera that is mounted to the ceiling. It can be customized sub-
sequently using local PTZ.

 n Panorama focus: This display mode combines the panorama view (aspect ratio 8:3) with two smal-

ler images (each with aspect ratio 4:3) in one large image.

To select a mode, move the slider  to the right until you reach the desired position. This slider position 
will be stored automatically until you change it again.

Panorama Correction

The distortion-corrected images of the different display modes can be further refined. For example, if the 
image in Panorama mode is not centered, you may see a trapezoidal distortion. The panorama correction 
allows adjusting the skewed (vertical) lines of the image to produce a more naturally-looking image. To do 

Basics/Introduction
MxManagementCenter- Function Overview
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so, move the  slider to the right to  and use the mouse to correct the image. To store the corrected set-
ting, click on the  slider and hold it until the slider icon briefly appears in the center of the image.

Status Display
The Status bar displays different states by means of icons. The status displays always refer to the displayed 
camera. This gives you an up-to-date overview, e.g., showing you at a glance whether a door has been closed 
again or is still open.

Fig. 4: Status display

Door Status Dis-
play

 = door is closed.
 = door is open.
 = door is locked.
 = door lock switch is locked, but the door is open! 

Light Status Dis-
play

 = light is off.
 = icon is lit: Lights are on, need to be switched off manually. 

Microphone 
Status Display

 = microphone is switched off, no announcement possible.
 = microphone is on, announcements are possible.
 = microphone connection is blocked, possibly because a connection has been estab-

lished to a different remote station. 

Switching additional devices via hyperlink
Hyperlinks can be used to switch additional devices or to send HTTP requests. When defining hyperlinks, you 
can select an individual button icon for the hyperlink (there are several pre-defined icons to choose from) or 
set one button from which to run all hyperlinks.
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Fig. 5: Switching additional devices via hyperlink

To define a hyperlink, right-click on  and then on .
In case you did not assign an icon for the individual hyperlinks, they will be combined under one  button. 
To execute such a hyperlink, click on  and then on the name of the desired hyperlink.

Manually recording live images
In the Live view as well as in the Grid view, you can start manual recording at any time, such as when you 
observe a suspicious situation that should be recorded. While you keep track of the situation in the live 
image, the images are recorded and saved as a MXG file. 
   Users with administrator rights can specify where the clips are saved and how long the recordings can be in 
the Program Settings (Mac: menu: MxManagementCenter > Preferences > Live Recorder, Windows menu: 
File > Settings > Live Recorder).

Notes:
This feature is not supported by MOBOTIX MOVE cameras and third-party cameras that provide an ONVIF-S 
compatible interface. For an overview of how the camera functions differ, see Camera Feature Overview.             

Audio can only be recorded with the Live Recorder under these conditions:

 n Audio transmission must be activated on the camera side.

 n In the Live View of the MxManagementCenter, the audio connection must be activated by clicking on 
.

Basics/Introduction
MxManagementCenter- Function Overview
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Fig. 6: Manually recording live images

Starting And Stopping Recordings

To start recording, click on Live Recorder . Recording will stop automatically after the recording time set 
in the program settings has expired. Just before this time expires, a message will be displayed. You can stop 
the recording from within this message or extend the set period of time. To stop recording before the time 
expires, click on  again.

 Note
If you change the view, the recording is automatically stopped. However, a camera change within the Live 
view does not stop the recording.

Play Clip

The live image data is stored in a MXG file at the location specified in Program Settings during recording. The 
clip file is automatically imported into the current project when the recording stops and the Device bar 
shows it alongside the  icon in the Clips section. You can click on the clip name to playback the MXG clip 
file via the Device bar.             

Working With the Graphic View
You can define a floor plan (ground plan) in the Graphic view and place the cameras or camera groups 
according to their actual positions. The icon of the corresponding camera turns red in case of an alarm (or 
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green upon a bell event). A simple click is enough to show the current live image of the triggering camera, 
allowing you to quickly check the situation.

Temporarily showing the live image of a camera
To temporarily display the live image of a camera, move the mouse pointer over the camera icon. In addi-
tion, the live image of another camera group can also be displayed in the Graphic view. Drag & drop the 
desired camera from the Camera bar onto the floor plan. When changing the view, the live image disappears.

Automatically display all live images of a group
To keep track of all live images in the current group, you can activate the camera sequencer or the group 
sequencer. When the sequencer is activated, all live images of the camera group are displayed one after 
another in a small window. You can move this window to any location and enlarge it or make it smaller. 

Camera Sequencer
If you want to see a different camera in the focus window, simply drag that camera to the focus window. 
Note that the camera sequencer can also switch cameras automatically.

Instructions:

 1. Click on the camera sequencer icon  to activate the automatic switching. 

 2. Right-click on  to change the following settings:

 n Duration Slider: Move the slider to the desired duration (1 sec to 60 sec) to show each camera.

 n Autostart: Once you switch to the Grid view, the sequencer starts automatically.

 n Stop at event: The sequencer stops when an event has occurred, allowing you to further investigate 
the situation. To start again, click on .

 n Restart after confirmation: Activate this option if you want to avoid having to restart the sequencer 
over and over again.

Group Sequencer
If you want to display a different camera group in the focus window, drag and drop that camera group into 
the focus window. A grid with all cameras of the group will be displayed and each camera of the group will 
be shown sequentially in the grids focus window for a defined time. You can automate this camera group 
change with the group sequencer.

Instructions:

 1. Click on the group sequencer icon  to activate the group sequencer.

 2. To change the sequencer settings right-click on :

Basics/Introduction
MxManagementCenter- Function Overview
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 n Duration: set the duration to show each group. You can set a value between 1 sec and 60.  The “Com-
bined Sequencer”  activates the group sequencer together with the camera sequencer (“Autostart” on 
the camera sequencer is not needed). The group sequencer waits until all cameras on a grid or graphic 
have been cycled before switching to the next group. When the “Combined Sequencer” is active then 
the camera sequencers “Stop at Event” and “Restart after Confirmation” also apply to the group 
sequencer.

 n Autostart: Once you switch to the Grid view, the group sequencer will start automatically.

Switching group functions
At the bottom of the program window is a Command bar with controls that change depending on the selec-
ted view. In the Graphic view, you can use the group buttons of the Command bar to control the functions of 
a camera group (Prerequisite: Group functions were assigned in the Group Functions dialog box). This means 
that you can switch on/off lights, open a door and make an announcement for a predefined camera of this 
group, regardless of the currently displayed camera. You can also assign the functions for switching on/off 
lights and opening doors to several cameras of this group, enabling you to switch on/off several lights or 
open several doors.
    In addition, you can right-click on the group buttons to open the shortcut menu in order to control cameras 
that are not part of the current group. Before you can do this, the cameras have to be set up accordingly, 
that is, they need to be connected to door openers/light contacts and have to be configured properly.

Fig. 7: Switching group functions

Searching And Playing Back In Playback View
Recorded clips cannot only be played in the player, but they can also be searched. The way that you search 
depends on whether you want to search for specific events within the recorded clips or whether you want to 
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search for events at specific times.

General Playback View controls

Fig. 8: General playback view controls

To search and play back recordings, first activate Playback mode  or select the date and time and then 
use the Previous/Next Image buttons , to browse the recordings; alternatively, you can start the play-
back using the Forward/Backward Playback buttons . Hold the Forward/Backward Playback to 
select a playback speed between 0.5 times and maximum.

Basics/Introduction
MxManagementCenter- Function Overview
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General operation of the Playback View for MOBOTIX MOVE and ONVIF 
cameras

Fig. 9: General operation of the Playback View for MOBOTIX MOVE and ONVIF cameras

Note
all playback capabilities are supported by MOBOTIX MOVE cameras and third-party cameras that provide an 
ONVIF-S-compatible interface. For these cameras, recordings can only be played forward.
    Therefore, first select Date/Time ① , and then start playback using Forward Playback  ② .

Performing PTZ actions in recordings
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Fig. 10: Performing PTZ actions in recordings

Note
On a secondary monitor, a single camera image can only be zoomed with the mouse wheel or panned with 
the mouse button pressed down. PTZ controls are only available on the MxMC main screen or on the sec-
ondary monitor in Grid View.

You can zoom and move the visible image area not only in live images but also in recorded images (PTZ). 
This enables you to examine specific image areas more closely while the recorded video stream is playing 
back. On Dual cameras, the program also shows the  slider. Use this slider to show the images of either 
the right, the left or both image sensors. When playing back the recordings of hemispheric cameras, you can 
set different display modes .

Zooming and moving image sections
You can zoom using the slider  or the mouse wheel. To see other image areas, you can move the recorded 
image using the mouse.

Choosing a sensor 
On Dual cameras, you can opt to see the recordings of the right, the left or both image sensors. To do so, 
move the  slider to the right to  (left sensor) or further to the right to  (right sensor).

Subsequent distortion correction of hemispherical images
When showing recorded images of hemispheric cameras or cameras with the lenses L12/B016, L23/B036, 
L25/B041, you can select different display modes. In order to get naturally-looking images, the camera will 
automatically correct the distortion in these modes. This distortion correction can be refined even further 
when using the panorama correction. Note that this type of correction only takes place locally. This means 
that the distortion correction of the recorded images only takes place on this computer. The stored record-
ings (from the camera or a file server) are not influenced in any way.

 n Full image: Shows the entire (distorted) full image.

 n Normal: Shows a distortion-corrected image and allows executing PTZ actions.

 n Panorama: This option shows the distortion-corrected image of an entire room (corrected 180° pan-

orama view) from the left to the right wall. The aspect ratio (width to height) is 8:3. 

 n Surround: This option shows four image sections (one for each cardinal direction: N, E, S, W) in one 

joint view. Note that you can use PTZ actions to modify all four views independently from one 
another.

 n Double panorama: This mode shows a panorama view for the North half of the image and a second 

panorama view of the South half of the image using an aspect ratio (width to height) of 4:3. This mode 
only makes sense for a hemispheric camera that is mounted to the ceiling.

 n Panorama focus: This display mode combines the panorama view (aspect ratio 8:3) with two smal-

ler images (each with aspect ratio 4:3) in one large image.

Basics/Introduction
MxManagementCenter- Function Overview
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Selecting The Distortion Correction Mode

Move the slider  to the right until you see the desired view. This slider position will be stored auto-
matically until you change it again.

Panorama Correction
The distortion-corrected images of the different display modes can be further refined using the panorama cor-
rection. Move the  slider to the right to  and use the mouse to correct the image. To store the corrected 
setting, click on the  slider and hold it until the slider icon briefly appears in the center of the image.

Browsing recordings for event images
When searching for event images, first select the image playback type:

 n Event images: Only shows event images.

 n Pre-event images: Shows only the first recorded image for each event.

 n Highlighted images: Shows only the images, which had been marked as important before.

Note
This feature is not supported by MOBOTIX MOVE cameras and third-party cameras that provide an ONVIF-S-
compatible interface. For an overview of how the camera functions differ, see Camera Feature Overview.

Fig. 11: Browsing recordings for event images

 1. In the Playback view, select the Playback mode by right-clicking on  ①and selecting the desired mode 

② .
 2. Browse the recordings using the  and  buttons. Starting with the current event image, these buttons 

show the previous or next event image.
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Browsing recordings for a specific date and time
If you have set up a continuous recording for certain times and you want to check for events during those 
times, for example, you can limit the search to these times. You can search for events at a given time by 
using time leaps or time-lapse playback.

Searching for a specific date and time

Fig. 12: Searching for a specific date and time

 1. Click on Date/Time ①  and enter the date and time to search for.
 2. The event image jumps to the event in the recordings that is closest to the specified date and time.
 3. Click on Playback .

     or     

 1. Click on the Calendar slider ② . The date and time will be shown above the slider. 
 2. Move the slider until you reach the date and time that is closest to the point in time you want to exam-

ine. The event image jumps to the event in the recordings with the specified date and time. If such a 
recording is not available, the event image jumps to the event that is closest to the specified point in 
time (in the direction of searching). In the latter case, the slider turns read the time difference to the spe-
cified point in time is shown above the slider.

 3. Click on Playback .

Note
The farther away you move the mouse pointer from the slider, the more precise your setting will be.

Basics/Introduction
MxManagementCenter- Function Overview
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Searching Several Cameras For Persons Or Objects
Scenario: Camera A is overlooking the gate and signals an event. The event image in the Alarm bar shows a 
delivery truck driving through the gate. You want to know if the truck has also passed the area monitored by 
camera B.

 1. To do so, move the mouse pointer over the event image. Three icons are shown. 
 2. Open the Playback view mode by clicking on .

 3. Play back the recording (end of recording) ① .

Fig. 13: Playback the recording

 4. Drag&drop camera B from the camera bar into the Playback view.
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 5. The playback automatically selects the recording that follows the end of camera A's recording ② . You 
can continue this process for any number of cameras.

Investigating Multiple Cameras For A Specific Point In Time
You want to know if other cameras have recorded something at a specific point in time:

 1. Set the reference time using the Pin button ① .
 2. Drag the cameras from the Camera bar ②  one by one.
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 3. The application shows the event images of each camera that are closest to the specified point in time.

Limiting The Search Range For An Incident
Scenario: Your camera monitors a parking lot from which a car had been stolen during the day. Follow these 
steps to locate the event as quickly as possible:

 1. Start the Playback mode (right-click on ) and select an interval (e.g., 1 day ).

 2. Keep clicking on Previous Image  until the car can be seen again in the image.

 3. Now select a shorter interval (e.g., 1 hour ).

 4. Keep clicking on Next Image  until the car has left the frame.

 5. Keep on using shorter intervals until you have found the exact point in time of the incident.

Note
You can also use the Forward/Backward Playback  /  buttons to play back using the same time 

leaps.

30 / 375



Note
This feature is not supported by MOBOTIX MOVE cameras and third-party cameras that provide an ONVIF-
compatible interface. For an overview of how the camera functions differ, see Camera Feature Overview.

Playing Back Recordings

Playing Clips

To play the clips, the play buttons  and the       playback mode are available in the Command bar of 
the Playback view. First set the desired mode for playing the recordings, such as event images only or with 
one hour time-lapse, in the Playback mode. 
    Next, use the Playback Buttons to browse and play back the images one-by-one  or continuously 

 in backward or forward direction.
Note: As mentioned in General Operation Of The Playback View For MOBOTIX MOVE And ONVIF Cameras, 
playback of recordings is limited when using MOBOTIX MOVE cameras and third-party cameras that provide 
an ONVIF S-compatible interface. Recordings of these cameras can only be played forward. For an overview 
of how the camera functions differ, see Camera Feature Overview.
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The following table summarizes the actions that you can perform with the playback buttons, depending on 
the playback mode:

Playback Mode Playback Buttons

Complete Record-
ings 

Jumps one image backward/forward.

Plays back all recordings backward/forward.

Event Recording Jumps to the end/the start of the recorded sequence.

Plays back until the start/the end of the recorded sequence has been 
reached.

Event Images Shows the previous/next image every time you click on the button.

Pre-alarm Images 

Highlighted Images The previous/next images are shown automatically one after the 
other. 

1 day time lapse 

1 hour time lapse 

10 minute time 
lapse

1-minute time 
lapses
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Setting The Playback Speed

The Playback Speed option  allows you to speed up or slow down the playback of a recording. This also 
applies if you play back a recording backward. 

 1. Click on Playback Speed. The background of the button turns dark gray.
 2. To play the recording forward, left-click and hold the left mouse button and move the mouse pointer to 

the right. The further you move the mouse pointer down (to the right), the faster the playback speed. 
 3. To play the recording backward, left-click and hold the left mouse button and move the mouse pointer 

to the left. Again, the further you move the mouse pointer down (to the left), the faster the playback 
speed.

Precise Positioning by Image

If you want to examine a scene very closely, you can view the recordings one image at a time. To do so, stop 
playback (click on  or ). Now use the two buttons  (forward) and  (backward) to navigate the 
images one by one.

Exporting Recordings
Using the Playback view, you can export recorded video data from one camera, while the Grid Playback 
allows exporting from several cameras at once. Use the Export bar to combine several clips to one export. 
You can save individual images with the Snapshot function.
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Saving Snapshot Images
Snapshot images can be created in the Live and the Playback views for the displayed camera, and in the Grid 
view and Grid Playback for all displayed cameras.

Fig. 14: Saving Snapshot Images

To do so, click on the Snapshot  button in the Command bar. By default, images are saved in the image 
folder of the user account. The destination path and the image settings for saved images can be selected via 
the MxManagementCenter > Settings > Snapshot Images (Mac) or File > Settings > Snapshot Images 
(Windows) menu item.

Exporting Camera Recordings
The Playback view allows setting a time range for a recording (event recording or continuous recording) in 
order to select it for exporting.

 1. Open the Playback view.
 2. Drag the desired camera from the Camera bar or the Device bar.
 3. Find the start of the relevant recording.
 4. Specify the export range. There are two possibilities for this export:

Select export range using visual markers:

 1. Mark the start of the clip by clicking on the gray flag on the left .

 2. Play the recording until you have reached the end of the clip you want to export. Mark the end of the 
clip by clicking on the gray flag on the right. Both flags are now green.

 3. Click on Export  and select the export profile.
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 4. The Export dialog box appears. Select a target folder and enter a file name.

Manually capture export range:
First, make sure that no export area has yet been set using the "export flag." If an export area has already 
been defined, you can delete it. Do so by right-clicking on a flag and selecting Delete Time Range.

 1. Click on Export . Then click on the desired export profile ① . The dialog box used for defining the 

export range appears.
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 2. Specify the export range ② .
 3. Click on OK and then on Save.

Note
If you select the Automatically Import After Export checkbox in the Export dialog, the exported clip will 
be automatically added to the Camera bar and in the Device bar to the Clips & Recordings section.

Exporting Camera Group Recordings
The Grid Playback allows for setting a time range for a recording (event or continuous recording) in order to 
select it for exporting from multiple cameras.

 1. Open the Grid Playback.
 2. Drag & drop the desired camera group from the Group bar or the Device bar.
 3. Find the start of the relevant recording for the camera in the focus window. At the same, the search is 

extended to the other cameras in the group, and the recordings with the closest relevance to those in the 
focus window recording will be displayed in the tiles.

 4. Specify the export range. There are two possibilities for this export:

Select export range using visual markers:

 1. Mark the start of the clip by clicking on the gray flag on the left .

 2. Play the recording until you have reached the end of the clip you want to export. Mark the end of the 
clip by clicking on the gray flag on the right. Both flags are now green.

 3. Instead of exporting all cameras of this group, you can also select one or more cameras for exporting. To 
do so, right-click on Export . A circle appears on the camera images in the top left corner. Select the 

desired cameras by clicking on the corresponding circles ① .
 4. Then click on Export  and select the export profile ② . The Export dialog box appears.
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Fig. 15: Select export range using visual markers

 5. Select a target folder and enter a file name.

Manually capture export range:
Make sure that no export area has yet been set using the "export flag." If an export area has already been set, 
you can delete it. Do so by right-clicking on a flag and selecting Delete Time Range.

 1. Before you define the export range, you can limit the selection if you do not want to export all of the 

recordings that appear in the tiles. To do so, right-click on Export . A circle appears on the tiles in the 

top left corner. Select the desired cameras by clicking on the corresponding circles ① .

 2. Click on Export  and select the export profile ② . The dialog box used for defining the export range 

appears.
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Fig. 16: Manually capture export range

 3. Specify the export range ③ .
 4. Click on OK and then on Save.

Note: Automatic Import
    If you activate the Automatically Import After Export option, the exported clips are automatically added 
to the Group bar.

Exporting Recordings From The Export Bar
The Export bar provides a quick and easy way to take camera recordings and MXG clips by dragging and drop-
ping and create a list of recordings for subsequent exporting. From the bar, you can export recording time 
ranges as combined clips. You can add the clips in the Playback view, in Grid Playback, in the Research view 
and in the Retail view. After an export, the clips are not deleted automatically. It is deleted when the pro-
gram is closed.

Adding Clips for Exporting in the Playback View

 1. Drag the desired camera or the desired clip from the camera bar or from the Device bar.
 2. Find the recording you are interested in.
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Fig. 17: Adding Clips for Exporting in the Playback View

 3. Mark the start of the time range by clicking on the gray flag on the left . Play the recording until you 

have reached the end of the clip you want to export. Mark the end of the time range by clicking on the 

gray flag on the right . Both flags are now green ① .

     You can set the end marker first (gray flag on the right), then play the recording from the beginning so 
you can set the start marker (gray flag on the left) at the desired point.

 4. Click on the image of the recording and maintain the position until you see a scaled-down image of the 
recording ② .

 5. Drag this image to the Alarm bar (regardless of whether or not it is open). The Export bar will open auto-
matically, allowing you to save the image there.

Adding Clips for Exporting in Grid Playback
The Export bar in Grid Playback is useful for combining sequential time ranges of different cameras.

 1. Drag the desired camera to the focus window in the grid and find the relevant recording.

 2. Mark the start of the time range by clicking on the gray flag on the left . Play the recording until you 

have reached the end of the clip you want to export. Mark the end of the time range by clicking on the 

gray flag on the right . Both flags are now green.

 3. Click on the image of the recording in the focus window and maintain the position until you see a 
scaled-down image. Drag this image to the Alarm bar (regardless of whether or not it is open). The Export 
bar will open automatically, allowing you to save the image there.
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 4. After you have set the end marker of the time range, the recordings of all other cameras will reposition to 
show the same time. Drag the camera with the next recording in the sequence of events into the focus 
window. Mark the start and the end of the clip as described above, then drag the recording into the 
Export bar.

 5. Repeat these steps until you have added all recordings you want to export.

You can also add time ranges from several cameras in the Export bar.

 1. Simply drag the desired camera group from the Group bar or from the Device bar and search for the rel-
evant recording.

 2. Mark the start and the end of the clip as described above. The recordings of the other cameras will repos-
ition accordingly.

 3. Right-click on Export . A selection box with a checkmark appears in the top left corner of the record-

ings. If you do not want to add the recording range of a specific camera to the list, uncheck the selection 
box for that camera.

 4. Click on the image of the recording in the focus window and maintain the position until you see a 
scaled-down image. Drag this image to the Alarm bar (regardless of whether or not it is open). The Export 
bar will open automatically, allowing you to save the image there. The selected clips will be copied to 
the Export bar.

 5. Repeat these steps until you have added all time ranges you want to export.

Adding Clips for Exporting in the Research View
In the Research view, you can add recorded event sequences to the list. The length of the event sequences is 
currently 10 seconds. 

 1. Set filters by camera, by group or by event type as needed.
 2. Right-click on Export . A selection box appears on the event images in the top left corner. Select the 

desired events by clicking on the corresponding selection boxes.
 3. Open the Export bar by clicking on the lower frame border of the open Alarm bar. Click on an event 

image and maintain the position until you see a scaled-down event image. Drag this image to the Export 
bar. The clips of all selected event images are added to the Export bar.      (An alternative option is: In the 
Export bar, click on . The clips of all selected event images are added to the Export bar.

 4. If needed, you can set new filters and add more event images to the Export bar.

Adding Clips for Exporting in the Smart Data View
You can add clips for the individual Smart Data transactions to the Export bar. The default clip length is ten 
seconds on either side of the transaction time stamp, that is, for a total of 20 seconds.

 1. Right-click on Export . A selection box appears on the preview images in the top left corner. Select 

the desired transactions by clicking on the corresponding selection boxes.
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 2. Open the Export bar by clicking on the lower frame border of the open Alarm bar. Click on an preview 
image and maintain the position until you see a scaled-down preview image. Drag this image to the 
Export bar. The clips of all selected preview images are added to the Export bar.      An alternative option is: 
In the Export bar, click on . The clips of all selected preview images are added to the Export bar.

You can also add clips for the individual preview images of the selected transaction to the Export bar:

 1. Drag the transaction preview image in the Preview Image section and drop it on the Export bar.

Editing Clips
If you have added a recording to the Export bar for which you previously used distortion correction or zoom 
features during playback, you can choose to export the clip with or without zoom. Likewise, you can export 
the clip with or without audio. To do so, move the mouse pointer over the recording in the Export bar. Three 
icons appear:

 

 n : Clip is exported with zoom.

Click on  to export the clip without zoom. The icon is disabled.

 n : By default, the clips are exported with audio (provided that audio had been recorded).

To export without audio, click on . The icon is disabled.

 n : Note that you can play back the individual clips directly in the Export bar before exporting.

Click on   to do so.

Right-click on a clip to open a context menu with these functions: Manually adjust time range, activ-
ate/deactivate audio and zoom for all clips, duplicate a clip, delete one or all clips.
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Exporting Clips
Click on Export , then select MOBOTIX to export an MXG clip. Select a different profile to create an AVI, 
MP4 or MKV file. However, depending on the data source (e.g. MOBOTIX NAS) not all export profiles are avail-
able.
    Select a destination path in the Export dialog and enter a file name. Activate the Automatically Import 
After Export checkbox in the file selection dialog to automatically add the MXG clips to the Export bar after 
exporting.

Operate Door Stations
Door Stations can also be integrated and operated with the MxManagementCenter. For this purpose, Door Sta-
tion-specific functions are provided in addition to the program functions for cameras.

Note
Door Station functions are not supported by MOBOTIX MOVE cameras and third-party cameras that provide 
anONVIF S-compatible interface. For an overview of how the camera functions differ, see:   

 n Camera Feature Overview, p. 13.

 n Door Station Settings, p. 207

Bell Signaling
If someone rings the doorbell, it can be indicated in different places of the application.

42 / 375



Where? Explanation

Alarm bar 
and Alarm 
Info bar

A bell event is indicated by coloring the Alarm and Alarm info bar green. The prerequisite for 
this is that the Door Station bell events have been configured as alarms in the Camera Con-
figuration dialog. The Alarm bar ①  is located at the bottom of the MxManagementCenter and 
the Alarm Info bar ②  below the camera image of the corresponding door camera.

Basics/Introduction
MxManagementCenter- Function Overview

43 / 375



Basics/Introduction
MxManagementCenter- Function Overview

Where? Explanation

Doorbell 
notification

When the bell is rung, a ringing notification is displayed, no matter which view you are in. The 
prerequisite for this is that the Door Station bell events were configured as alarms in the Cam-

era Configuration dialog and that the Notification  was not deactivated in the header.

Note
The notification can be temporarily disabled by an administrator by clicking on Notification

 in the application header.

Counter on 
the bell 
icon

The counter next to the bell icon  in the Live view is increased by one.
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Where? Explanation

Setting Bell Signaling

Go to Door Station Settings, p. 207 to find out which signaling options can be combined and where they can 
be configured.

Open Door and Switch Lights
If the door camera has been set up properly, you can use MxMC to open the door and to switch the lights. To 
do this, use the  and  keys in the Live view Command bar and in the Command bar of the Grid view 
focus box.

Checking System Security
After completing the basic configuration of the system, you can check its security. The Wizards & Tools, p. 
256 view offers the Secure System wizard. It analyzes the security of the cameras and assesses their status 
based on common best practices. If test criteria are not met, possible measures to protect the cameras are 
provided. 

Note
The system security check feature is not available for MOBOTIX MOVE cameras and third-party cameras 
that provide an ONVIF S-compatible interface. For an overview of how the camera functions differ, see    Cam-
era Feature Overview, p. 13   .
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Verifying Settings for System Security

 1. To open the Wizards & Tools view, right-click on the navigation key in the Command bar. Select the 
Wizards & Extras view.

 2. Select the desired camera or camera group in the Device bar or the Camera/Group bar.
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 3. Click Secure System. The following criteria are checked:
 n Usage of the "meinsm" password with standard or ONVIF user accounts on MOBOTIX cameras. It is 

easy for cyber attackers to guess the standard "meinsm" password.

 n Enabled Public Access: If Public Access is enabled, a number of different camera functions can be 
used without a password.

 n Activated HTTP web server: It is possible for data, including user data such as passwords and images, 
to be transmitted via the network without encryption when HTTP is used. 

The result of the check is displayed for each camera in the Secure System dialog. It will also show all cases 
in which cameras were not checked due to a connection error, for example.

Status Explanation

 Not secured There was at least one criterion that was listed as not secure.

 Software too old Please check the camera software and update it, if necessary.

 Connection error Check your network connection to the camera and perform the security check again. 

 Not supported The camera (s) cannot be analyzed or secured using the wizard.

 Secured Camera is secure; no further action is necessary.

Secure System

 4. In the Secure System dialog, click on Next. Cameras resulting in a Not secure status are displayed 
together with whichever of the three criteria that were fulfilled as well as the measures that need to be 
taken to properly secure the cameras: 
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Criterion Explanation

Password Changes the password of all user accounts on the cameras that use the standard “meinsm” pass-
word. It also include ONVIF users whose passwords have never been changed.
      Enter a new password and confirm it. A suitable password has at least eight characters. It can 
consist of lowercase and uppercase letters, digits and special characters (see ). If you set a 

password that does not meet these criteria, a red frame appears around the text field. The frame 
turns green once you have entered a valid password.
     The new password is automatically entered in the MxMC project data. 

SSL 
encryption

Disables camera connections via unencrypted HTTP and configures the cameras to accept 
HTTPs connections only.
      The TCP port and the SSL setting will be automatically updated in the MxMC project data, if 
necessary. 
      The TCP port will not be updated for cameras that are connected via a remote URL. For remote 
URL connections, you may need to change port forwarding in the router to the appropriate set-
ting.
Please note that different services, such as network messaging etc., will no longer work when 
you disable HTTP. 

Public 
Access

Disables access that does not require password entry to the web interface and the APIs of the 
cameras. 

 5. Click on OK in the dialog box. The selected security measures will be performed. The security status for 
the selected camera or camera group will be analyzed once again and the result for each camera is dis-
played. 

Working With The Grid View
The Grid view consists of a grid of live images and one focus window. This grid (tile) structure is ideal for get-
ting a quick overview of all cameras of a group. You can drag the camera image that is most interesting to 
you onto the focus window. Use the controls at the bottom to operate the camera.

Showing a group
To view another group, you can use the Device bar or the Group bar. To do this, either drag and drop the 
desired group from the Device bar into the display area or click on the desired group in the Group bar. The 
displayed group is indicated by a yellow bar in the Device bar as well as in the Group bar.
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Fig. 18: Showing a group

Working With The Focus Window
At the bottom of the focus window is a Command bar with controls that allow you to operate the camera in 
the focus window. If you move the mouse pointer over the Command bar, further controls are displayed.

  
Fig. 19: Camera in a focus window

Zooming And Moving Image Sections

Use the slider  to zoom. The zoomed image sections can then be moved with the mouse. These actions 
take place in the application. This means that only the image section of the current live image is modified. 
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The camera will not move and therefore zooming will not affect the possible recording of the generated cam-
era image. 

 1. Drag the slider  to zoom in on or out of the live image.

 2. Move the image with the mouse to focus on individual image sections.

Select predefined image sections.

To quickly focus on a specific image section, you can use one of the factory default image positions that are 
predefined in the camera.

 n Overview , point of interest , preview  and detail view 

 n Top , bottom , left , right 

Move the slider Standard  to the next position or until you have found a suitable position. 

Accept and end calls.

To talk to visitors at the door, click on . To end an audio connection, click on .

Opening Doors And Switching Lights

If a camera is connected to a door station and has been configured accordingly, you can open the door by 
clicking on . If the camera is also connected to a light switch and configured accordingly, the light can be 
turned on and off by clicking on .

Show Temperature

MOBOTIX cameras have a built-in temperature sensor that measures the temperature inside the housing. If 
an ExtIO module or an MX-GPS-Box is connected to the camera, you can also measure the ambient tem-
perature of the module or the box and view it by clicking on .

Executing Hyperlinks

If hyperlinks have been defined and configured, their function can be executed by clicking on .

Camera Sequencer

If you want to see a different camera in the focus window, simply drag that camera to the focus window. 
Note that the camera sequencer can also switch cameras automatically.
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Instructions:

 1. Click on the camera sequencer icon  to activate the automatic switching. 

 2. Right-click on  to change the following settings:

 n Duration Slider: Move the slider to the desired duration (1 sec to 60 sec) to show each camera.

 n Autostart: Once you switch to the Grid view, the sequencer starts automatically.

 n Stop at event: The sequencer stops when an event has occurred, allowing you to further investigate 
the situation. To start again, click on .

 n Restart after confirmation: Activate this option if you want to avoid having to restart the sequencer 
over and over again.

Group Sequencer

If you want to display a different camera group in the focus window, drag and drop that camera group into 
the focus window. A grid with all cameras of the group will be displayed and each camera of the group will 
be shown sequentially in the grids focus window for a defined time. You can automate this camera group 
change with the group sequencer.

Instructions:

 1. Click on the group sequencer icon  to activate the group sequencer.

 2. To change the sequencer settings right-click on :

 n Duration: set the duration to show each group. You can set a value between 1 sec and 60.  The “Com-
bined Sequencer”  activates the group sequencer together with the camera sequencer (“Autostart” on 
the camera sequencer is not needed). The group sequencer waits until all cameras on a grid or graphic 
have been cycled before switching to the next group. When the “Combined Sequencer” is active then 
the camera sequencers “Stop at Event” and “Restart after Confirmation” also apply to the group 
sequencer.

 n Autostart: Once you switch to the Grid view, the group sequencer will start automatically.

Switching group functions
At the bottom of the program window is a Command bar with controls that change depending on the selec-
ted view. In the Grid view, you can use the group buttons of the Command bar to control the functions of a 
camera group (Prerequisite: Group functions were assigned in the Group Functions dialog box). This means 
that you can switch on/off lights, open a door and make an announcement for a predefined camera of this 
group, regardless of the currently displayed camera. You can also assign the functions for switching on/off 
lights and opening doors to several cameras of this group, enabling you to switch on/off several lights or 
open several doors. 
    In addition, you can right-click on the group buttons to open the shortcut menu in order to control cameras 
that are not part of the current group. Before you can do this, the cameras have to be set up accordingly, 
that is, they need to be connected to door openers/light contacts and have to be configured properly.
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Fig. 20: Switching group functions

Manually recording live images
In the Grid view as well as in the Live view, you can start manual recording at any time, such as when you 
observe a suspicious situation that should be recorded. While you keep track of the situation in the live 
image, the images are recorded and saved as an MXG file. The camera's live image that is in the focus win-
dow is always recorded. For this reason, live recording can also only be used in the Grid view when there is a 
focus window.
     Users with administrator rights can specify where the clips are saved and how long the recordings can be in 
the      Program Settings, p. 230     (Mac: menu: MxManagementCenter > Preferences > Live Recorder, Windows 
menu: File > Settings > Live Recorder). 

Note
     This feature is not supported by MOBOTIX MOVE cameras and third-party cameras that provide an 
ONVIF S-compatible interface. For an overview of how the camera functions differ, see      Camera Feature Over-
view, p. 13     .
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Fig. 21: Manually recording live images

Starting And Stopping Recordings

To start recording, click on Live Recorder . Recording will stop automatically after the recording time set 
in the program settings has expired. Just before this time expires, a message will be displayed. You can stop 
the recording from within this message or extend the set period of time. To stop recording before the time 
expires, click on  again.

Note
    The recording ends automatically when switching to another view. However, changing the group within 
the Grid view will not result in an early termination of the recording, unless that group has no focus win-
dow. In the latter case, the recording will end. 

Play Clip

The live image data is stored in an MXG file at the location specified in Program Settings during recording. 
The clip file is automatically imported into the current project when the recording stops and the Device bar 
shows it alongside the  icon in the Clips section. You can click on the clip name to playback the *MXG clip 
file via the Device bar. 

About The MxManagementCenter Online Help
The online help introduces you to the concept and features of MxMC and helps you with any questions or 
issues that may arise while working with MxMC. The online help generally refers to the full range of functions 
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of the application, even if individual functions may not be available to all users. The online help is divided 
into various sections, so that both users and system administrators can find help on the topics that are rel-
evant to them. The help texts can be called up via keyword search or by navigating the table of contents.
In addition to the online help, the application also offers local help. You can access it by clicking on the 
question mark icon  in the application's header. These help texts give you a short explanation of the 
respective function or field. If additional explanation is needed, further links are displayed in the online help.

Controls in the help pages
The help pages use the following controls:

Controls Explanation

Show and hide text 

Call up the search function (keyword search)

Show and hide the table of contents

Open the start page

Opening the Online Help
The online help can be accessed directly from the application. Do so by clicking on Help in the Menu bar. 

You can access the local help by clicking on the question mark icon  in the application's header. You can 
download the Online Help from the Download Center on the MOBOTIX website.

Support
Installation instructions are not included in this documentation. Please refer to the software download 
information available from the MOBOTIX website Download Center at Software Downloads: MxMan-
agementCenter. For technical questions, please contact our support. See MOBOTIX Support for more inform-
ation.

Program Structure and Operating Concept

Program Structure
MxManagementCenter provides functions for different user groups:
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 n System administrators (installers):
This user group uses MxMC to build and configure a monitoring system that consists of the application 
itself, cameras, recorders and other components.

 n End users:
These use the application for their monitoring tasks, such as live video surveillance, searches in and 
playback of recordings, video exports etc.

Despite these different tasks performed by the two user groups, the program structure and operating concept 
are largely the same.

Operating Concept

Program window
There are multiple views that allow the user groups to complete their tasks. These consist of a Menu bar, a 
main area in which most of the task is executed, four bars that can be opened and closed, a Header bar at 
the top and a Command bar at the bottom of the program window. 
The bars, consisting of a Device Bar, p. 57, a Camera Bar and Camera Group Bar, p. 61 and an Alarm Bar And 
Export Bar, p. 63, contain features for working with MxMC on a daily basis. The fourth bar contains the The 
Histogram: Graphical Representation Of The Frequency Distribution Of Events, p. 188 or the Smart Data-Sys-
tem, p. 190, which allows users to perform specific actions. In the Configuration view, this fourth bar also 
contains the Configuration bar. The Configuring Basic Camera Settings, p. 100 provides functions for chan-
ging the settings of multiple cameras in a group without having to change the camera or camera group.
The Command bar at the bottom contains the icons and buttons relevant to the current view. The contents 
of the Header bar as well as the Menu bar are the same for all views.

Note
If the Menu bar is not visible under Windows, it can be displayed by pressing the Alt key.

Fig. 22: Program window
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MxMC can be operated on Working With Multiple Monitors, p. 147. Double-click on a live image, for instance, 
to display it on a second monitor. If several monitors are connected, they are recognized and can be selected 
as required.

Controls and Buttons
Icons, sliders and buttons are available for working with the views.

Elements Examples Explanation

Icons Icons are mainly used in the Graphic view. They are either assigned predefined func-
tions or can be freely defined (hyperlinks). Icons can be freely placed in the Graphic 
view. Clicking on these buttons directly performs a function, for example, open a door. 
Icons used to control camera functions indicate their status, if available, such as "Door 
is locked" at the door icon of a Door Station. 

Buttons Buttons appear in many places in the application, including the Command bar or 
Header bar. Similar to the icons, clicking on the button performs a function directly. 
Buttons with a small white triangle at the bottom of the button indicate shortcut 
menus that provide additional options. The shortcut menus can be opened by right-
clicking, long-clicking or clicking on the triangle.

Slider Sliders are also used in many places for operation. Clicking & dragging a slider performs 
actions, such as scrolling through the last records. Available setting options can be lis-
ted and selected by clicking on the slider.

The name of the controls and buttons is displayed by moving the mouse pointer over it. Explanations with 

links to quick help are displayed when clicking the question mark icon  in the Header bar.

Note
In some places in MxMC, multiple cameras can be selected at once. Do so by using CMD + click (Mac) or 
CTRL + click (Windows).
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Device Bar

Fig. 23: Device Bar

The Device bar at the left margin of the MxManagementCenter is the central place for creating camera 
groups and for adding and grouping cameras and clips. Its tree structure design provides a quick overview of 
the contents and the composition of the individual projects by allowing you to open and close the individual 
branches and view the hierarchical structure. 

Adding Cameras, Creating Groups and Importing Clips

 1. Open the edit mode at the bottom of the Device bar by clicking on .

 2. Next, click on . The Adding devices and sources, p. 92 dialog opens. 

Adding Cameras to a Camera Group

 1. Open the edit mode at the bottom of the Device bar by clicking on .

 2. Drag & drop the desired camera from the Cameras section to the appropriate group in the Camera 
Group section.

Note
If you have assigned a camera to one group, you can copy this assignment to other groups by dragging 
the assignment from the first group to other groups.

 3. Once you have assigned the cameras to the desired groups, you can deactivate the edit mode by clicking 

on .
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Setting Group Functions

 1. Open the edit mode at the bottom of the Device bar by clicking on .

 2. To do so, move the mouse pointer over the group name. Three icons appear. Click on  .

 3. The Group Functions dialog opens.
 4. Assign the desired functions to the cameras by activating the respective checkboxes.

 5. Once you have defined all group functions, you can deactivate the edit mode by clicking on .

Deleting Cameras, Removing Cameras from Groups, Deleting Groups

Deleting Cameras

 1. Open the edit mode at the bottom of the Device bar by clicking on .

 2. Drag the camera from the Cameras section to .

 3. Once you have deleted the cameras, you can deactivate the edit mode by clicking on .

Note
Deleting a camera from the Cameras section will also delete the group assignments of that camera.

Removing Cameras from Groups

 1. Open the edit mode at the bottom of the Device bar by clicking on .

 2. Drag the camera from the Camera Groups section to .

 3. Once you have deleted the cameras from the groups, you can deactivate the edit mode by clicking on 

.

Deleting Groups

 1. Open the edit mode at the bottom of the Device bar by clicking on .

 2. Drag the camera group from the Camera Groups section to .

 3. Next, activate the edit mode by clicking on .

Working With the Device Bar

Configure Screen
Various features support the customization of the Device bar or the arrangement of items in the Device bar.
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Feature Explanation

Opening/Closing 
Sections

Click on  to close a section, click on  to open it again.

Moving Sections If you move the mouse over the upper part of the section, the  icon appears and the 

mouse pointer changes to the Move cursor. You can now click and drag the section up or 
down.

Setting Display 
Options

You can select how the cameras are listed, i.e., by camera name, IP address, factory IP 
address or reference image. Note that you can set different display options for the Cam-
eras and Camera Groups sections. For clips, you can choose to list the clips by name or 
by path.

Click on  and select the desired display option.

Sorting The 
Cameras

The Cameras section allows sorting the list. Click on  and select the desired sorting 

mode. 

Editing Project Data
Set favorites for display in the Camera/Group bar and change the names of cameras and groups.

Special 
Feature

Explanation

Selecting 
Favorites 
from Cameras 
and Groups

You can filter the displayed cameras in the Camera Bar and Camera Group Bar, p. 61 using dif-
ferent filter criteria (by favorites, for example). Before you can use favorites, however, you 
need to label the desired cameras and groups in the device bar as favorites.
      Activate the Edit mode by clicking on . Move the mouse pointer over the camera or 

group name. Several icons are shown. Click on  . Next, deactivate the edit mode by click-

ing on .

Editing 
Names

Using the device bar, you can quickly modify the names of cameras and groups. Activate the 
Edit mode by clicking . Click on the camera or group name you want to change – it will 

turn yellow. Click again on the name and edit it as needed. Deactivate the edit mode by click-
ing on .
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Navigation: Targeted Selection of Views

Special Feature Explanation

Selecting 
Views

The Device bar allows for selecting a specific view for a group of cameras or one camera. 
Move the mouse pointer over the camera or group name. Different icons will appear depend-
ing on whether you have moved the mouse over a camera or a group name. Click on the 
icon of the view you want to use.
Camera views

   Live view

   Playback view

   Research view

Group views

   Grid view

   Graphic view

   Grid Playback

   further views (Research view, Info view)

Overview of the Different Camera Statuses
An icon next to the camera name or the camera IP address indicates the current status of the camera.

Icon Explanation

Camera is not active.

Camera is not reachable.

Wrong camera password.

Privacy mode is active.

Limited functionality (only live image access) due to old firmware (<4.0), old camera model      (M/D/V12, 
M/D/Q22M) or proxy issue.

Camera password does not grant administrative access.

No license for this camera.
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Camera Bar and Camera Group Bar

Fig. 24: The camera- and camera group bar

The Group or Camera bar at the upper margin of MxManagementCenter provides the means for quickly 
selecting individual cameras/camera groups or for switching views.
   In addition, icons in the camera images of the camera bar indicate the current status of the corresponding 
camera:
  The height of the bar and thus the size of the images can be increased to cover two lines. To do this, pull 
down the lower frame border until it locks into place.

Camera Bar
The Camera bar displays the cameras with the image that was transferred from the camera when the camera 
was added. The camera name that was captured when the camera was added is shown in the gray Info bar at 
the bottom of the camera image.

Sorting the Cameras
By default, the cameras are displayed according to the order in which they were added to the Device bar. In 
order to make it easier to locate single cameras, you can change this order and sort the cameras. Do so by 
moving the slider  on the lower frame border to the desired position:

 n  unchanged order

 n  alphabetical sorting

 n  sorted by IP address
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Showing Camera States
The following camera states can be displayed in the camera image: 

 n  Camera is not active

 n  Camera is not reachable.

 n  Wrong camera password

 n  Privacy mode is active

 n  Limited functionality (only live image access) due to old firmware (<4.0), old camera model 

(M/D/V12, M/D/Q22M) or proxy issue.

 n  Camera password does not grant administrator rights.

Selecting Cameras
Select the desired camera either with a single click or drag and drop the camera into the display area. The 
Info bar of the selected camera turns yellow.

Switching To The Group Or Camera Bar
By clicking on the top frame border of the bar, you can switch from the Camera bar with individual cameras 
to the Group bar for managing camera groups.

Group or Camera Bar
The Group bar displays the camera groups with the reference image or icon configured in the camera man-
agement section (see Setting Up Camera Groups, p. 94). The name that was entered when creating the cam-
era group is shown at the bottom of the reference image or icon.

Sorting The Camera Group Display
The camera groups are displayed according to the order in which they were added to the Device bar. You can 
change this order and sort the camera groups alphabetically. 

    To do this, move the slider  on the lower frame border until the slider indicates alphabetical sorting: .

Select a camera group
Click on the desired camera group. The Info bar of the selected camera group turns yellow.

Switching To The Camera Bar
Click on the upper frame border of the bar to change from the Group bar with camera groups to the Camera 
bar for managing individual cameras. 
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Alarm Bar And Export Bar

The bar at the bottom of the MxManagementCenter contains the Alarm and Export bar. The Alarm bar turns 
red when there is an unacknowledged alarm event. This happens only if the Alarms option has been activ-
ated in the Camera Configuration dialog box and if the event types responsible for triggering an alarm have 
been activated. 
  Clicking on the bottom frame border of the open Alarm bar will take you from the Alarm bar to the Export 
bar. Using drag & drop, the Export bar provides a quick and easy way to collect recordings for subsequent 
exporting.

Alarm Bar

Recognizing and Acknowledging New Alarms
If the bar is hidden, new alerts will be indicated by a red frame border  . If the bar is open, the Info 
bar of the event image turns red. A ringing at the door bell will color the bar in green  . 
    To acknowledge a new alarm, right-click on the event image and select Confirm . To acknowledge all new 
alarms at once, select Confirm All .

Filtering the Display of Alarm Images
The alarm images in the Alarm bar are sorted chronologically. You can filter the event images by camera, by 
group or by event type. There are two sliders for this purpose: the group/camera slider and the event type 
slider . To set the filter, move the sliders until you see the desired results:

Basics/Introduction
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 n Group/Camera: Group  , camera 

 n Event Type: All  , MxActivitySensor , Video Motion Sensor , Behavioral Detection , Shock 

Detector , Illumination , Microphone , PIR Sensor , Temperature , Internal Events , 

MxMessageSystem , Meta Events , Signal Input Events , Time Events , Bell Events , Voice 

Mailbox Messages , Door Station Events , RFID Rejected , PIN Rejected .

Playing Back Recordings

 n You can play back the recording associated with an alarm directly from the Alarm bar (instant play-

back). To do so, move the mouse pointer over the alarm image. Three icons appear. Click on  .

 n To play back the alarm in the Playback view, move the mouse pointer over the alarm image. Click on 
 to switch to the Playback view.

Deactivating Alarms
You can use the Camera Configuration dialog box or the Alarm bar to deactivate alarms.

 n Deactivating alarms for a specific camera and event type: 
Right-click on the desired alarm image and select Deactivate As Alarm .

 n Disable alarms for all event types of a camera: 
Right-click on an alarm image and select Deactivate All Alarms of This Camera .

Export Bar
The Export bar can be opened in all views, and clips that have already been added can be edited in the bar. 
To do so, right-click on a clip. A shortcut menu with the following functions opens:

 n : Manually adjusting the time range

 n : Turning audio and PTZ on or off for all clips

 n : Duplicating a clip

 n : Deleting one or all clips

You can add the clips to be exported in the Playback view, in Grid Playback and in the Research view. Note 
that the Export bar will not be deleted automatically after exporting, but only when closing the application.

MxMC Views
The basic structure of the views is always the same. Each view, however, contains additional elements cor-
responding to the respective functional area. The following views are available:
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 n The Grid View, p. 65

 n The Graphic View, p. 66

 n The Live View, p. 66

 n The Playback View, p. 67

 n The Grid Playback, p. 68

 n The Research View, p. 69

 n The Smart Data View, p. 70

 n The Components View, p. 70

 n The AI Camera Apps View, p. 71

 n The Info View, p. 72

 n The Wizards & Tools view, p. 73

 n Configuration: Overview, p. 285

The Grid View
The Grid view consists of a grid of live images and a focus window. This grid display is ideal for getting a 
quick overview of all cameras of a group. You can drag the camera image that is most interesting to you onto 
the focus window. Use the controls at the bottom to operate the camera.
You will always notice when a camera registers an event, regardless of whether or not the camera is in the 
current group. The alarm info bar at the bottom of the camera's live image signals an event within the group. 
The alarm info bar at the bottom of the Grid view shows the events of all attached cameras. To investigate 
the event, simply drag the live image from the Grid view, or the event image from the alarm bar, into the 
focus window.

Fig. 25: The Grid View
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The Graphic View
You can define a floor plan (ground plan) in the Graphic view and place the cameras or camera groups 
according to their actual positions. The icon of the corresponding camera turns red in case of an alarm (or 
green upon a bell event). Move the mouse pointer over the camera icon to show the live image of the trig-
gering camera, allowing you to quickly monitor the situation.
   You can use the group buttons of the Command bar to switch on/off the lights of several cameras at once, 
to open several doors or to make an announcement over several speakers for one or more cameras of the 
group, regardless of the displayed camera. In addition, you can right-click on the group buttons and open the 
shortcut menu to control cameras that are not part of the current group.
To make work easier, you can drag elements from the Command bar onto the floor plan and operate them dir-
ectly in the floor plan by clicking on them.
In case you want to monitor the live images of cameras of other camera groups in the Graphic view, you can 
temporarily drag these 
live images onto the floor plan.

Fig. 26: The Graphic View

The Live View
The Live view allows you to control the live images of individual cameras. This includes switching various 
functions, e.g., opening doors or switching lights.
In order to better recognize objects in an image area, the live image in the Live view can be zoomed and 
image areas can be moved (PTZ). To facilitate quick loading of these image sections, several image positions 
are already configured for loading using the slider  in the Live view. On Dual cameras, the program also 
shows the  slider. Use this slider to show the live images of either the right, the left or both image sensors.

When showing the live images of hemispheric cameras, you can select different display modes (slider ).
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You can also make settings for the Door Station cameras in the Live view (e.g., voice mailbox announce-
ments).

Fig. 27: The Live View

The Playback View
The Playback view provides a quick and easy way to search for recordings and play back found sequences. 
There are various options available. The way that you search depends on whether you want to search the 
recordings for specific events, or if you want to search for events at specific times.

When searching for events, select a suitable playback mode   (e.g. event images only) and start playback 
  (backward or forward) or use the  (previous/next image) buttons to jump through the sequences.

When looking for incidents at specific points in time, you can search for a specific time or you can perform a 
search using "time leaps" and time-lapse playback. Furthermore, it is possible to play back any date and time 
and store that point in time so that the recordings of other cameras can be quickly searched for events at 
that time.
The recordings can be played back forward or backward at different speeds, which makes it easier to search 
for individual events.
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Fig. 28: Playback View

The Grid Playback
If a camera registers an event and you want to know if and what other cameras in that camera group were 
recording at that time, you can use Grid Playback to view the recordings of multiple cameras synchronously. 
  The camera in the focus window is the lead camera. So, if you are browsing the recordings on this camera 
to find events or specific situations or if you are playing back recordings, the other cameras will follow the 
leading camera as soon as playback is paused. The program always shows the event images that are closest 
to the time stamp of the leading camera. If the time of the other cameras differs from the leading camera, the 
difference will be displayed at the lower border of the event images.
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Fig. 29: The Grid Playback

The Research View
Use the Research view to search all recorded event images at once. You can filter the results by event type, 
that is, by bell events or by motion events to get a quick overview.  Or you can reduce the results to the 
event you have marked as "important" in the Playback view. The search results are displayed as preview 
images with camera name, times tamp and type of event trigger. Note that you can play back the recording 
for an event directly from the event image (Instant Playback). Double-click on the event image to open the 
Playback view and to start playing back the recording. Recorded clips can be assembled in MxMC in the 
export list for export.
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Fig. 30: The Research View

The Smart Data View
With the MOBOTIX Smart Data System, transaction data, for example from POS systems, can be linked to the 
video recordings of transactions in MxMC. This enables conspicuous activities to be found and checked 
quickly. The Smart Data Bar and the Smart Data View are available for searching and analyzing transactions.
In the Smart Data View, you can perform a detailed search. Advanced search options and complete video doc-
umentation assist you in maintaining a comprehensive overview of, for example, POS systems, video-based 
license plate recognition or access control systems.

Fig. 31: The Smart Data View

The Components View
In the  Component View, you can manage the following components:

 n File Servers that are used to store video recordings. 

 n Smart Data Sources (license required) from which you can read transaction data, e.g. from MOBOTIX 
P7 Apps (no license required), POS systems or license plate recognition systems.

 n MxThinClients,  which allow you to display live images from MOBOTIX cameras on a monitor or TV set 
with HDMI connection.
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Fig. 32: The Components View

①  User Management, p. 227 /  Notification, p. 340 /  Bandwidth, p. 330
②  Header Bar
③  Camera Bar and Camera Group Bar, p. 61
④  Context Help /  Refresh, p. 302 / Network Environments, p. 213 /  Connection Monitoring, p. 308
⑤  Smart Data Bar, p. 297
⑥  Histogram Bar , p. 294
⑦   Access and Save the Home View, p. 336 / Previous View / Next View /  Select View, p. 336
⑧  Device Bar, p. 57
⑨  File Server Settings, p. 245
⑩  Smart Data Settings, p. 250
⑪  MxThinClient Settings, p. 254
⑫  Settings Area for File Server Settings, p. 245, Smart Data Settings, p. 250 and MxThinClient Settings, p. 254

The AI Camera Apps View
The AI Camera Apps view you can display the AI Apps Web GUI within MxMC to configure the corresponding 
AI App or to open the Apps Dashboard for statistical and analytical purposes.

Basics/Introduction
MxMC Views

71 / 375



Basics/Introduction
MxMC Views

Fig. 33: The AI Camera Apps View

The Info View
You can add an information page to every camera group in order to show special instructions for operating 
this camera group or instructions for a notification chain in case of an alarm, for example. To show the 
information in the Info view, you can compile the information and save it in a PDF or JPG file and then load 
the file in the Group Management dialog box. 
If you want to show up-to-date information that is presented on a web server, you also do this in the Info 
view.  Simply activate the edit mode and pull the URL into the Info view.
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Fig. 34: The Info View

The Wizards & Tools view
The Wizards & Tools view is only available to administrators. The options provided by this view can either 
be executed for individual cameras or camera groups. Select the camera or camera group in the Cam-
era/Group bar or in the Device bar and then execute the desired feature.

Fig. 35: The Wizards & Tools view

①  User Management, p. 227 /  Notification, p. 340 /  Bandwidth, p. 330
②  Header Bar
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③  Camera Bar and Camera Group Bar, p. 61
④  Context Help /  Refresh, p. 302 / Network Environments, p. 213 /  Connection Monitoring, p. 308
⑤  Smart Data Bar, p. 297
⑥  Histogram Bar , p. 294
⑦   Access and Save the Home View, p. 336 / Previous View / Next View /  Select View, p. 336
⑧  Device Bar, p. 57
⑨  Wizards & Tools, p. 256

Configuration: Overview
The Configuration view you to directly access and make settings for MOBOTIXcameras. In general, the view is 
divided into a Basic Settings section and an Advanced Configuration section containing Configuration 
Groups.
The controls at the bottom can be used for actions such as storing the changed settings permanently or reset-
ting the parameter values to their factory settings.
The settings are made for one camera at a time. The Configuration bar on the right margin also offers the pos-
sibility to change the settings of several cameras of a group simultaneously without having to change the 
camera or the camera group.

Note
The Configuration view is not supported by MOBOTIX MOVE cameras and third-party cameras that provide 
an ONVIF S-compatible interface. For an overview of how the camera functions differ, see Camera Feature 
Overview, p. 13.

Structure of the camera configuration view
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Fig. 36: Structure of the camera configuration view

Basic Settings
The Basic Settings ①  contain basic configuration settings that are important for the setup of cameras and 
camera system. The Basic Settings include the following areas: 

 n General Settings,

 n Network,

 n Time,

 n Image Settings,

 n MxActivitySensor and Recording.

The parameters of the respective topic areas are grouped in tabs. For information about each tab, see Con-
figuring Basic Camera Settings, p. 100.

Fig. 37: Basic settings

Advanced Configuration (license required)
The available configuration parameters are thematically grouped in tiles. The Advanced Configuration tiles ②  
are only visible if the required license key has been installed, otherwise only the basic settings are available. 
Clicking on a tile opens the topic area and tabs for the associated sub-topics.
Some of the topics contain graphical configuration items, such as those for defining exposure windows or 
detection areas. For more information on how to operate these configuration items (see Graphical operation, 
p. 292).
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Extensive information on the setting options and parameters of the individual subject areas are currently 
available only via the help pages of the camera. You can access the camera help table of contents directly 
from MxMC by pressing CMD+Shift+H (Mac) / CTRL+Shift+H (Windows).

Fig. 38: Advanced Configuration

Advanced Configuration - Users and Groups
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Configuring Advanced Settings

Caution
By modifying User Settings, you can loose access to your cameras. Make sure you do not delete or move 
user or passwords you do not know!

 1. Click on the respective tab to open the corresponding topic area.
 2. Make your settings as required by topic. 

Note
Clicking on the relevant topic area in the table opens an information page for the individual topic areas 
of the Advanced Configuration settings. 

Fig. 39: Advanced Configuration - Users and Groups

Applying and saving changed settings

Warning
By modifying User Settings, you can loose access to your cameras. Make sure you do not delete or move 
user or passwords you do not know!
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Fig. 40: Applying and saving changed settings

You can use the controls at the bottom of the view to permanently save changed settings or to reset the para-
meter values to factory settings, among other things:

Resetting To Factory Settings

Click on  to reset all parameters for the current camera tab to the factory settings.

Undo/Redo Last Change

Click on  to undo the last change. Click on   to redo the change you previously undid.

Apply Changes

You can make changes by pressing Enter or selecting the new value in the Configuration view. The changes 
made here are not automatically adopted because it could potentially cause problems with the network set-
tings.
    When a value is changed, the checkmark in the Command bar turns red, indicating that the change has not 
been implemented yet. Click  to make this change.

Saving Configurations

If parameter values are changed, the Store Configuration  icon turns red in the Command bar. Initially, 
changes are always temporarily stored in the camera. To ensure that the current settings are also used after 
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the next restart, the changes must be saved permanently.

 1. To do so, click on Store configuration . The program opens a system prompt. In the prompt, click on 

Store.
 2. If you do not want to keep the changes, click on Discard. This discards the changes and restores the last 

permanently saved overall configuration.

Expert Settings

Various sections of the configuration provide additional settings that can be used to change parameters that 
are not necessary for the daily work with MxMC. Note that these settings have been combined as expert set-
tings in the different sections. Click on    to open the expert settings.

Changing Parameter Values For Multiple Cameras In The Configuration 
Bar

Warning
By modifying User Settings, you can loose access to your cameras. Make sure you do not delete or move 
user or passwords you do not know!

You can enter parameters for a single camera in the Configuration view. You can use the Configuration bar to 
check which parameter values are available for the other cameras in the group. There you can also change 
the settings of one or multiple cameras in the group without having to switch to a different camera or cam-
era group.

Checking parameter values of other cameras in the group

Basics/Introduction
MxMC Views

79 / 375



Basics/Introduction
MxMC Views

Fig. 41: Checking parameter values of other cameras in the group

Example: Check arming for multiple cameras

 1. Click on the relevant parameter name ① .
 2. It turns yellow and the Configuration bar shows all values associated with this parameter that were 

defined for cameras in this group ② .

Changing a value for one camera or for multiple cameras

Fig. 42: Changing a value for one camera or for multiple cameras

Example: Change a value using the Configuration bar

 1. Click the appropriate parameter name in the Configuration view ① . It turns yellow and the Configuration 
bar shows all values associated with this parameter for this group ② . The cameras for which this value is 
set are assigned to the individual values.

 2. Highlight the desired camera and drag it onto the parameter value you want to set. The destination area 
turns yellow.

 3. If the same value is set for several cameras and you want to change this value, click on the parameter 
selection field in the Configuration bar ③ . Then select the desired value.
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Setup
Basic Installation: Overview

Setup
Setting up a MxManagementCenter-based video surveillance system can be costly and will usually be done 
by an administrator / system installer. This section addresses administrators and system installers and 
provides an overview of the tasks that must be performed to efficiently set up a system.
 However, not all of these tasks are mandatory for a basic installation(See Basic Installation: Overview, p. 82).

Step Explanation

Adding Cameras, p. 83 Integrate cameras with the Welcome wizard or in the Device bar
Set alarm filters
Set up recording paths

Setting Up Camera Groups, p. 94 Create camera groups
Add cameras to groups
Define group functions

Adding Users, p. 98 Create users
Assign permissions

Configuring Basic Camera Settings, p. 100 General settings
Network
Time
Image settings
MxActivitySensor
Recording

Checking System Security, p. 258 Verify system security settings
Secure the system

Backing Up System Settings, p. 122 Save the settings made

Import Existing Project, p. 124 Import an MxControlCenter file (INI file)
Import an MxEasy file (NDB file)

Basic Installation: Overview
The Setup section describes the steps required to set up a system. For a basic installation, however, not all 
the steps shown are mandatory. The following list gives an overview of the most important steps of a basic 
installation.          
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Step Explanation

Adding Cameras, p. 83 When starting MxMC for the first time, the Welcome Wizard opens and auto-
matically starts searching for MOBOTIX cameras. Cameras in the local network are 
automatically detected and listed.
Cameras can also be added in the Device bar. Cameras that are in the local network 
are also automatically detected and listed here. Cameras outside the local network 
are Adding devices and sources, p. 92.               

Setting Up Camera 
Groups, p. 94

Create camera groups to group your cameras. By organizing in groups, entire sur-
veillance areas are always recognizable at a glance
Assign the cameras to the desired groups. 
Set the layout for the Grid view and Graphic view.         

Adding Users, p. 98 After you have added the cameras and organized them into groups, create the users 
and any other administrators and set their access permissions. 

MxMC Licensing, p. 
276

Industry-specific solutions and special functions, such as the integration of cash 
point systems, are subject to licensing. To be able to use them, the purchased 
licenses must be activated.

Configuring Basic Cam-
era Settings, p. 100

Make sure that the main arming option has been activated (see Basic Camera Set-
tings: General Settings, p. 105. Synchronize the time (see Basic Camera Settings: 
Time, p. 107), arm the recording (see Basic Camera Settings: Recordings, p. 112)and 
specify a recording destination if necessary (see Adding Cameras, p. 83).

Checking System 
Security, p. 258

After completing the basic configuration of the system, you can check its security.

Backing Up System 
Settings, p. 122

Finally, you should save your settings. You can save the settings locally as a project 
file). The Device Backup function can be used to save the settings across the entire 
system.

Adding cameras, devices and sources
This section describes the necessary steps to add and configure cameras, devices and other sources.

Adding Cameras
The cameras and Door Stations can either be integrated with the Welcome wizard or added to the Device 
bar. These cameras also include MOBOTIX MOVE cameras and third-party cameras that provide an ONVIF S-
compatible interface.

Setup
Adding cameras, devices and sources
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Integrating cameras with the Welcome Wizard
When starting MxMC for the first time, the Welcome wizard opens and automatically starts searching for cam-
eras. The number of found cameras is shown next to the Add button . This number is updated auto-
matically if the number of MOBOTIX cameras on the network has changed (i.e., by connecting 
new/disconnecting existing cameras).

 
Fig. 43: Integrating cameras with the Welcome Wizard

 1. Click on Add Devices .

      All found cameras are displayed either in a list or as tiles. Whether the cameras are displayed in a list or 
as tiles is determined by clicking on either the
tiles  or list  button.

 2. The respective camera status is automatically tested and displayed:       
 n  = The camera cannot be interacted with under the found or entered IP address.

 n  = The camera is in a different network than the computer.

 n  = The camera firmware is not up to date.

 n  = The camera is password protected.

 n  = Incorrect user data was entered.

 n  = Preview image not available.

 3. Select the cameras you would like to integrate. 
 n If some of the selected cameras are password protected, click on Change Camera Access  and 

enter the user name and password. 

 n If some of the selected cameras are not in the correct network, click on Edit Network Settings . 

Here you can choose whether the IP address is automatically determined or whether a fixed IP 
address is used.
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 n Determining an IP Address Automatically: If your computer automatically gets its IP address 
from a DHCP server (e.g., DSL router), then it also makes sense to have the system determine 
the camera's IP address automatically. To do so, enable the Get IP Address Automatically 
option.

 n Using a Fixed IP Address: If you have assigned a fixed IP address to your computer, you will 
probably prefer to assign a fixed IP address to the camera as well. To do so, enter the IP 
address and the subnet mask.

 4. Click on Apply and wait for the cameras to be reconfigured.

Note
    If the  icon is displayed instead of the preview image, the camera could not be reconfigured due to incor-

rect user data. In this case, correct the user data and try again.

 5. The number of selected cameras is shown near the Next Page button. Go to the next page.
 6. Click on Done. The selected cameras are now integrated.

Note: Clicking on Start New Project opens the application directly, and you can add the cameras using 
the Device bar.

Adding cameras via the Device Bar

Fig. 44: Adding cameras via the Device Bar

The first time you start MxMC , the Welcome wizard automatically opens, allowing you to add your cameras 
and Door Stations. These can also be added using the Device bar. If you prefer to use the Device bar instead 
of the Welcome wizard, click on Start New Project in the dialog. This opens MxMC directly in live view, and 
the Device bar is open.
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 1. Open the edit mode at the bottom of the Device bar by clicking on .
 2. Next, click on . The Add and Import dialog opens. 

 n Adding Cameras In The Local Network

All cameras and Door Stations in the local network can be detected and displayed automatically.

 n Adding Cameras Manually

Cameras outside of the local network (for example, on the Internet) need to be added manually.

Capturing the data of many cameras
The authentication data used by MxMC as well as the environment settings can be changed in one step for 
many cameras in the  Multi-Camera Configuration  dialog. 

 1. To do this, open the edit mode in the Device bar by clicking on .

 2. Select the cameras as needed.
   Mac: CMD + click, Windows: CTRL + click

 3. Right-click on one of the selected cameras. The Multi-Camera Configuration dialog opens (see     Multi-Cam-
era Configuration, p. 226     ).

Setting Alarm Filters

Note
     For MOBOTIX MOVE cameras and third-party cameras that provide an ONVIF-compatible interface, there is 
no alarm function available and you can thus neither activate background monitoring nor set alarm filters. 
For an overview of how the camera functions differ, see      Camera Feature Overview, p. 13     .
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Events that lead to an alarm will change the background color of the Alarm bar, Alarm Info bar (see      Alarm Bar 
And Export Bar, p. 63 and Alarm Processing, p. 151     ) and other UI items to red. You can set the event types 
that trigger a signal for specific cameras in the Camera Configuration dialog.

 1. To open the Device bar, click on  at the bottom of the bar.

 2. Then either right-click on individual cameras or click on the  icon, which is shown when you pos-

ition the mouse pointer over the camera name.
 3. Click on Alarms to adjust the settings to your needs. The Alarm Events dialog opens.

  
Fig. 45: Setting Alarm Filters

 4. Make sure that the Alarms option has been activated.
 5. Select the event types that should create an alarm.

Setup
Adding cameras, devices and sources

87 / 375



Setup
Adding cameras, devices and sources

 6. In addition, you can select a weekly profile for every event type that should trigger an alarm. As long as 
no other weekly profile has been selected, the setting is valid from Monday 00:00 to Sunday 24:00.       

 n Click on Edit weekly profiles to create new weekly profiles. The Weekly Profiles dialog opens. 
Several predefined profiles are available, such as the Weekend profile (Saturday 00:00 to Sunday 
24:00).

 n To add a profile, click on  . Enter a description. Next, highlight the desired active times in the 

table using the mouse. You can resize an active time block by clicking on the time block and then 
moving the borders accordingly It is also possible to move a block. Click on the block to select it, 
then drag the block to the new position. To delete a time block, click on  .

Fig. 46: Alarm Filter profiles

 7. You can change the description of an existing profile. Right-click on the name and overwrite it.
 8. To select a weekly profile, click on the Weekly Profile drop down list next to the event type and select 

the desired profile.
 9. Click on the calendar icon to easily invert the settings of the weekly profile. For example, if you have cre-

ated a profile with opening hours and would like to activate the alarms for the closing times, click on the 
Invert weekly profile checkbox and the profile is used in inverted fashion.

Setting Up Recording Paths
The program can access the stored recordings using the following methods: Access to recordings via the cam-
era (remote playback) or to a local directory where the recordings are stored or directly to a file server. 
When accessing via the camera (MOBOTIX camera), no further settings are required. If you want to access the 
recordings directly (file server or local directory), you need to define recordings paths and assign these to 
the cameras. Direct access offers the advantage of an extremely fast playback speed (up to 60x).
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Note
 Recordings of MOBOTIX MOVE cameras and third-party cameras that provide an ONVIF S-compatible inter-
face can only be saved on MOBOTIX NAS. To do this, first configure the MOBOTIX NAS and then set up the 
recording path in MxMC.

Defining the Recording Path

Fig. 47: Defining the Recording Path

 1. Open Settings in the MxManagementCenter > Settings > Recording Paths (Mac) or File > Settings > 
Recording Paths (Windows) menu.

 2. Click on "+" and enter the desired name. Under this name, the path can be selected as the recording path 
in the Camera Configuration dialog.
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 3. Select the type:
 n Local

Contains a local folder on this computer or on a connected network drive. You can either enter the 
folder path manually, drag & drop a folder to the input field or select the local or linked folder.
Path: You must select the path that contains the recording folders created by the camera.

 n Network Share
The program directly accesses a shared folder on a file server. In this case, you need to enter the 
computer, the folder and the access data.
File Server (IP): IP address or DNS name of the file server with the share.
Directory: Name of the share on the file server. 
Important: Make sure that the path ends before the folder containing the factory IP address of the 
camera.
User Name/Password: Access data for the network share.

 n MOBOTIX NAS
Data is accessed directly on a shared folder on a MOBOTIX NAS.
File Server (IP): IP address or DNS name and port of the MOBOTIX NAS.
Directory: Name of the share on the MOBOTIX NAS.
Important: Make sure that the path ends before the folder containing the factory IP address of the 
camera.
User Name/Password: Access data for the MOBOTIX NAS.

 n MOBOTIX NAS (ONVIF)
The ONVIF recordings are accessed on a MOBOTIX NAS.
File Server (IP): IP address or DNS name of the file server.
User Name/Password: Access data for the file server.
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Assigning recording paths to the cameras

Fig. 48: Assigning recording paths to the cameras

 1. Open the Camera Configuration dialog in the Device bar. To do so, click on  at the bottom of the 

bar.

 2. Then either right-click on individual cameras or click on the  icon, which is shown when you pos-

ition the mouse pointer over the camera name.
 3. Select the appropriate recording path in the recording settings. The following options are available:

 n Via camera: When accessing via the camera (MOBOTIX camera), no further settings are required.

 n Local Path: Set the appropriate recording format: Use MxFFS, if the recordings have been stored in 
an MxFFS archive. Use MxFileServer, if the recordings have been stored in the classic MOBOTIX 
folder/file structure. Then enter the local directory in the Device Directory text box.

Note:
Click on the pen icon in the text field to open a file selection dialog.

 n File Server: If file server access is used, MxMC searches the specified file server path for sub folders 
with the corresponding recordings. Once the search has been completed, you can select the folder for 
this camera in the Device Directory selection box.

 n MOBOTIX NAS: When accessing a MOBOTIX NAS, select the appropriate camera IP in the Device Dir-
ectory selection box.
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Adding devices and sources

Fig. 49: Adding devices and sources

Select the desired action:

Adding Cameras in the Local Network
All cameras and door stations in the local network are detected automatically.

 1. Click on  . The Welcome wizard opens and lists all cameras that were found on the local network.

 2. Select the camera you want to add (use CMD-click on a Mac or CTRL-click on Windows to select several 
cameras).

 3. Specify a user name and a password. Click on   to do so. When multiple cameras have been selected, 

all of these cameras will get this user name and password.
 4. Click on  and then on Finish. All new cameras are shown in the device bar in the Cameras section and 

you can already see the live images of the cameras.
 5. You should now complete the data for the individual cameras. Open the Camera Configuration dialog 

for this purpose. To open the dialog box, you can either right-click onto individual cameras or you click 
on the  icon, which is shown if you position the mouse pointer over the camera name. The Camera 

Configuration dialog opens (see Camera Configuration, p. 219).
 6. Close the dialog once you have completely filled in the camera data in the Camera Configuration dia-

log. Then deactivate the edit mode of the device bar by clicking on .

Adding Cameras Manually
Cameras outside of the local network (for example, on the Internet) need to be added manually. 
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 1. Click on  . The Camera Configuration dialog opens.
 2. Enter the camera access data:

Name: Enter a descriptive camera name.
URL: IP address of the camera.
Remote URL: To access the camera from outside of the local network, you can enter the corresponding 
external address of the camera (such as a DynDNS name). Make sure that you also activate the Remote 
option.
User name, password: Enter the user name and password of the camera.

 3. Complete the network data and set up alarm notification as described in Camera Configuration, p. 219.
 4. Close the dialog once you have completely filled in the data in the Camera Configuration dialog. Then 

deactivate the edit mode of the device bar by clicking on .

Creating Camera Groups

 1. To create a camera group, click on . The Group Configuration dialog opens.

 2. Fill in the data as described in Setting Up Camera Groups, p. 94.
 3. Close the dialog once you have completely filled in the data in the Group Configuration dialog. Then 

deactivate the edit mode of the device bar by clicking on .

Importing Clips
You can use MxMC to play back exported MxPEG clips. Click on   to do so. The Load Clips dialog opens: 
Select the desired MXG file and click on Open. The clip appears in the device bar in the Clips section. 

Importing recordings
This function allows you to add storage paths generated by MOBOTIX cameras.

 1. Click Recordings.
 2. Select the desired directory with the camera's recording structure and click Open.

The recordings are displayed in the Device Bar in the Clips & Recordings section.

MxFFS Medium
This function allows you to access a MOBOTIX storage device connected to the USB port with recordings in 
MxFFS format.
Note: o be able to read MxFFS media, you must start MxManagementCenter with administrator rights (see 
Integrating MOBOTIX storage device, p. 193). Without administrator rights, the storage medium will not be 
recognized.

 1. Click MxFFS Medium.
 2. Select the desired directory and click Open.

The recordings in MxFFS-Format are displayed in the Device Bar in the Clips & Recordings section.
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Creating Clips-/ Recording groups
Clips and recordings can be organized into groups.

 1. Click Create Clips / Recording Group.
 2. Specify a name for the group.
 3. Move the desired clips and recordings into the group.

Connecting MxThinClients
Edit the MxThinClient setting here. The MxThinClient is a compact solution for displaying the live image of a 
MOBOTIX camera on a monitor or TV set with HDMI connection. 
Name
Enter the name for the MxThinClient here.
URL
Enter the URL or IP address of the ThinClient.
User Name
 Enter the user name of the MxThinClient user here.
Password
 Enter the password of the ThinClient user here.
Display resolution
Select the resolution of the camera image to be displayed on the monitor of the MxThinClient.
Camera display
Select here how long the assigned camera image should be displayed on the monitor of the ThinClient. After 
the selected time period the ThinClient will display the configured setting (e. g. sequences, still images etc.).
MxThinClients can also be added via the Component view (see The Components View, p. 70).

Setting Up Camera Groups
You can combine individual cameras into camera groups. For example, you can combine all cameras situated 
on the same floor in one group.  This allows checking on entire surveillance areas at one glance and – in case 
of an alarm, you are quicker to access the relevant cameras.
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Creating camera groups

Fig. 50: Creating camera groups

 1. Open the edit mode in the Device bar by clicking on  at the bottom of the bar. Next, click on . The 

Add and Import dialog opens.

 2. Click on  . The Group Configuration dialog opens.

 3. Enter a group name and – if desired – add an image or an icon that will be used to represent the group in 
the group bar later on. To do so, click on the gray field and select one of the predefined icons. If you 
want to use one of your own images, click on Custom.

 4. Add a background image: Move the slider  to the right until you reach the  position. Click on the 

arrow in the gray field and select the file with the background image (for example, ground or floor plan). 
 5. You can add an information page to a camera group in order to show special instructions for this cam-

era group, for example.  Move the slider  to the right until you reach the  position. Click on the 

arrow in the gray field and select the file you want to use.
 6. Grid Tiles Bandwidth Limits If a very large number of cameras is displayed in the Grid view, the per-

formance may decline. To avoid this, you can limit the frame rate of the live images within the grid 
frames. Note that this limit does not apply to the camera displayed in the focus window.
Use ONVIF LoRes Profile: Use this checkbox to limit the frame rate for MOBOTIX MOVE cameras and for 
third-party cameras that provide an ONVIF S-compatible interface. If the checkbox is enabled, the set-
tings for the live images in the tiles captured in the Bandwidth Settings as the LoRes profile for these 
cameras will be used.

 7. Close the dialog once you have completely filled in the data in the dialog. Then deactivate the edit mode 

of the device bar by clicking on .
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Adding Cameras to a Camera Group
After you have added cameras and created camera groups, you now should assign cameras to the proper 
groups.

 1. Open the edit mode in the Device bar by clicking on  at the bottom of the bar.

 2. Drag and drop the corresponding camera to the desired group.
 3. Once you have assigned the cameras to the desired groups, you can deactivate the edit mode by clicking 

on .

Setting the Group View layout
To view and work with camera groups, there are two views available: the Grid view (grouping the cameras      by 
any criteria in raster form) and the Graphics view (realistic arrangement of the cameras on a graphic back-
ground). For each camera group you have the option of defining the Grid view grid layout and      positioning the 
cameras on the background image (e.g., building plan) in the Graphics view as desired.

Note

If you have created a group and have not added any cameras yet, the application will show      the icon  in 

the     Group and Device bar.

Setting the layout for the Grid View
    When you first open the Grid view after you have created a camera group, the cameras belonging to the 
group are displayed in the following grid layout by default:

 n The aspect ratio of the camera images is 4:3.

 n The Grid view is in auto grid mode. In auto grid mode, MxMC always tries to distribute the available 
space as well as possible according to the specified camera image format, the size of the focus window 
and the number of cameras. If you change the size of the window, the grid layout adapts auto-
matically.

 n The focus box displays the camera that is in the Device bar at the top of the group.

 n The focus window size is twice as large as that of the camera images.
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Fig. 51: Setting the layout for the Grid View

 1. To change the format of the camera images or the size of the focus window, open the edit mode by click-

ing on  in the Command bar. The following sliders for adjusting the grid layout appear at the bottom 

of the bar:      
 n  = Format of the camera images and the focus window (4:3, 16:9, 8:3) 

 n  = Size of the focus window (1x, 2x, ..., 8x the size of the camera images)

 n  = Maximum number of cameras

 2. Move the sliders to the desired settings. To close the edit mode, click on .

See also: Group Views, p. 200

Configuring the Graph View layout 
When you open the Graphic view for the first time after creating a camera group, all the cameras in that 

group are listed at the right margin of the previously defined background image with a camera icon . 
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Fig. 52: Configuring the Graph View layout

 1. To arrange the cameras according to their actual positions on the background image, open the edit mode 

by clicking on .

 2. To do so, move the mouse pointer over the camera icon. Two icons are shown.

 3. Click on  and drag the camera icon to the desired location. 

 4. Click on  to save the changes.

See also: Group Views, p. 200

Adding Users
After you have added the cameras and organized them into groups, set up users and any other admin-
istrators, if required. Users and administrators are set up in the User Management. You set up access per-
missions at the same time. You can assign rights for users depending on the specific functions they need, 
whereas an administrator possesses all rights.
See also: User Management, p. 227

 Creating Users or Administrators
Open the User Management by clicking on  in the Header bar. Next, click on Add .
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Fig. 53: Creating Users or Administrators

User type and user name

 1. Enter the corresponding user name. 
 2. Select the desired user type: user or administrator.

 The user type is set to User by default. The sections Weekly profiles and User rights are available for 
users, in contrast to administrators. All other settings apply to both user types and will be used in the fol-
lowing description; however, reference will only be made to User.

 3. Use the Active option to enable the new user immediately or later on.

Password

 1. Enter a password and confirm it.
 2. Use the Expires option if you want to require the user to change the password at regular intervals.
 3. If the user is to change the original password upon the next legion, select the Force change on next log 

in option. 
Note: Activating this option automatically gives the user the "Change Password" right, even if it had 
been disabled before.

 4. The Force Complex Password option ensures that users can only set secure passwords. 
 A secure password has at least eight characters, consists of lowercase and uppercase letters, including at 
least one special character, one digit and one character. Furthermore, it cannot be one of the last thir-
teen passwords used on this user account. If you are trying to set a password that does not meet the cri-
teria, a red frame around the text field will appear.

Log in
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 1. You can establish a specific setting for time ranges in a weekly profile for users who can only access 
MxMC at specific times. This section is not displayed when creating an administrator because the admin-
istrator always has all rights and access to MxMC .
Click on Edit weekly profiles to create a weekly profile. The Weekly Profiles dialog opens with the 
options Weekly profiles and Holidays.
Weekly profiles
There are two predefined profiles available from the beginning: the Weekend profile (Saturday 00:00 to 
Sunday 24:00) and the Working days profile (Monday 00:00 to Friday 24:00).             

 n To add a profile, click on . Enter a description. Highlight the desired active times in the table. 

You can resize an active time block by clicking on the time block and then moving the borders 
accordingly It is also possible to move a block. Click on the block to select it, then drag the block 
to the new position. To delete a time block, select one first and then click on .

 n You can change the description of an existing profile. Double-click on the name and overwrite it.
Holidays

 n To add a holiday, select the date, check "Repeat annually" if required and click on .

 n To delete a holiday, select it and click . existing profile.

 2. Close the dialog box to finish editing the weekly profiles. You can then use the new (or modified) weekly 
profile in user management. To do so, click on the Weekly Profile box and select the desired profile.

Note
24 hours is set by default. In this example, the user always has access to MxMC.

 3. Click on the calendar icon to easily invert the settings of the weekly profile. For example, if you have cre-
ated a profile with access on the weekend and would like to activate the alarms for working days, click 
on the Invert checkbox and the profile is used in inverted fashion.

Log out
In addition, you can specify after how many minutes of inactivity this user will be automatically logged out.

Setting Up Access Rights
Every user has all user rights initially. Deactivate the rights that should not be available for a specific user in 
the User Rights section. This section is not displayed when creating an administrator because the admin-
istrator always has all rights.

Configuring Basic Camera Settings
MxMC offers the possibility to adjust settings directly on the cameras. Some of the configuration options are 
summarized in the Configuration view under the green Basic Settings tile. This area includes all topics that 
are important or necessary for commissioning. Unlike "Advanced Features," the basic camera settings do not 
require a license and are therefore always available. 
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Note
MOBOTIX MOVE cameras and third-party cameras that provide an ONVIF S-compliant interface cannot be 
configured using MxMC. For an overview of how the camera functions differ (see Camera Feature Overview, 
p. 13.

Opening Basic Settings

 1. Open the Configuration view by right-clicking on the navigation key in the Command bar. Select the Con-
figuration view. 

Note
When opening this view, the system always loads the configuration of a camera group.

 2. If you did not purchase a license to use "Advanced Features," the Basic Settings section is opened by 
default.
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 3. If you have purchased an "Advanced Features" license, the Configuration view entry page will open. Click 
on the Basic Settings tile.

Configuring Basic Settings

 1. Click on the respective tab to open the corresponding topic area.
 2. Make your settings as required by topic. 

More detailed information on editing the settings can be found in the table below. Clicking on the rel-
evant topic area in the table opens an information page for the individual topic areas of the basic set-
tings.
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Default setting Associated Parameters

Basic Camera Settings: Gen-
eral Settings, p. 105

Arming, Frequency of power supply, Audio source

Basic Camera Settings: Net-
work, p. 117

Internal host name, BOOTP/DHCP, Second IP address 

Basic Camera Settings: 
Time, p. 107

Automatically synchronize using a time server, Do not adjust automatically

Basic Camera Settings: 
Image settings, p. 108

Image size, JPEG quality, Camera selection, Display mode, Installation, Expos-
ure window, Exposure program, Max. exposure time

Basic Camera Settings: 
MxActivitySensor, p. 116                             

Active, Profile name, Event dead time, Edit detection area 

Basic Camera Settings: 
Recordings, p. 112

Arming, Recording mode 

Applying And Saving Changed Settings
The controls at the bottom of the configuration view can be used to perform actions such as permanently 
storing the changed settings or to reset the parameter values to their factory settings.
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Applying Changes
Normally, the changes in the Configuration view take effect when you type or select the new value. The 
changes made here are not automatically adopted because they could potentially cause problems with the 
Network Settings. Instead, the Apply Changes  icon in the Command bar turns red, indicating that the 
change is not yet in effect. To apply your changes, click on .
Storing the Configuration
If parameter values are changed, the Store Configuration icon  turns red in the Command bar. Changes to 
the configuration are always stored in the camera temporarily. To ensure that the current settings are also 
used after the next restart, the changes must be saved permanently.

 1. Click on Store Configuration . The program opens a system prompt. In the prompt, click on Store.

 2. If you do not want to keep the changes, click on Discard. This discards the changes and restores the last 
permanently saved overall configuration.

Resetting to Factory Settings                 

The parameter values of the opened tab can be reset to the factory default settings. Click on   to do so.
Undoing or Repeating Changes
Click on  to undo the last change. Click on  to repeat the last change.

Changing Parameter Values for Multiple Cameras in the Configuration 
Bar
The Configuration bar on the right margin offers the possibility to change the settings of several cameras of a 
group without having to change the camera or the camera group.
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Changing the Value for a Camera

 1. If the Configuration bar is not already open, open it by clicking on the right margin in the application.
 2. Click on the desired parameter name in the Basic Settings. It turns yellow and the Configuration bar 

shows all values associated with this parameter for this group. The cameras for which this value is set 
are assigned to the individual values.

 3. Highlight the desired camera and drag it onto the parameter value you want to set. The destination area 
turns yellow.

Changing a Value for Multiple Cameras
If the same value is set for several cameras and you want to change this value, click on the parameter selec-
tion field in the Configuration bar. Then change the parameter value for the cameras configured the same 
way at once.

Basic Camera Settings: General Settings
The general topics on operating the cameras are found in the general settings.
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Fig. 54: Camera Settings: General Settings

Arming
The main arming feature needs to be activated in order to process events, execute actions and notifications 
and record images and audio data. 

Parameter Explanation

Activated The camera is always armed.

Off The camera is not armed: no image storage, actions or messages.

CS Arming is controlled via a custom signal that needs to be previously configured on the cam-
era. The camera can use a signal input, for example, as the main switch for arming by using 
the custom signal. 

From master The camera is armed only when the master camera is armed.

See also:  n Recording, p. 364

 n MxActivitySensor, p. 361

Frequency of Power Supply
If the camera’s exposure control is not matched to the frequency of the power supply, sources of artificial 
lighting may lead to image interference. This parameter sets the camera to the power supply frequency of the 
respective country to prevent interference.
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Parameter Explanation

No artificial 
light

If the camera is used in daylight conditions (rather than with artificial lighting), you can also 
use the No artificial light setting.

50 Hz The factory default setting for Europe is 50 Hz.

60 Hz Set the power supply frequency to 60 Hz for Canada, the U.S. and Japan. 

Audio Source
Select the desired audio source. It is also possible to integrate an external audio source in addition to using 
the camera's microphone. The audio source is used for two-way communication and recording audio data, 
for example.

Basic Camera Settings: Time
The date and time can be manually set, adopted from the computer, or continuously synchronized through a 
time server. If you use a time server, the clock can be synchronized using a time server over the Internet, a 
time server service in the local network or another MOBOTIX camera. In this case, the camera's time server 
must first be set in the camera web UI Admin menu (Admin Menu > Camera Administration > 
Time & Date > Use Camera as Time Server).

Fig. 55: Basic Camera Settings: Time

Automatically Synchronize Using a Time Server
Two protocols are available for synchronizing the camera using a time server: NTP and Time Protocol. 
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Parameter Explanation

Time 
Server
      and 
     Time 
Server 
Address

 n NTP: With this protocol, the camera continuously synchronizes with one or more NTP 
time servers. If the NTP protocol has been selected, you can enter up to five time servers 
under Time server address. Theses servers must support the protocol specified in RFC 
1305. A green dot to the right of the time server address indicates that the time server is 
accessible and offers an NTP service. It can take a moment for the camera to connect to 
the time server and the dot to turn green.

 n Time Protocol: With this protocol, the camera synchronizes every six hours (and when it 
is rebooted). If Time Protocol (RFC 868) is selected, enter the Time server address in 
this box. The server must support the protocol specified in RFC 868.

Current 
Time

Display time of the current camera

Time 
Zone

Select the correct time zone for the camera location.

Do not adjust automatically
Deactivate automatic synchronization if the date and time are set automatically or if they are adopted from 
the computer. 

Parameter Explanation

Current Time Display time of the current camera
     If the camera’s time deviates from the computer’s time, click on Use PC time to adopt the 
computer’s time.

Set time manu-
ally

Capture the desired data to manually set the date and time and click on Set time to con-
firm the entry.

Time Zone Select the correct time zone for the camera location.

Basic Camera Settings: Image settings
To display the camera live images, you can set camera views, image and exposure settings in this tab and cre-
ate and edit custom exposure windows directly in the live image.
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Fig. 56: Image settings

JPEG quality
The JPEG quality influences both the image quality as well as the file size of the JPEG and MxPEG files gen-
erated by the camera.
Using a compression of 60% (default) will usually deliver good-quality images that are suitable for most pur-
poses. If the value is lower than 20%, you can see pixelation within the image. For values higher than 70%, 
differences to the uncompressed original image are hardly visible. The file size, however, may increase to 
more than 100 kB (for a 640x480 pixel image).

Camera selection
On Dual cameras, select the image sensor to use when displaying the images: right image sensor, left image 
sensor, both image sensors or automatic day/night switching. When configuring the image settings for both 
sensors, first select the sensor you want to configure using the left or right checkbox in the live image pre-
view window and enter the settings you want. 

Display mode
There are various display modes available depending on the camera model.

All Cameras Except Hemispheric Models

 n  Full image: The entire live image from the camera is displayed.

 n  Lens correction: This option displays a portion of the live camera image (with lens correction). This 
option is only available for L22 lenses, provided that the camera configuration is adjusted accordingly.

 n  Picture-in-Picture: This option displays a small image from one camera sensor inset in the large 
image of the other. This setting is available on MOBOTIX Dual models only.
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 n  Picture in Zoom: This option displays a small version of the entire live camera image in the lower 
right corner of the large live camera image. This way, the entire image is visible even when the live 
image is zoomed.

 n  Event in Picture: This option displays a small version of the latest event image in the lower right 
corner of the large live camera image.

Hemispheric Models

 n  Full image: The entire (distorted) full image of the image sensor is displayed.

 n  Normal: A corrected image is displayed. This image can be panned and tilted. This is the factory 
default setting for hemispheric cameras.

 n  Surround: This option shows four image sections (one for each cardinal direction: N, E, S, W) in one 
joint view. Note that you can use PTZ actions to modify all four views independently from one 
another.

 n  Panorama: This option shows the distortion-corrected image of an entire room (corrected 180° pan-
orama view) from the left to the right wall. The aspect ratio (width to height) is 8:3.

 n  Panorama focus: This display mode combines the panorama view (aspect ratio 8:3) with two smaller 
images (each with aspect ratio 4:3) in one large image.

 n  Double panorama: This mode shows a panorama view for the North half of the image and a second 
panorama view of the South half of the image using an aspect ratio (width to height) of 4:3. This view 
only makes sense for the ceiling-mounted MOBOTIX Hemispheric model. Both partial views (North and 
South) can be changed independently of each other using PTZ commands.

Installation
You can set the mounting position of a MOBOTIX Hemispheric camera: wall, ceiling or floor. The mounting 
positions are set separately for the left and right lenses for cameras with two active image sensors.

Exposure window
It is set to ensure the proper exposure/brightness for the live camera image. 

Custom
Creating And Editing Custom Exposure Windows Select the Custom option and then click on the window in 
the live image preview.     

Action Explanation

Create expos-
ure windows

Draw a window using the mouse pointer.

Move expos-
ure windows

Left-click on the exposure window and move it to the desired position.

110 / 375



Modify 
exposure 
windows

Move the mouse pointer over one of the white "handles" until the  icon is displayed. Left-

click with the mouse and drag the window making it larger or smaller.

Delete expos-
ure windows

Click .

Exclude 
areas from 
exposure 
metering

Pull open a window of the appropriate size at the position that should be excluded from 
exposure metering. Click in the window and keep the mouse button depressed until two 
icons appear. Click on  to determine the exclusion window. The window turns red.

Visible image area
This setting enables you to use the current visible image section as the exposure window.

Predefined
You can use a number of predefined exposure windows: When you select the corresponding window, it will 
be displayed in the live image for review. A predefined exposure window is always applied to the full-image 
area, that is, the entire image of the sensor.

 1. Full image: Entire area of the image.
 2. Quarter: An exposure window at the image center that covers a quarter of the viewable image area.
 3. Center: One exposure window at the image center.
 4. Spot: One small exposure window at the image center.
 5. Top: One horizontal exposure window at the top of the image.
 6. Center: One horizontal exposure window at the image center.
 7. Bottom: One horizontal exposure window at the bottom of the image.
 8. Right: One vertical exposure window at the right border of the image.
 9. Vertical: One vertical exposure window at the image center.

 10. Left: One vertical exposure window at the left border of the image.
 11. Right AND left: Two vertical exposure windows at the left and right borders of the image.

Exposure program
These parameters influence the balance between an exposure time that is as short as possible and hardware 
aperture that is as small as possible. The objective is to reach a fair compromise between clear images of 
moving objects (short exposure time, high amplification) and as little image noise as possible (long exposure 
time, low amplification).

 n  0: Default program.

 n  Negative: The programs will reduce exposure times to decrease motion blurring; could increase 
image noise.

 n  Positive: The programs will increase exposure times to reduce image noise; exposure in very bright 
environments is not impacted.
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Maximum exposure time
This parameter determines the longest exposure time used by the camera. This setting enables you to either 
avoid motion blurring as lighting conditions decrease, or even specifically allow it.   Select shorter maximum 
exposure times if you do not want motion blurring. You can use a longer maximum exposure time (max. of 
1/1 = 1 second, for example) if you want the camera to produce images with good exposure (with motion 
blurring), even in low light situations. 

Basic Camera Settings: Recordings
In this tab, the most important recording settings can be made, such as selecting the recording mode or set-
ting the recording speed.

Arming

The arming feature for event control handles camera recording. However, the main arming of the camera 
needs to be activated in order to make the recordings in the first place.

Parameter Explanation

Off The recording feature is deactivated.
     No further parameters will be displayed.

Activated The recording features of the camera are activated (default setting). 

CS The recording is activated by a custom signal (CS).

From master The recording feature of the camera will only be enabled if recording has also been activated 
on the master camera.
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Recording mode

You can select the type of recording for events and story images. The availability of the parameters will 
depend on the recording mode you select.
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Recording 
Type

Parameter

Snapshot 
Recording

This option will save individual pre- and post-alarm images (JPEG images), but without sound. 

Snap shot interval

This option determines the amount of time between the individual pre-alarm and post-alarm 
images. You can set values from zero to ten minutes (max.). 

Pre-alarm images

Number of the image that are recorded before the event.

Post-alarm images

Number of the image that are recorded after the event.

Unlimited time to keep

The time to keep is set to unlimited by default. You can select a maximum time to keep, 
expressed in hours and days, if you deactivate this option. 
       The maximum value for time to keep indicates how long images and video clips need to be 
stored.
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Recording 
Type

Parameter

Event 
recording

This option stores clip files for every event using the MxPEG codec with variable frame rate and 
optional audio data.

Record audio data

If available in the camera, audio data can also be recorded. Set this option to active to enable 
audio recording.

Event frame rate

Recording speed in frames per second (fps).

Recording time before event

Time (in seconds) to include in recorded stream before an event has occurred.

Recording time after event

Time (in seconds or minutes) to include in recorded stream after an event has occurred.

Unlimited time to keep

The time to keep is set to unlimited by default. You can select a maximum time to keep, 
expressed in hours and days, if you deactivate this option. 
The maximum value for time to keep indicates how long images and video clips need to be 
stored.

Continuous 
Recording

Continually saves video and (optionally) audio data as MxPEG clips.      

Record audio data

Similar to Event Recording, audio data from the camera be recorded with the same quality, 
regardless of the frame rate. Set this option to active to activate the microphone.

Frame rate

Recording speed for continuous recording.
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Recording 
Type

Parameter

Unlimited time to keep

The time to keep is set to unlimited by default. You can select a maximum time to keep, 
expressed in hours and days, if you deactivate this option. 
The maximum value for time to keep indicates how long images and video clips need to be 
stored. 

Basic Camera Settings: MxActivitySensor
The MxActivitySensor is a camera-internal video motion detector that can identify direction of motion detec-
tion and object size while blocking out any undesired interference (such as trees swaying in the wind) when 
detecting motion.  By default, a MOBOTIX camera ships with a predefined MxActivitySensor profile.
You can activate and deactivate this profile in this tab, change the name of the profile, adjust the event dead 
time, change the detection range and define new areas. 

 
Fig. 57: The MxActivitySensor 

Active
The MxActivitySensor profile is also activated when the Arming feature is enabled in the general settings. 

Profile name
You can change the preset profile name.

Event Dead Time
The event dead time defines a period of time (0–3600 sec.) after an event during which no new events from 
the same profile are detected. By defining an event dead time you can avoid, for example, that a complex 
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action (person walks through the active image area) triggers multiple events. You can adjust the preset event 
dead time (5 sec.).

Edit detection area
Proceed as follows to adjust the default detection area or to define additional image areas:
Click on the green detection area in the live image preview.

Action Explanation

Change 
shape of 
detection 
area

Position the mouse pointer on one of the white "handles" until the  icon is displayed. Click 

and hold the left mouse button and drag the frame to make the detection area larger or smaller.

Move 
detection 
area

Left-click on the detection area and move it to the desired position.

Rotate 
detection 
area

Click on  and, while holding the mouse button down, rotate the detection area clockwise or 

counterclockwise.

Change 
shape of 
detection 
area

Switch to polygon mode by clicking on . You will see white corner points on the corners. 

Drag the corner points to the desired position. You can insert new corner points by right-clicking 
on the white line or in the detection area. Right-click on a dot to delete a corner point. Then 
click on .

Deleting 
a Detec-
tion Win-
dow

Click on  .

Create a 
detection 
window

Use the mouse to pull open a new window in an area that is not yet covered by another window. 

Exclude 
area from 
analysis

Pull open a window of the appropriate size at the position that should be excluded from the ana-
lysis. Click in the window and keep the mouse button depressed until two icons appear. Click on 

 to determine the exclusion window. The window turns red. 

Basic Camera Settings: Network
Your network interface settings determine how the camera can communicate with the “outside” world and 
how the camera can be accessed from outside of the local network. When changing parameter values, please 

Setup
Configuring Basic Camera Settings

117 / 375



Setup
Configuring Basic Camera Settings

note that the changed values are not automatically applied as in the other tabs of the Configuration view. For 
changes to take effect, you must click on  in the Command bar.

 

Internal host name

The host name is the unique camera name in the network under which it is accessible.

BOOTP/DHCP

BOOTP and DHCP are protocols with which IP addresses can be managed in a network and automatically 
assigned. The camera can use them to automatically obtain its network configuration. 
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Parameter Explanation

Off The camera’s network configuration is manually established. Enter the appropriate information 
in the IP address and subnet mask boxes and, if necessary, change the standard route or gate-
way and the DNS server.
IP Address: You can access the camera in the network via its IP address. Ask your network 
administrator which IP address is available.
Subnet Mask:: A matching subnet mask needs to be entered for the IP address in order for com-
puters to be able to communicate in a network. Again, it is your network administrator who will 
tell you which subnet mask to use.
Default Gateway:
The gateway acts a relay between individual networks and it coordinates the data traffic 
between these networks. Enter the IP address of the gateway that should be used.
DNS Server:
A Domain Name Service (DNS) resolves computer names to IP addresses. If you have a DNS on 
your network, you can specify up to three IP addresses of DNS servers. This is only necessary if 
you want to address computers using their name instead of their IP address for other con-
figurations (FTP, email). 

On
client 
mode 

Use BOOTP/DHCP to set the IP address and network configuration automatically. The gateways 
and the default route are automatically determined via BOOTP/DHCP and configured.

On
server 
mode 

This camera provides DHCP service to clients on the local network. The IP address of the camera 
will be 192.168.0.19 with subnet mask 255.255.255.0 by default.

Default Gateway:
Enter the IP address of the gateway that should be used.
DNS Server:
A Domain Name Service (DNS) resolves computer names to IP addresses. If you have a DNS on 
your network, you can specify up to three IP addresses of DNS servers. This is only necessary if 
you want to address computers using their name instead of their IP address for other con-
figurations (FTP, email). 

Additional IP address

The camera can manage two different network configurations. If you enable this checkbox, the factory 
default IP address and the subnet mask will also be used, ensuring that the camera remains accessible at all 
times.

Checking System Security
After completing the basic configuration of the system, you can check its security. The Wizards & Tools, p. 
256 view offers the Secure System wizard. It analyzes the security of the cameras and assesses their status 
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based on common best practices. If test criteria are not met, possible measures to protect the cameras are 
provided. 

Note
The system security check feature is not available for MOBOTIX MOVE cameras and third-party cameras 
that provide an ONVIF S-compatible interface. For an overview of how the camera functions differ, see    Cam-
era Feature Overview, p. 13   .

Verifying Settings for System Security

 1. To open the Wizards & Tools view, right-click on the navigation key in the Command bar. Select the 
Wizards & Extras view.

 2. Select the desired camera or camera group in the Device bar or the Camera/Group bar.
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 3. Click Secure System. The following criteria are checked:
 n Usage of the "meinsm" password with standard or ONVIF user accounts on MOBOTIX cameras. It is 

easy for cyber attackers to guess the standard "meinsm" password.

 n Enabled Public Access: If Public Access is enabled, a number of different camera functions can be 
used without a password.

 n Activated HTTP web server: It is possible for data, including user data such as passwords and images, 
to be transmitted via the network without encryption when HTTP is used. 

The result of the check is displayed for each camera in the Secure System dialog. It will also show all cases 
in which cameras were not checked due to a connection error, for example.

Status Explanation

 Not secured There was at least one criterion that was listed as not secure.

 Software too old Please check the camera software and update it, if necessary.

 Connection error Check your network connection to the camera and perform the security check again. 

 Not supported The camera (s) cannot be analyzed or secured using the wizard.

 Secured Camera is secure; no further action is necessary.
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Secure System

 4. In the Secure System dialog, click on Next. Cameras resulting in a Not secure status are displayed 
together with whichever of the three criteria that were fulfilled as well as the measures that need to be 
taken to properly secure the cameras: 

Criterion Explanation

Password Changes the password of all user accounts on the cameras that use the standard “meinsm” pass-
word. It also include ONVIF users whose passwords have never been changed.
      Enter a new password and confirm it. A suitable password has at least eight characters. It can 
consist of lowercase and uppercase letters, digits and special characters (see ). If you set a 

password that does not meet these criteria, a red frame appears around the text field. The frame 
turns green once you have entered a valid password.
     The new password is automatically entered in the MxMC project data. 

SSL 
encryption

Disables camera connections via unencrypted HTTP and configures the cameras to accept 
HTTPs connections only.
      The TCP port and the SSL setting will be automatically updated in the MxMC project data, if 
necessary. 
      The TCP port will not be updated for cameras that are connected via a remote URL. For remote 
URL connections, you may need to change port forwarding in the router to the appropriate set-
ting.
Please note that different services, such as network messaging etc., will no longer work when 
you disable HTTP. 

Public 
Access

Disables access that does not require password entry to the web interface and the APIs of the 
cameras. 

 5. Click on OK in the dialog box. The selected security measures will be performed. The security status for 
the selected camera or camera group will be analyzed once again and the result for each camera is dis-
played. 

Backing Up System Settings
Once the system has been set up to add all the cameras, organize the cameras into groups, create the users, 
set their access permissions and verify system security, you should save the settings as a project. Everything 
is saved, except for settings that are only relevant for the local installation, such as the Remote Control port.
 Secured system settings can be e-mailed directly from the application to other people. You can also include 
the encrypted access data for each camera (user name and password). When opening the project in MxMC, 
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this access data will be used automatically. If you do not supply the access data, the user name and pass-
word will have to be entered manually for each camera.
Furthermore, you can quickly export a tabular overview of all cameras and camera groups from MxMC and 
save it in the usual way. The table lists the cameras with their IP addresses and the camera groups with the 
associated cameras.

Saving projects

 1. Click on  in the Header bar. The Projects and Network Environments dialog opens.

 2. Click on Save As  and complete the dialog.

Providing projects via email
In the header bar, click on Projects and Environments  and then on Email to . This will generate a 
project file which will be transferred to the mail program as an attachment within a new e-mail. 

Note
a properly configured email client is required for this purpose.         

Export MXU File
You can conveniently add large numbers of cameras, camera groups, devices and recordings/clips in MxMC 
using a list in MXU format. To create an MXU file based on the current project data, proceed as follows:

 1. Select File > Export MXU… from the Menu bar. 
 2. Click on Save. The table is saved as an MXU file.
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Import Existing Project
If you have already used MxControlCenter or MxEasy, you can import an existing MxControlCenter.ini file 
from the MxControlCenter or the MxEasy.ndb camera list from an MxEasy installation. In both cases, the cam-
eras already integrated in the MxControlCenter (MxCC) or MxEasy are automatically transferred to the 
MxManagementCenter with their access data.
Furthermore, it is possible to quickly integrate a large number of cameras and camera groups into MxMC 
using a manually created list inMXU format. You need to adhere to specific rules for the format when creating 
the list in order to correctly export the contents of the MXU file.

Importing configurations from MxControlCenter
When importing an MxCC file, the following is taken into account: 

 n The layouts defined in MxCC are created as groups in MxMC.

 n The background layouts from MxCC, including the background graphics and definitions of the camera 
symbols, are transferred to the Graphic view of the associated group.

 n If a global password has been assigned, this will be entered for all cameras that do not have a user 
name.

 n For each hyperlink used, a softbutton is created in MxMC.

 n Furthermore, the tree structure from MxCC is shown in the Device bar and file servers configured in 
MxCC are created in the MxMC settings.

Fig. 58: Importing configurations from MxControlCenter

 1. Open the Welcome Wizard from the File > Welcome menu.
 2. Click on Import MxCC. Decide if the current project should be saved.
 3. Import the desired INI file.
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Importing Configurations From MxEasy

Fig. 59: Importing Configurations From MxEasy

 1. Open the Welcome Wizard from the File > Welcome menu.
 2. Click on Import MxEasy. Decide if the current project should be saved.
 3. Import the desired NDB file.

Importing MXU Files
Using a manually created list in .MXU format, you can quickly add a large number of cameras and camera 
groups. You need to adhere to various formatting rules when creating the list in order to correctly export the 
contents of the MXU file (see Creating MXU Files for Imports, p. 126).

Important
This list does not replace the project import, during which program settings, such as settings for the cam-
eras and camera groups with assigned layouts, are imported.
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 1. Click on Import MXU to import cameras and camera groups in the Welcome wizard. You can save the 
existing project, if necessary.

 2. Open the MXU file.
 3. Decide whether the cameras and groups from the MXU file should replace the entire configuration or they 

should be only added.

Creating MXU Files for Imports
You can quickly add a large number of cameras and camera groups to the MxMC using an MXU file. There are 
several format specifications that need to be followed when generating such an MXU file. 

Format for Simple Imports
It needs to adhere to the following format for a simple import of cameras:

 n Unformatted UTF-8 text

 n One or more camera lines with the following structure:
Name<TAB>IP<TAB>Username<TAB>Password<CR LF/LF>

 n Elements in a camera line need to use TABs as separators.

 n Line breaks are either CR LF (Windows) or LF (UNIX).

 n Comment lines are preceded by a //.

 n Camera names need to be unique and cameras using the same name will not be added more than 
once.

Example:     Main Entrance   10.6.37.25   admin   meinsm
     Side Entrance   10.6.15.206  admin   meinsm
    Entrance Gate   10.6.23.132  admin   meinsm
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Format for Advanced Imports

Expanded Format

The file needs to use the following format for the advanced import of cameras, groups, clips and settings for 
graphics and grid view:

 n First line always #EXTMXU

 n Any additional commands must start with #EXT. Parameters use “:” as separators. 
Example:#EXTGROUP:Doorstations

Commands for advanced imports

#EXTMXU Marker to indicate the beginning of the file 

#EXTGROUP:name:f:r:icon:map:info Group “name” is created and all further cameras will be added to this 
group. 

f: Large focus window (0=0x, 1=1x, 2=2x ...) 

r: Tile ratio (0=4:3, 1=HD, 2=8:3) 

icon: If numeric, index of the internal group icons; otherwise, file name 
corresponding to the *.mxu file. 

map: File name of the background image 

info: File name of the information page 

#EXTGROUP: All further cameras will not be added to a group if no name is specified 
(unless “All cameras”). 

#EXTCLIP:clipMXG Camera demo clip is added. Clips need to be stored in the same dir-
ectory as the *.mxu file.

#EXTMXPEG:name:clipMXG MxPEG clip with “name” is added. This references the absolute path of 
the MXG file.

#EXTCURRENTCAMERA:name Select camera. 

#EXTCURRENTGROUP:name Select group. 

#EXTSUBGROUPS:name The following groups (each with the name in a line) are added to the 
group “name” as a subgroup.

#EXTINFO:Comment Comment line. 

#EXTEND End of file, all further lines are ignored. 
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Example:     #EXTMXU
     #EXTGROUP:Doorstations:2:2:2
     Main Entrance           10.6.37.25        admin   meinsm
     Side Entrance           10.6.15.206       admin   meinsm
 
     #EXTGROUP:Indoor:2:2:3
     Building East           10.3.31.251       admin   meinsm
     Building West           10.7.25.186       admin   meinsm
     Staircase               10.6.115.57       admin   meinsm
     Canteen                 10.12.32.65       admin   meinsm
 
     #EXTGROUP:Outdoor:2:2:4
     Parking Visitors        10.5.46.39        admin   meinsm
     Parking Employees       10.10.231.107     admin   meinsm
 
     #EXTGROUP:Dual Cams:2:2:10
     Checkout1               10.10.106.26      admin   meinsm
     Checkout2               10.10.152.225     admin   meinsm
     Checkout3               10.13.242.195     admin   meinsm
 
     #EXTGROUP:Faststreams:2:0:11
     Ground Floor            10.2.2.169        admin   meinsm
     First Floor             10.2.104.130      admin   meinsm
     Second Floor            10.3.11.51        admin   meinsm
     Elevator                10.3.209.198      admin   meinsm
 
     #EXTGROUP:Clips:2:2:groupIcon.png:groupMap.jpg
     #EXTCLIP:FiremanMXG
     #EXTCLIP:PoleMXG
 
     #EXTCURRENTCAMERA:Main Entrance
     #EXTCURRENTGROUP:Doorstations
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Using The Application
This section is for users. It provides assistance with daily MxMC operation, from monitoring one or more cam-
eras to searching records.

Areas Topics

Live Surveillance Working with the Live view
Working with the Grid view
Working with the Graphic view
Using Door Stations
Working with multiple monitors
Working in different network environments

Alarm Processing Alarm notification
Setting up alarm notification
Filtering alarm images
Playing back alarm recordings

Searching in MxMC Searching and playing back in the research view
Searching and playing back in the grid playback
Searching and playing back in the search view
Searching and playing back door events
Exporting recordings
Special search features

Live surveillance
The section describes basic scenarios and options of live surveillance.

Working With The Live View
The Live view allows you to control the live images of individual cameras. This also includes switching vari-
ous functions, e.g, opening doors or switching lights.
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Showing Cameras

Fig. 60: Showing cameras

To view a camera, you can use the Device or Camera bar. To do this, either drag and drop the desired camera 
from the Device bar into the display area or click on the desired camera in the Camera bar. The displayed 
camera is marked with a yellow bar in the Device bar as well as in the Camera bar.

Customizing Image Settings

Fig. 61: Customizing image settings

Use the Brightness  and Contrast  controls to adjust the image display of the displayed camera to the 
current environment.
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Move the corresponding slider upwards or downwards. The new settings are stored automatically for the cur-
rent camera. The default values can be restored by double-clicking on the corresponding slider.

Note:
Adjusting the image settings does not have any effect on the camera settings. These will not be changed

Performing PTZ Actions

Fig. 62: Performing PTZ actions

Note
On a secondary monitor, a single camera image can only be zoomed with the mouse wheel or panned with 
the mouse button pressed down. PTZ controls are only available on the MxMC main screen or on the sec-
ondary monitor in Grid View.

To better identify objects in an image section, you can zoom the live image and move the resulting image 
area around (PTZ). To facilitate quick loading of these image sections, several image positions are already 
pre-configured for loading using the slider .
The program also shows the  slider on Dual cameras. Use this slider to show the live images of either the 
right, the left or both image sensors.
When showing the live images of hemispheric cameras, you can configure different display modes (slider 

Zooming and Moving Image Sections
You can zoom using the slider  or the mouse wheel. Zooming with the slider takes place only on the com-
puter. This means that only the image section of the current live image is modified.
To see other image sections, you can move the live image using the mouse.
If you want to execute the PTZ actions on the camera, you can also switch to camera PTZ. In this case, the 
PTZ actions are applied to the camera's live image and also influence the recordings (but only if the camera 
does not record the full image). To use this feature, click on the slider  and keep it pressed until it starts 
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flashing. You can now adjust the zoom level as needed. To store the setting, click again on the slider and 
keep it pressed until the slider stops flashing.

Selecting and Adjusting Image Sections

Selecting Image Sections

To quickly focus on a specific image section, you can use one of the factory default image positions that are 
predefined in the camera. 

 n Preview , detail , overview  and point of interest

 n Top , bottom , left , right

The camera will then move to the selected position. Note that the PTZ actions are executed on the camera 
and also influence the recordings (only if the camera does not record the full image).   Move the  slider to 
the next position or until you have found a suitable position.

Adjusting Image Sections

You can adjust the pre-defined image positions of the factory default. Select a position and modify it as 
needed. Keep the slider on this position until it flashes once. The new image section has been stored.

Choosing a Sensor
If you want to show the live images of only the right or the left image sensor, you can move the  slider to 

the right to  (left sensor) or further to the right to  (right sensor).

Correcting The Distortion Of Hemispherical Images
When showing the live images of hemispheric cameras or cameras with the lenses L12/B016, L23/B036, 
L25/B041, you can select different display modes. This requires that you enabled OpenGL in the settings 
(Mac: MxManagementCenter > Settings > General menu; Windows: File > Settings > General menu). In 
order to get naturally-looking images, the camera will automatically correct the distortion in these modes. 
This distortion correction can be refined even further when using the panorama correction. The selection of 
a display mode is always done locally and thus does not influence the camera settings. However, the selec-
tion is also applied to the other program views. When selecting a display mode in the live view for a specific 
camera, this mode is also applied if the camera shows up in the focus window of the Grid view as well as in 
the live images of the Graphic view. Consequently, the alarm images in the Alarm bar and in the Research 
view are also shown in the selected display mode.
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Selecting The Distortion Correction Mode

 n Full image: Shows the entire (distorted) full image.

 n Normal: Shows a distortion-corrected image and allows executing PTZ actions. 

 n Panorama: Shows the entire distortion-corrected image (corrected 180° panorama) from the left to 

the right border. The aspect ratio (width to height) is 8:3. 

 n Surround: This option shows four image sections (one for each cardinal direction: N, E, S, W) in one 

joint view. Note that you can use PTZ actions to modify all four views independently from one 
another.

 n Double panorama: This mode shows a panorama view for the North half of the image and a second 

panorama view of the South half of the image using an aspect ratio (width to height) of 4:3. This mode 
makes sense for a hemispheric camera that is mounted to the ceiling. It can be customized sub-
sequently using local PTZ.

 n Panorama focus: This display mode combines the panorama view (aspect ratio 8:3) with two smal-

ler images (each with aspect ratio 4:3) in one large image.

To select a mode, move the slider  to the right until you reach the desired position. This slider position 
will be stored automatically until you change it again.

Panorama Correction

The distortion-corrected images of the different display modes can be further refined. For example, if the 
image in Panorama mode is not centered, you may see a trapezoidal distortion. The panorama correction 
allows adjusting the skewed (vertical) lines of the image to produce a more naturally-looking image. To do 
so, move the  slider to the right to  and use the mouse to correct the image. To store the corrected set-
ting, click on the  slider and hold it until the slider icon briefly appears in the center of the image.

Status Display
The Status bar displays different states by means of icons. The status displays always refer to the displayed 
camera. This gives you an up-to-date overview, e.g., showing you at a glance whether a door has been closed 
again or is still open.
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Fig. 63: Status display

Door Status Dis-
play

 = door is closed.
 = door is open.
 = door is locked.
 = door lock switch is locked, but the door is open! 

Light Status Dis-
play

 = light is off.
 = icon is lit: Lights are on, need to be switched off manually. 

Microphone 
Status Display

 = microphone is switched off, no announcement possible.
 = microphone is on, announcements are possible.
 = microphone connection is blocked, possibly because a connection has been estab-

lished to a different remote station. 

Switching additional devices via hyperlink
Hyperlinks can be used to switch additional devices or to send HTTP requests. When defining hyperlinks, you 
can select an individual button icon for the hyperlink (there are several pre-defined icons to choose from) or 
set one button from which to run all hyperlinks.
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Fig. 64: Switching additional devices via hyperlink

To define a hyperlink, right-click on  and then on .
In case you did not assign an icon for the individual hyperlinks, they will be combined under one  button. 
To execute such a hyperlink, click on  and then on the name of the desired hyperlink.

Manually recording live images
In the Live view as well as in the Grid view, you can start manual recording at any time, such as when you 
observe a suspicious situation that should be recorded. While you keep track of the situation in the live 
image, the images are recorded and saved as a MXG file. 
   Users with administrator rights can specify where the clips are saved and how long the recordings can be in 
the Program Settings (Mac: menu: MxManagementCenter > Preferences > Live Recorder, Windows menu: 
File > Settings > Live Recorder).

Notes:
This feature is not supported by MOBOTIX MOVE cameras and third-party cameras that provide an ONVIF-S 
compatible interface. For an overview of how the camera functions differ, see Camera Feature Overview.             

Audio can only be recorded with the Live Recorder under these conditions:

 n Audio transmission must be activated on the camera side.

 n In the Live View of the MxManagementCenter, the audio connection must be activated by clicking on 
.
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Fig. 65: Manually recording live images

Starting And Stopping Recordings

To start recording, click on Live Recorder . Recording will stop automatically after the recording time set 
in the program settings has expired. Just before this time expires, a message will be displayed. You can stop 
the recording from within this message or extend the set period of time. To stop recording before the time 
expires, click on  again.

 Note
If you change the view, the recording is automatically stopped. However, a camera change within the Live 
view does not stop the recording.

Play Clip

The live image data is stored in a MXG file at the location specified in Program Settings during recording. The 
clip file is automatically imported into the current project when the recording stops and the Device bar 
shows it alongside the  icon in the Clips section. You can click on the clip name to playback the MXG clip 
file via the Device bar.             

Working With The Grid View
The Grid view consists of a grid of live images and one focus window. This grid (tile) structure is ideal for get-
ting a quick overview of all cameras of a group. You can drag the camera image that is most interesting to 
you onto the focus window. Use the controls at the bottom to operate the camera.
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Showing a group
To view another group, you can use the Device bar or the Group bar. To do this, either drag and drop the 
desired group from the Device bar into the display area or click on the desired group in the Group bar. The 
displayed group is indicated by a yellow bar in the Device bar as well as in the Group bar.

  
Fig. 66: Showing a group

Working With The Focus Window
At the bottom of the focus window is a Command bar with controls that allow you to operate the camera in 
the focus window. If you move the mouse pointer over the Command bar, further controls are displayed.

  
Fig. 67: Camera in a focus window
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Zooming And Moving Image Sections

Use the slider  to zoom. The zoomed image sections can then be moved with the mouse. These actions 
take place in the application. This means that only the image section of the current live image is modified. 
The camera will not move and therefore zooming will not affect the possible recording of the generated cam-
era image. 

 1. Drag the slider  to zoom in on or out of the live image.

 2. Move the image with the mouse to focus on individual image sections.

Select predefined image sections.

To quickly focus on a specific image section, you can use one of the factory default image positions that are 
predefined in the camera.

 n Overview , point of interest , preview  and detail view 

 n Top , bottom , left , right 

Move the slider Standard  to the next position or until you have found a suitable position. 

Accept and end calls.

To talk to visitors at the door, click on . To end an audio connection, click on .

Opening Doors And Switching Lights

If a camera is connected to a door station and has been configured accordingly, you can open the door by 
clicking on . If the camera is also connected to a light switch and configured accordingly, the light can be 
turned on and off by clicking on .

Show Temperature

MOBOTIX cameras have a built-in temperature sensor that measures the temperature inside the housing. If 
an ExtIO module or an MX-GPS-Box is connected to the camera, you can also measure the ambient tem-
perature of the module or the box and view it by clicking on .

Executing Hyperlinks

If hyperlinks have been defined and configured, their function can be executed by clicking on .
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Camera Sequencer

If you want to see a different camera in the focus window, simply drag that camera to the focus window. 
Note that the camera sequencer can also switch cameras automatically.

Instructions:

 1. Click on the camera sequencer icon  to activate the automatic switching. 

 2. Right-click on  to change the following settings:

 n Duration Slider: Move the slider to the desired duration (1 sec to 60 sec) to show each camera.

 n Autostart: Once you switch to the Grid view, the sequencer starts automatically.

 n Stop at event: The sequencer stops when an event has occurred, allowing you to further investigate 
the situation. To start again, click on .

 n Restart after confirmation: Activate this option if you want to avoid having to restart the sequencer 
over and over again.

Group Sequencer

If you want to display a different camera group in the focus window, drag and drop that camera group into 
the focus window. A grid with all cameras of the group will be displayed and each camera of the group will 
be shown sequentially in the grids focus window for a defined time. You can automate this camera group 
change with the group sequencer.

Instructions:

 1. Click on the group sequencer icon  to activate the group sequencer.

 2. To change the sequencer settings right-click on :

 n Duration: set the duration to show each group. You can set a value between 1 sec and 60.  The “Com-
bined Sequencer”  activates the group sequencer together with the camera sequencer (“Autostart” on 
the camera sequencer is not needed). The group sequencer waits until all cameras on a grid or graphic 
have been cycled before switching to the next group. When the “Combined Sequencer” is active then 
the camera sequencers “Stop at Event” and “Restart after Confirmation” also apply to the group 
sequencer.

 n Autostart: Once you switch to the Grid view, the group sequencer will start automatically.

Switching group functions
At the bottom of the program window is a Command bar with controls that change depending on the selec-
ted view. In the Grid view, you can use the group buttons of the Command bar to control the functions of a 
camera group (Prerequisite: Group functions were assigned in the Group Functions dialog box). This means 
that you can switch on/off lights, open a door and make an announcement for a predefined camera of this 
group, regardless of the currently displayed camera. You can also assign the functions for switching on/off 
lights and opening doors to several cameras of this group, enabling you to switch on/off several lights or 
open several doors. 
    In addition, you can right-click on the group buttons to open the shortcut menu in order to control cameras 
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that are not part of the current group. Before you can do this, the cameras have to be set up accordingly, 
that is, they need to be connected to door openers/light contacts and have to be configured properly.

  
Fig. 68: Switching group functions

Manually recording live images
In the Grid view as well as in the Live view, you can start manual recording at any time, such as when you 
observe a suspicious situation that should be recorded. While you keep track of the situation in the live 
image, the images are recorded and saved as an MXG file. The camera's live image that is in the focus win-
dow is always recorded. For this reason, live recording can also only be used in the Grid view when there is a 
focus window.
     Users with administrator rights can specify where the clips are saved and how long the recordings can be in 
the      Program Settings, p. 230     (Mac: menu: MxManagementCenter > Preferences > Live Recorder, Windows 
menu: File > Settings > Live Recorder). 

Note
     This feature is not supported by MOBOTIX MOVE cameras and third-party cameras that provide an 
ONVIF S-compatible interface. For an overview of how the camera functions differ, see      Camera Feature Over-
view, p. 13     .
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Fig. 69: Manually recording live images

Starting And Stopping Recordings

To start recording, click on Live Recorder . Recording will stop automatically after the recording time set 
in the program settings has expired. Just before this time expires, a message will be displayed. You can stop 
the recording from within this message or extend the set period of time. To stop recording before the time 
expires, click on  again.

Note
    The recording ends automatically when switching to another view. However, changing the group within 
the Grid view will not result in an early termination of the recording, unless that group has no focus win-
dow. In the latter case, the recording will end. 

Play Clip

The live image data is stored in an MXG file at the location specified in Program Settings during recording. 
The clip file is automatically imported into the current project when the recording stops and the Device bar 
shows it alongside the  icon in the Clips section. You can click on the clip name to playback the *MXG clip 
file via the Device bar. 

Working With the Graphic View
You can define a floor plan (ground plan) in the Graphic view and place the cameras or camera groups 
according to their actual positions. The icon of the corresponding camera turns red in case of an alarm (or 
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green upon a bell event). A simple click is enough to show the current live image of the triggering camera, 
allowing you to quickly check the situation.

Temporarily showing the live image of a camera
To temporarily display the live image of a camera, move the mouse pointer over the camera icon. In addi-
tion, the live image of another camera group can also be displayed in the Graphic view. Drag & drop the 
desired camera from the Camera bar onto the floor plan. When changing the view, the live image disappears.

Automatically display all live images of a group
To keep track of all live images in the current group, you can activate the camera sequencer or the group 
sequencer. When the sequencer is activated, all live images of the camera group are displayed one after 
another in a small window. You can move this window to any location and enlarge it or make it smaller. 

Camera Sequencer
If you want to see a different camera in the focus window, simply drag that camera to the focus window. 
Note that the camera sequencer can also switch cameras automatically.

Instructions:

 1. Click on the camera sequencer icon  to activate the automatic switching. 

 2. Right-click on  to change the following settings:

 n Duration Slider: Move the slider to the desired duration (1 sec to 60 sec) to show each camera.

 n Autostart: Once you switch to the Grid view, the sequencer starts automatically.

 n Stop at event: The sequencer stops when an event has occurred, allowing you to further investigate 
the situation. To start again, click on .

 n Restart after confirmation: Activate this option if you want to avoid having to restart the sequencer 
over and over again.

Group Sequencer
If you want to display a different camera group in the focus window, drag and drop that camera group into 
the focus window. A grid with all cameras of the group will be displayed and each camera of the group will 
be shown sequentially in the grids focus window for a defined time. You can automate this camera group 
change with the group sequencer.

Instructions:

 1. Click on the group sequencer icon  to activate the group sequencer.

 2. To change the sequencer settings right-click on :

142 / 375



 n Duration: set the duration to show each group. You can set a value between 1 sec and 60.  The “Com-
bined Sequencer”  activates the group sequencer together with the camera sequencer (“Autostart” on 
the camera sequencer is not needed). The group sequencer waits until all cameras on a grid or graphic 
have been cycled before switching to the next group. When the “Combined Sequencer” is active then 
the camera sequencers “Stop at Event” and “Restart after Confirmation” also apply to the group 
sequencer.

 n Autostart: Once you switch to the Grid view, the group sequencer will start automatically.

Switching group functions
At the bottom of the program window is a Command bar with controls that change depending on the selec-
ted view. In the Graphic view, you can use the group buttons of the Command bar to control the functions of 
a camera group (Prerequisite: Group functions were assigned in the Group Functions dialog box). This means 
that you can switch on/off lights, open a door and make an announcement for a predefined camera of this 
group, regardless of the currently displayed camera. You can also assign the functions for switching on/off 
lights and opening doors to several cameras of this group, enabling you to switch on/off several lights or 
open several doors.
    In addition, you can right-click on the group buttons to open the shortcut menu in order to control cameras 
that are not part of the current group. Before you can do this, the cameras have to be set up accordingly, 
that is, they need to be connected to door openers/light contacts and have to be configured properly.

Fig. 70: Switching group functions

Operate Door Stations
Door Stations can also be integrated and operated with the MxManagementCenter. For this purpose, Door Sta-
tion-specific functions are provided in addition to the program functions for cameras.
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Note
Door Station functions are not supported by MOBOTIX MOVE cameras and third-party cameras that provide 
anONVIF S-compatible interface. For an overview of how the camera functions differ, see:   

 n Camera Feature Overview, p. 13.

 n Door Station Settings, p. 207

Bell Signaling
If someone rings the doorbell, it can be indicated in different places of the application.
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Where? Explanation

Alarm bar 
and Alarm 
Info bar

A bell event is indicated by coloring the Alarm and Alarm info bar green. The prerequisite for 
this is that the Door Station bell events have been configured as alarms in the Camera Con-
figuration dialog. The Alarm bar ①  is located at the bottom of the MxManagementCenter and 
the Alarm Info bar ②  below the camera image of the corresponding door camera.
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Where? Explanation

Doorbell 
notification

When the bell is rung, a ringing notification is displayed, no matter which view you are in. The 
prerequisite for this is that the Door Station bell events were configured as alarms in the Cam-

era Configuration dialog and that the Notification  was not deactivated in the header.

Note
The notification can be temporarily disabled by an administrator by clicking on Notification

 in the application header.

Counter on 
the bell 
icon

The counter next to the bell icon  in the Live view is increased by one.
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Where? Explanation

Setting Bell Signaling

Go to Door Station Settings, p. 207 to find out which signaling options can be combined and where they can 
be configured.

Open Door and Switch Lights
If the door camera has been set up properly, you can use MxMC to open the door and to switch the lights. To 
do this, use the  and  keys in the Live view Command bar and in the Command bar of the Grid view 
focus box.

Working With Multiple Monitors
MxManagementCenter supports the use of multiple monitors. Camera live images can be displayed on mon-
itors directly connected to the computer running MxMC . Camera live images can also be switched to addi-
tional display devices using an MxThinClient.

Displaying Live Images On Monitors Connected To The Computer
If several monitors are connected to the computer running MxMC , the live images of individual cameras can 
be displayed by double-clicking on the different monitors. To do so, double-click either:

 n on a camera image in the Camera bar

 n on an event image in the Alarm bar
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 n on a camera image in the Grid view

 n or on a camera icon in the Graphic view

and select the monitor on which you want to view the live image.   

Fig. 71: Displaying Live Images On Monitors Connected To The Computer

Using MxThinClient To Display Live Images On Additional Monitors
As far as MxMC is concerned, any number of monitors can be connected and operated. However, the number 
is limited by the graphics card installed in the computer. By using one or more MxThinClient devices, you 
can increase the number of display devices available for MxMC. This allows you, for example, to switch to 
additional display devices (monitors or TV sets) by double-clicking on the camera live images from MxMC.

Note
MxThinClient devices are not supported by MOBOTIX MOVE cameras and third-party cameras that provide 
an ONVIF-S-compatible interface. For an overview of how the camera functions differ, see Camera Feature 
Overview, p. 13.

Adding a MxThinClient

 1. The MxMessageSystem needs to be activated in the Program Settings, p. 230 because the camera live 
images are connected via this system (Mac: MxManagementCenter > Settings > MxMessageSystem; 
Windows: File > Settings > MxMessageSystem). Also, make sure that the same parameters are set as in 
the MxThinClient.
   Furthermore, you must make sure that MxThinClient and the computer running MxMC use the same time 
server.
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 2. Open the edit mode in the Device bar by clicking on  at the bottom of the bar. Next, click on . The 
Add and Import dialog opens.

Fig. 72: Adding a MxThinClient

 3. Click on  . The MxThinClient Configuration dialog box opens.

 4. Enter a name for the MxThinClient that will be shown in the Device bar. You can freely select the name.
 5. Use the URL option to enter the current IP address or DNS domain name.
 6. Under Serial Number you need to enter the factory IP address printed on the MxThinClient housing. 

Remember that you need to enter the number correctly because it represents the address at which the 
MxThinClient is accessed in the MxMessageSystem.

 7. Enter the user name and password you used when installing the MxThinClient.
 8. Select the resolution that the camera's live image uses when data is sent to the additional display unit. If 

you select a resolution that is not supported by the display device, the message Resolution Not Sup-
ported is shown on the display of the display device. In this case, select a lower display resolution.

 9. Select how long the live camera image will be displayed before the MxThinClient will continue to run in 
the configured mode.
    If you select Unlimited for the display length, the camera's live image is displayed until the MxTh-
inClient receives a new command, such as when an event is triggered based on an event-controlled set-
ting.
   If you want to stop the display of the camera’s live image before the set display length elapses, click on 
the  icon. It appears when you move the mouse pointer over the name of the MxThinClient in the 

Device bar.
 10. Close the dialog box. Then deactivate the edit mode of the device bar by clicking on .

Using The Application
Live surveillance

149 / 375



Using The Application
Live surveillance

Using MxThinClient

To switch a live camera image to an additional display device, either double-click on the desired camera 
image or drag and drop the camera image to the appropriate MxThinClient in the MxThinClient section of 
the Device bar. 

Notes
The MxThinClient section is only visible in the Device bar if a MxThinClient has been integrated.
You need to possess administrator rights to add, manage or delete an MxThinClient.

Working In Different Network Environments
Using MxManagementCenter, you can access cameras from different locations. For example, you can monitor 
the cameras at home over the local area network (LAN) or while on the move via a pre-configured DynDNS 
access over the Internet.
See also: Network Environments

Selecting an Environment
If you want to access the cameras from a different location (different network), select the corresponding pre-
viously created environment. Switching to a different environment causes the network address data for con-
necting to the cameras to be switched automatically.

Fig. 73: Selecting an Environment

 1. Right-click on  in the Header bar. The Projects and Network Environments dialog opens.

 2. Click on Environment.
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 3. Select the desired environment.

Temporarily Adjusting the Bandwidth
By assigning a bandwidth to an environment, you can specify how the images are pulled from the cameras 
given different connection speeds. This basically controls how the images can be displayed for live viewing 
and event research. Selecting a bandwidth thus also controls the image quality. Note that you can tem-
porarily overwrite the bandwidth setting without actually changing the camera setting.

 1. Click on  in the Header bar. The Bandwidth Mode dialog opens.

 2. Select the desired setting:
 n  HiRes: The images are transferred using the settings made in the camera.

 n  LoRes: Images are delivered at the frame rate, resolution and image quality as defined in the Pro-

gram Settings for LoRes.

 n  Unchanged: Use this to return to the original setting of the camera.

Alarm Processing
An important component of a video management system is the alarm function. It allows you to specify which 
events lead to alarms and how you are notified in the event of an alarm. In addition, you can define the alert-
ing behavior for individual time periods in weekly profiles.
Note: Alarm processing functions are not supported by MOBOTIX MOVE cameras and third-party cameras 
that provide an ONVIF-S-compatible interface. For an overview of how the camera functions differ, see Cam-
era Feature Overview.

Alarm Notification
Alarm-triggering events can be signaled at various points in the application.

Where? Explanation

Alarm bar 
and Alarm 
Info bar

If alarm notification has been activated in the Camera Configuration, the Alarm and Alarm 
Info bars will turn red and will inform you about the events that triggered the alert (green 
when a bell is rung). The Alarm bar ①  is located at the bottom of the MxManagementCenter 
and the Alarm Info bar ②  below the camera image of the corresponding camera.
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Alarm Noti-
fication

In addition, you can choose to receive an alarm message and an alarm sound.
 This requires the alarm notification option to be enabled in the Camera Configuration dia-
log and the Alarms checkbox to be set in the Notifications section (Mac: 
MxManagementCenter > Settings menu, Windows: File > Settings ) menu.

Camera icon 
and group 
icon in the 
Graphic 

When a camera detects an alarm, the corresponding camera icon turns red ②  or green (bell 
event). You can take a quick glance at the situation observed by the camera by showing a 
small live image (move mouse pointer over the icon) or by showing a live image on a second 
monitor, if available (double-click on the camera icon). 
If you positioned an additional camera group on the background image (floor plan), the cam-
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view era group turns red ②  or green when a camera in this camera group registers an alarm-trig-
gering event.

Setting Up Alarm Notification
The following table describes where and how the notification options can be set.

Notifications Settings

Alarm bar, 
Alarm Info bar

For an alarm to be signaled in the Alarm bar and the Alarm Info bar, you must activate alarm 
notification for each camera and select the events that will trigger an alarm. 
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 1. To do so, open the Camera Configuration dialog box by right-clicking on the cor-
responding camera in the Camera bar.
 Another option is to open the dialog box in the Device bar by clicking on  and then 

right-clicking on the corresponding camera.
 2. Click on Alarms, enable alarm notification and set the events that should trigger an 

alarm.

Alarm Noti-
fication

In addition to signaling in the Alarm bar and Alarm Info bar, you can set up a visual and aud-
ible alert. Do so by navigating to the notifications (Mac: MxManagementCenter > Settings 
menu, Windows: File > Settings menu), selecting the Alarms option and then selecting the 
alarm sound, alarm duration and volume. 

Camera icon 
and group 
icon in the 
Graphic view

In order for the camera icon and group icon to turn red or green in the Graphics view when 
an alarm event occurs, the same settings must be made as for notification in the Alarm bar 
and Alarm Info bar.
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Setting time 
ranges for 
alarms

In addition, you can select a weekly profile for every event type that should trigger an alarm.

 1. To do so, open the Camera Configuration dialog box by right-clicking on the cor-
responding camera in the Camera bar.
 Another option is to open the dialog box in the Device bar by clicking on  and then 

right-clicking on the corresponding camera.
 2. Make sure that the Alarms option has been activated.
 3. As long as no other weekly profile has been selected, the setting is valid from Monday 

00:00 to Sunday 24:00.
 4. Click on Edit weekly profiles to create a weekly profile for an event type. See also Set-

ting Alarm Filters for information on how to create and select a weekly profile.                         

Filtering Alarm Images
All Alarm images are displayed in the Alarm bar and in the Research view. To get a quick overview, you can 
filter the display of images according to different criteria.
Filtering Alarm Images In The Alarm Bar ("Filtering The Display Of Alarm Images" section):
 The alarm images in the Alarm bar are sorted chronologically. You can filter the display of alarm images by 
camera, group, event type, and confirmation status. 
Filtering the Research view by event types:
 All event images of the selected cameras are shown in chronological order. You can filter the view according 
to event types.                 

Playing Back Alarm Recordings
You can play the recording of an alarm directly in the Alarm bar ("Playing Back Recordings" section) or dir-
ectly in the Research view.         
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Researching in MxMC
This section describes basic research functions of MxMC

Searching And Playing Back In Playback View
Recorded clips cannot only be played in the player, but they can also be searched. The way that you search 
depends on whether you want to search for specific events within the recorded clips or whether you want to 
search for events at specific times.

General Playback View controls

Fig. 74: General playback view controls

To search and play back recordings, first activate Playback mode  or select the date and time and then 
use the Previous/Next Image buttons , to browse the recordings; alternatively, you can start the play-
back using the Forward/Backward Playback buttons . Hold the Forward/Backward Playback to 
select a playback speed between 0.5 times and maximum.
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General operation of the Playback View for MOBOTIX MOVE and ONVIF 
cameras

Fig. 75: General operation of the Playback View for MOBOTIX MOVE and ONVIF cameras

Note
all playback capabilities are supported by MOBOTIX MOVE cameras and third-party cameras that provide an 
ONVIF-S-compatible interface. For these cameras, recordings can only be played forward.
    Therefore, first select Date/Time ① , and then start playback using Forward Playback  ② .

Performing PTZ actions in recordings
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Fig. 76: Performing PTZ actions in recordings

Note
On a secondary monitor, a single camera image can only be zoomed with the mouse wheel or panned with 
the mouse button pressed down. PTZ controls are only available on the MxMC main screen or on the sec-
ondary monitor in Grid View.

You can zoom and move the visible image area not only in live images but also in recorded images (PTZ). 
This enables you to examine specific image areas more closely while the recorded video stream is playing 
back. On Dual cameras, the program also shows the  slider. Use this slider to show the images of either 
the right, the left or both image sensors. When playing back the recordings of hemispheric cameras, you can 
set different display modes .

Zooming and moving image sections
You can zoom using the slider  or the mouse wheel. To see other image areas, you can move the recorded 
image using the mouse.

Choosing a sensor 
On Dual cameras, you can opt to see the recordings of the right, the left or both image sensors. To do so, 
move the  slider to the right to  (left sensor) or further to the right to  (right sensor).

Subsequent distortion correction of hemispherical images
When showing recorded images of hemispheric cameras or cameras with the lenses L12/B016, L23/B036, 
L25/B041, you can select different display modes. In order to get naturally-looking images, the camera will 
automatically correct the distortion in these modes. This distortion correction can be refined even further 
when using the panorama correction. Note that this type of correction only takes place locally. This means 
that the distortion correction of the recorded images only takes place on this computer. The stored record-
ings (from the camera or a file server) are not influenced in any way.

 n Full image: Shows the entire (distorted) full image.

 n Normal: Shows a distortion-corrected image and allows executing PTZ actions.

 n Panorama: This option shows the distortion-corrected image of an entire room (corrected 180° pan-

orama view) from the left to the right wall. The aspect ratio (width to height) is 8:3. 

 n Surround: This option shows four image sections (one for each cardinal direction: N, E, S, W) in one 

joint view. Note that you can use PTZ actions to modify all four views independently from one 
another.

 n Double panorama: This mode shows a panorama view for the North half of the image and a second 

panorama view of the South half of the image using an aspect ratio (width to height) of 4:3. This mode 
only makes sense for a hemispheric camera that is mounted to the ceiling.

 n Panorama focus: This display mode combines the panorama view (aspect ratio 8:3) with two smal-

ler images (each with aspect ratio 4:3) in one large image.
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Selecting The Distortion Correction Mode

Move the slider  to the right until you see the desired view. This slider position will be stored auto-
matically until you change it again.

Panorama Correction
The distortion-corrected images of the different display modes can be further refined using the panorama cor-
rection. Move the  slider to the right to  and use the mouse to correct the image. To store the corrected 
setting, click on the  slider and hold it until the slider icon briefly appears in the center of the image.

Browsing recordings for event images
When searching for event images, first select the image playback type:

 n Event images: Only shows event images.

 n Pre-event images: Shows only the first recorded image for each event.

 n Highlighted images: Shows only the images, which had been marked as important before.

Note
This feature is not supported by MOBOTIX MOVE cameras and third-party cameras that provide an ONVIF-S-
compatible interface. For an overview of how the camera functions differ, see Camera Feature Overview.

Fig. 77: Browsing recordings for event images

 1. In the Playback view, select the Playback mode by right-clicking on  ①and selecting the desired mode 

② .
 2. Browse the recordings using the  and  buttons. Starting with the current event image, these buttons 

show the previous or next event image.
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Browsing recordings for a specific date and time
If you have set up a continuous recording for certain times and you want to check for events during those 
times, for example, you can limit the search to these times. You can search for events at a given time by 
using time leaps or time-lapse playback.

Searching for a specific date and time

Fig. 78: Searching for a specific date and time

 1. Click on Date/Time ①  and enter the date and time to search for.
 2. The event image jumps to the event in the recordings that is closest to the specified date and time.
 3. Click on Playback .

     or     

 1. Click on the Calendar slider ② . The date and time will be shown above the slider. 
 2. Move the slider until you reach the date and time that is closest to the point in time you want to exam-

ine. The event image jumps to the event in the recordings with the specified date and time. If such a 
recording is not available, the event image jumps to the event that is closest to the specified point in 
time (in the direction of searching). In the latter case, the slider turns read the time difference to the spe-
cified point in time is shown above the slider.

 3. Click on Playback .

Note
The farther away you move the mouse pointer from the slider, the more precise your setting will be.
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Searching Several Cameras For Persons Or Objects
Scenario: Camera A is overlooking the gate and signals an event. The event image in the Alarm bar shows a 
delivery truck driving through the gate. You want to know if the truck has also passed the area monitored by 
camera B.

 1. To do so, move the mouse pointer over the event image. Three icons are shown. 
 2. Open the Playback view mode by clicking on .

 3. Play back the recording (end of recording) ① .

Fig. 79: Playback the recording

 4. Drag&drop camera B from the camera bar into the Playback view.
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 5. The playback automatically selects the recording that follows the end of camera A's recording ② . You 
can continue this process for any number of cameras.

Investigating Multiple Cameras For A Specific Point In Time
You want to know if other cameras have recorded something at a specific point in time:

 1. Set the reference time using the Pin button ① .
 2. Drag the cameras from the Camera bar ②  one by one.
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 3. The application shows the event images of each camera that are closest to the specified point in time.

Limiting The Search Range For An Incident
Scenario: Your camera monitors a parking lot from which a car had been stolen during the day. Follow these 
steps to locate the event as quickly as possible:

 1. Start the Playback mode (right-click on ) and select an interval (e.g., 1 day ).

 2. Keep clicking on Previous Image  until the car can be seen again in the image.

 3. Now select a shorter interval (e.g., 1 hour ).

 4. Keep clicking on Next Image  until the car has left the frame.

 5. Keep on using shorter intervals until you have found the exact point in time of the incident.

Note
You can also use the Forward/Backward Playback  /  buttons to play back using the same time 

leaps.
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Note
This feature is not supported by MOBOTIX MOVE cameras and third-party cameras that provide an ONVIF-
compatible interface. For an overview of how the camera functions differ, see Camera Feature Overview.

Playing Back Recordings

Playing Clips

To play the clips, the play buttons  and the       playback mode are available in the Command bar of 
the Playback view. First set the desired mode for playing the recordings, such as event images only or with 
one hour time-lapse, in the Playback mode. 
    Next, use the Playback Buttons to browse and play back the images one-by-one  or continuously 

 in backward or forward direction.
Note: As mentioned in General Operation Of The Playback View For MOBOTIX MOVE And ONVIF Cameras, 
playback of recordings is limited when using MOBOTIX MOVE cameras and third-party cameras that provide 
an ONVIF S-compatible interface. Recordings of these cameras can only be played forward. For an overview 
of how the camera functions differ, see Camera Feature Overview.
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The following table summarizes the actions that you can perform with the playback buttons, depending on 
the playback mode:

Playback Mode Playback Buttons

Complete Record-
ings 

Jumps one image backward/forward.

Plays back all recordings backward/forward.

Event Recording Jumps to the end/the start of the recorded sequence.

Plays back until the start/the end of the recorded sequence has been 
reached.

Event Images Shows the previous/next image every time you click on the button.

Pre-alarm Images 

Highlighted Images The previous/next images are shown automatically one after the 
other. 

1 day time lapse 

1 hour time lapse 

10 minute time 
lapse

1-minute time 
lapses
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Setting The Playback Speed

The Playback Speed option  allows you to speed up or slow down the playback of a recording. This also 
applies if you play back a recording backward. 

 1. Click on Playback Speed. The background of the button turns dark gray.
 2. To play the recording forward, left-click and hold the left mouse button and move the mouse pointer to 

the right. The further you move the mouse pointer down (to the right), the faster the playback speed. 
 3. To play the recording backward, left-click and hold the left mouse button and move the mouse pointer 

to the left. Again, the further you move the mouse pointer down (to the left), the faster the playback 
speed.

Precise Positioning by Image

If you want to examine a scene very closely, you can view the recordings one image at a time. To do so, stop 
playback (click on  or ). Now use the two buttons  (forward) and  (backward) to navigate the 
images one by one.

Searching And Playing Back In The Grid Playback
If a camera registers an event and you want to know if and what other cameras in that camera group were 
recording at that time, you can use Grid Playback to view the recordings of multiple cameras synchronously. 
The camera in the focus window is the lead camera. So, if you are browsing the recordings on this camera to 
find events or specific situations or if you are playing back recordings, the other cameras will follow the lead-
ing camera as soon as playback is paused. The program always shows the event images that are closest to 
the time stamp of the leading camera. If the time of the other cameras differs from the leading camera, the 
difference will be displayed at the lower border of the event images.
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Fig. 80: Grid Playback

 1. Open Grid Playback by right-clicking on the Navigation button and selecting Grid Playback.
 2. Drag the desired camera group from the group bar.

 3. Use the time stamp in the focus window ①  or the calendar slider ②  to set the time.
 4. All cameras jump to the event image that is closest to the specified point in time. The time stamp 

beneath each camera image shows the time and date of the image. The difference to the reference time is 
shown at the right.

Note
You can also use the Grid Playback by dragging a group onto the Playback view. The original camera will be 
shown in the focus window.
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Searching And Playing Back In The Research View
Use the Research view to search all recorded event images at once. You can filter the results by event type, 
that is, by bell events or by motion events to get a quick overview.  Or you can reduce the results to the 
event you have marked as "important" in the Playback view. The search results are displayed as preview 
images including camera name, time stamp and type of event trigger. Note that you can play back the record-
ing to an event directly from the event image. Double-click on the event image to open the Playback view 
and to start playing back the recording.

Note:
The Research view is not available for MOBOTIX MOVE cameras and third-party cameras that provide an 
ONVIF-S-compatible interface. For an overview of how the camera functions differ, see Camera Feature Over-
view, p. 13.

Displaying Camera Event Images

Fig. 81: Displaying camera event images

Open the Camera bar by clicking on the upper gray frame border. Drag and drop the camera image of the 
desired camera into the image area of the view. The event images of this camera are displayed.
 Another option is to: You can also drag and drop the desired camera image from the Device bar.              
Loading Additional Event Images
 Sometimes, the number of recordings of a camera is quite large. In such a case, loading all event images 
would take very long. To avoid this, only the latest events are loaded by default. However, you can manually 
load the remaining images. Click on Load More  to do so. 
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Displaying Camera Group Event Images

Fig. 82: Displaying camera group event images

Open the Group or Camera bar by clicking on the upper gray frame border. Click on the frame border again to 
switch to the camera Group view. Drag&drop the icon image of the desired camera group into the display 
area of the view. The event images of the individual cameras in the camera group are displayed.
Another option is to drag and drop the desired camera group from the Device bar. 

Filtering By Event Types
Initially, the event images of the selected cameras are sorted by time. You can filter the view according to 
event types.

Fig. 83: Filtering by event types
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Open the dialog for the respective event type by right-clicking on the corresponding icon in the Command 
bar. Then select one or more events. The display of events is filtered according to the selection.

Event Types Subcategories Explanation

Image Ana-
lysis
 Events

MxActivitySensor Triggered by continuous movement of people or objects in certain image 
areas.

  Video Motion 
Sensor

Triggered by movements in predefined motion windows.

  Behavioral Detec-
tion

The sensor reacts to different behavior profiles of the tracked objects in 
the image. Triggered by deviations from the recorded behavioral profiles.

Environment 
Events

Shock Detector Triggered by shocks on the camera (e.g., vandalism).

  Illumination Triggered by exceeding or falling below the specified illumination.

  Microphone Triggered by exceeding the set volume of the sounds picked up by the 
microphone.

  PIR Sensor The passive infrared sensor registers objects with a heat signature moving 
within the sensor area. Triggered by exceeding the set threshold. 

  Temperature Triggered by exceeding or falling below certain temperature thresholds.

Internal 
Events

Action Group Ter-
mination

Triggered by the completed execution of an action group.

  Custom Signal 
State

Triggered by state changes of user-defined signals.

  Recording Triggered by state changes of the recording (start, end, etc.).

News
 Events

IP Receive Triggered by receiving a network message via TCP/IP.

  MxMessageSystem Triggered by receiving a message from the MxMessageSystem via the 
MxBus or from the network.

Meta Events Event Counter Triggered by the quantitative evaluation of other events.
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  Logical AND Event Triggered by the simultaneous occurrence of multiple events.

  Event Logic Triggered by the order of occurrence of events.

Signal 
Events

Signal Input The camera's signal inputs can trigger events. For example, you can con-
nect the door bell with the signal input so that an event is triggered when 
the bell is rung. 

  User Click Triggered by clicking on the User Click softbutton.

Time Events Periodic Event Triggered by periodically recurring events.

  Random Event Triggered by a random time with a predefined expected frequency.

  Time Task Event Triggers at fixed points in time.

Door Station
 Events

Ringing event Triggered by activation of the door bell.

  Mailbox Message Triggered by leaving a voice mailbox message.

  Door Station 
Events

Triggered by opening the door.

  RFID Card Rejec-
ted

Triggered by the use of an invalid RFID card.

  PIN denied Triggered by entering a wrong PIN.

Marking Events
When browsing event images, you can right-click on an image to mark the event as "important." The same 
applies to events that you have marked as "important"  in the Playback view or in the Alarm bar: You can 
view them as a collection in the Research view.

Playing Back Events
Instant Playback:
     You can watch the recording of an event directly in the event image (instant playback). To do so, move the 
mouse pointer over the image. Three icons appear. Click on  to start the playback.

Note:
A click into the image after starting the playback opens the recording in full screen mode in the current pro-
gram window.
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Playback View:
    You can also play back the recording in the Playback view. To do so, move the mouse pointer over the event 
image. Click on  to switch to the Playback view.

Searching And Playing Back Door Events
Door Station-specific events and recordings can be searched for and played back with MxMC, just like all 
other events and recordings. However, there are some small differences, which are discussed in more detail 
below.

Note
Door Station functions are not supported by MOBOTIX MOVE cameras and third-party cameras that provide 
ONVIF S-compatible interface. For an overview of how the camera functions differ, see Camera Feature Over-
view.

Watching and Playing Doorbell Recordings

Bell Settings
If there were visitors ringing in your absence, you will see this by checking the counter near the Bell Settings 

 ① in Live view.

Note
The number displayed in the counter depends on the filter settings configured in the Alarm bar. 
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 1. Click on  to see who has rung. Instead of the live image, the event image for the last bell activation is 

displayed, and a red slider with the number "1" is displayed on the right side of the multislider ② . 
 2. If there are several doorbell recordings, click on the red slider and drag it to the left until the next higher 

number is displayed in the slider. At the same time, the event image also changes to the image of the pre-
vious bell activation.

 3. To play the respective  doorbell recording, click on  again. The view switches to the Playback view. 

Click on  . The recording is played back. 

Alarm Bar
A missed bell activation is also indicated by a green Alarm bar. This only happens if the Alarms option has 
been enabled for the corresponding cameras in the Camera Configuration dialog and if the bell event has 
been selected as an alarm triggering event. When the Alarm bar is opened, a green bar below the event image 
indicates a missed bell activation. You can watch the recording of the missed bell activation directly in the 
Alarm bar using the Instant Playback function. 

 1. To do so, move the mouse pointer over the event image. Three icons appear. Click on  . The recording 

is played back directly in the Alarm bar. 
 2. You can also jump from the Alarm bar directly to the recording in the Playback view and play it back 

without having to search for it there. To do this, move the mouse pointer over the event image once 

again and click on .

Viewing and Listening to Voice Mailbox Messages

Voice Mailbox Messages                    
If visitors have left messages in your absence, this is indicated by the counter next to the voice mailbox mes-

sages  ①  in the Live view.
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 1. Click on  to see who left a message. Instead of the live image, the event image for the last message is 

displayed, and a red slider with the number "1" is displayed on the right side of the multislider ② .
 2. If there are several messages, click on the red slider and drag it to the left until the next higher number is 

displayed in the slider. At the same time, the event image also changes to the image of the previous mes-
sage.

 3. To play and listen to the respective message, click on  again. The view switches to the Playback view. 

Click on  . The recording is played back.

Alarm Bar
A voice mailbox message is also signaled to you in the Alarm bar by turning red, and the new event image is 

marked with the  icon. This only happens if the Alarms option has been enabled for the corresponding 
cameras in the Camera Configuration dialog and if the voice mailbox message has been selected as an 
alarm triggering event. To play back the message, move the mouse pointer over the event image. Three icons 
appear. Click on  . The message is played directly in the Alarm bar.

Searching and Playing Back Door Events
Like all events, door-specific events (e.g., attempts to open a door with an invalid PIN) can also be searched 
and played back. Various options are available: Playback View, Grid Playback and Research View.

174 / 375



Exporting Recordings
Using the Playback view, you can export recorded video data from one camera, while the Grid Playback 
allows exporting from several cameras at once. Use the Export bar to combine several clips to one export. 
You can save individual images with the Snapshot function.

Saving Snapshot Images
Snapshot images can be created in the Live and the Playback views for the displayed camera, and in the Grid 
view and Grid Playback for all displayed cameras.

Fig. 84: Saving Snapshot Images

To do so, click on the Snapshot  button in the Command bar. By default, images are saved in the image 
folder of the user account. The destination path and the image settings for saved images can be selected via 
the MxManagementCenter > Settings > Snapshot Images (Mac) or File > Settings > Snapshot Images 
(Windows) menu item.

Exporting Camera Recordings
The Playback view allows setting a time range for a recording (event recording or continuous recording) in 
order to select it for exporting.

 1. Open the Playback view.
 2. Drag the desired camera from the Camera bar or the Device bar.
 3. Find the start of the relevant recording.
 4. Specify the export range. There are two possibilities for this export:
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Select export range using visual markers:

 1. Mark the start of the clip by clicking on the gray flag on the left .

 2. Play the recording until you have reached the end of the clip you want to export. Mark the end of the 
clip by clicking on the gray flag on the right. Both flags are now green.

 3. Click on Export  and select the export profile.

 4. The Export dialog box appears. Select a target folder and enter a file name.

Manually capture export range:
First, make sure that no export area has yet been set using the "export flag." If an export area has already 
been defined, you can delete it. Do so by right-clicking on a flag and selecting Delete Time Range.

 1. Click on Export . Then click on the desired export profile ① . The dialog box used for defining the 

export range appears.
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 2. Specify the export range ② .
 3. Click on OK and then on Save.

Note
If you select the Automatically Import After Export checkbox in the Export dialog, the exported clip will 
be automatically added to the Camera bar and in the Device bar to the Clips & Recordings section.

Exporting Camera Group Recordings
The Grid Playback allows for setting a time range for a recording (event or continuous recording) in order to 
select it for exporting from multiple cameras.

 1. Open the Grid Playback.
 2. Drag & drop the desired camera group from the Group bar or the Device bar.
 3. Find the start of the relevant recording for the camera in the focus window. At the same, the search is 

extended to the other cameras in the group, and the recordings with the closest relevance to those in the 
focus window recording will be displayed in the tiles.

 4. Specify the export range. There are two possibilities for this export:

Select export range using visual markers:

 1. Mark the start of the clip by clicking on the gray flag on the left .

 2. Play the recording until you have reached the end of the clip you want to export. Mark the end of the 
clip by clicking on the gray flag on the right. Both flags are now green.
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 3. Instead of exporting all cameras of this group, you can also select one or more cameras for exporting. To 
do so, right-click on Export . A circle appears on the camera images in the top left corner. Select the 

desired cameras by clicking on the corresponding circles ① .
 4. Then click on Export  and select the export profile ② . The Export dialog box appears.

Fig. 85: Select export range using visual markers

 5. Select a target folder and enter a file name.

Manually capture export range:
Make sure that no export area has yet been set using the "export flag." If an export area has already been set, 
you can delete it. Do so by right-clicking on a flag and selecting Delete Time Range.

 1. Before you define the export range, you can limit the selection if you do not want to export all of the 

recordings that appear in the tiles. To do so, right-click on Export . A circle appears on the tiles in the 

top left corner. Select the desired cameras by clicking on the corresponding circles ① .

 2. Click on Export  and select the export profile ② . The dialog box used for defining the export range 

appears.
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Fig. 86: Manually capture export range

 3. Specify the export range ③ .
 4. Click on OK and then on Save.

Note: Automatic Import
    If you activate the Automatically Import After Export option, the exported clips are automatically added 
to the Group bar.

Exporting Recordings From The Export Bar
The Export bar provides a quick and easy way to take camera recordings and MXG clips by dragging and drop-
ping and create a list of recordings for subsequent exporting. From the bar, you can export recording time 
ranges as combined clips. You can add the clips in the Playback view, in Grid Playback, in the Research view 
and in the Retail view. After an export, the clips are not deleted automatically. It is deleted when the pro-
gram is closed.

Adding Clips for Exporting in the Playback View

 1. Drag the desired camera or the desired clip from the camera bar or from the Device bar.
 2. Find the recording you are interested in.
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Fig. 87: Adding Clips for Exporting in the Playback View

 3. Mark the start of the time range by clicking on the gray flag on the left . Play the recording until you 

have reached the end of the clip you want to export. Mark the end of the time range by clicking on the 

gray flag on the right . Both flags are now green ① .

     You can set the end marker first (gray flag on the right), then play the recording from the beginning so 
you can set the start marker (gray flag on the left) at the desired point.

 4. Click on the image of the recording and maintain the position until you see a scaled-down image of the 
recording ② .

 5. Drag this image to the Alarm bar (regardless of whether or not it is open). The Export bar will open auto-
matically, allowing you to save the image there.

Adding Clips for Exporting in Grid Playback
The Export bar in Grid Playback is useful for combining sequential time ranges of different cameras.

 1. Drag the desired camera to the focus window in the grid and find the relevant recording.

 2. Mark the start of the time range by clicking on the gray flag on the left . Play the recording until you 

have reached the end of the clip you want to export. Mark the end of the time range by clicking on the 

gray flag on the right . Both flags are now green.

 3. Click on the image of the recording in the focus window and maintain the position until you see a 
scaled-down image. Drag this image to the Alarm bar (regardless of whether or not it is open). The Export 
bar will open automatically, allowing you to save the image there.
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 4. After you have set the end marker of the time range, the recordings of all other cameras will reposition to 
show the same time. Drag the camera with the next recording in the sequence of events into the focus 
window. Mark the start and the end of the clip as described above, then drag the recording into the 
Export bar.

 5. Repeat these steps until you have added all recordings you want to export.

You can also add time ranges from several cameras in the Export bar.

 1. Simply drag the desired camera group from the Group bar or from the Device bar and search for the rel-
evant recording.

 2. Mark the start and the end of the clip as described above. The recordings of the other cameras will repos-
ition accordingly.

 3. Right-click on Export . A selection box with a checkmark appears in the top left corner of the record-

ings. If you do not want to add the recording range of a specific camera to the list, uncheck the selection 
box for that camera.

 4. Click on the image of the recording in the focus window and maintain the position until you see a 
scaled-down image. Drag this image to the Alarm bar (regardless of whether or not it is open). The Export 
bar will open automatically, allowing you to save the image there. The selected clips will be copied to 
the Export bar.

 5. Repeat these steps until you have added all time ranges you want to export.

Adding Clips for Exporting in the Research View
In the Research view, you can add recorded event sequences to the list. The length of the event sequences is 
currently 10 seconds. 

 1. Set filters by camera, by group or by event type as needed.
 2. Right-click on Export . A selection box appears on the event images in the top left corner. Select the 

desired events by clicking on the corresponding selection boxes.
 3. Open the Export bar by clicking on the lower frame border of the open Alarm bar. Click on an event 

image and maintain the position until you see a scaled-down event image. Drag this image to the Export 
bar. The clips of all selected event images are added to the Export bar.      (An alternative option is: In the 
Export bar, click on . The clips of all selected event images are added to the Export bar.

 4. If needed, you can set new filters and add more event images to the Export bar.

Adding Clips for Exporting in the Smart Data View
You can add clips for the individual Smart Data transactions to the Export bar. The default clip length is ten 
seconds on either side of the transaction time stamp, that is, for a total of 20 seconds.

 1. Right-click on Export . A selection box appears on the preview images in the top left corner. Select 

the desired transactions by clicking on the corresponding selection boxes.
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 2. Open the Export bar by clicking on the lower frame border of the open Alarm bar. Click on an preview 
image and maintain the position until you see a scaled-down preview image. Drag this image to the 
Export bar. The clips of all selected preview images are added to the Export bar.      An alternative option is: 
In the Export bar, click on . The clips of all selected preview images are added to the Export bar.

You can also add clips for the individual preview images of the selected transaction to the Export bar:

 1. Drag the transaction preview image in the Preview Image section and drop it on the Export bar.

Editing Clips
If you have added a recording to the Export bar for which you previously used distortion correction or zoom 
features during playback, you can choose to export the clip with or without zoom. Likewise, you can export 
the clip with or without audio. To do so, move the mouse pointer over the recording in the Export bar. Three 
icons appear:

 

 n : Clip is exported with zoom.

Click on  to export the clip without zoom. The icon is disabled.

 n : By default, the clips are exported with audio (provided that audio had been recorded).

To export without audio, click on . The icon is disabled.

 n : Note that you can play back the individual clips directly in the Export bar before exporting.

Click on   to do so.

Right-click on a clip to open a context menu with these functions: Manually adjust time range, activ-
ate/deactivate audio and zoom for all clips, duplicate a clip, delete one or all clips.
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Exporting Clips
Click on Export , then select MOBOTIX to export an MXG clip. Select a different profile to create an AVI, 
MP4 or MKV file. However, depending on the data source (e.g. MOBOTIX NAS) not all export profiles are avail-
able.
    Select a destination path in the Export dialog and enter a file name. Activate the Automatically Import 
After Export checkbox in the file selection dialog to automatically add the MXG clips to the Export bar after 
exporting.

Special Search Functions
There are several special functions available for searching records.

Note:
These special features are not supported by MOBOTIX MOVE cameras and third-party cameras that provide 
an ONVIF S-compatible interface. For an overview of how the camera functions differ, see Camera Feature 
Overview.

Searching With Post Video Motion Detection (Post VM)
Post video motion detection (Post VM) is added to MxMC by default as a plug in. Searching With Post Video 
Motion Detection (Post VM), p. 185 allows searching recordings for changes in one or more image areas of a 
camera. To open the function, right-click in the Playback view or in the Grid Playback on the plug in button 

 in the Command bar and then select Post Video Motion Detection

Using The Application
Researching in MxMC

183 / 375



Using The Application
Researching in MxMC

Fig. 88: Post video motion detection

Histogram: Graphical Representation Of The Frequency Distribution Of 
Events
The histogram in the Histogram bar illustrates the distribution of the event frequency and thus provides a 
quick overview of the events of one or more cameras. Open the Histogram bar by clicking on the dark gray 
border on the right margin of the MxMC (see The Histogram: Graphical Representation Of The Frequency Dis-
tribution Of Events, p. 188).

Fig. 89: Histogram bar

184 / 375



Smart Data-System: Transaction data in combination with video sur-
veillance
With the MOBOTIX Smart Data System, transactions in MxMC can be linked to the video recordings made at 
the time of the transactions. It enables you to quickly find and review any suspicious activities. This makes it 
easy to find and review suspicious activity (see Smart Data-System, p. 190).

Note:
In order to use the MOBOTIX Smart Data System, you must purchase a Smart Data License.

Fig. 90: Smart Data System

Searching With Post Video Motion Detection (Post VM)
The post video motion detection allows searching recordings for changes in one or more image areas of a 
camera. This is done with the help of “motion windows.” 

Creating motion windows 

1. Open the context menu of the plug in by right-clicking on . Select Post Video Motion detection. The 

dialog for setting up the post VM settings opens.
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Fig. 91: Creating motion windows 

2. Click on  in the image area on the right-hand side of the settings dialog. A new window with a pre-

defined video motion window opens.
3. You can execute the following commands:

n Modify the size of the video motion window: By moving the sides or the corners of the window.

n Create additional video motion windows: Draw a new window with the mouse.

n Duplicate a video motion window: Click on  .

n Delete a video motion window: Click on  .

n Deactivate a video motion window: Click on  .

To close the editor window, click on  in the top right corner of the window. 

Setting the trigger conditions
The Post VM window provides options for setting different parameters that influence the motion detection 
results.
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Fig. 92: Setting the trigger conditions

n Trigger level: (White bar in diagram)
Controls the trigger threshold of the video motion windows. Move the bar to the bottom to recognize 
a movement if only a few pixels change from one image to the next. Move the bar to the top to recog-
nize a movement only if many pixels change.

n Sensitivity:

This setting controls how large the change of each pixel in a video motion window must be to count
as movement. Together with a low threshold value, this setting can be used to fine-tune video motion
detection. If you move the slider to the right, the detection sensitivity increases, i.e., even smaller
changes will trigger the detection.

n Correct Changes in Illumination:

Activate this option to avoid false alarms, such as when lighting conditions change rapidly (for
example, from sun to a cloudy sky).

n Deadtime:

This sets the amount of time after the last detected post video motion event, during which pixel
changes in a video motion window are ignored.

n Median Value:

Enter a long duration (2.0 sec., for example) to improve the detection of slow movements.
Note: Setting a value that is too high can lead to smears in the preview window.

n Color Filter:

Select a color to limit the motion detection to a specific range or colors. The Post VM event will trig-
ger if this color changes during post video motion detection.
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Searching for changes in Video Motion Windows
Once you have defined the video motion windows and have set the trigger conditions, you can search the 
recordings for changes in the video motion windows. Use the playback buttons in the command bar at the 
bottom.
It is best to use the Backward/Forward playback  buttons when searching continuous recordings. For 
searching in event images, use the Previous/Next image  buttons. If MxMC detects a change within a 
video motion window, the frame of that window turns red and the search stops.

The Histogram: Graphical Representation Of The Frequency Distribution 
Of Events
The histogram illustrates the distribution of event frequency and thus provides a quick overview of the 
events of one or more cameras.

Opening The Histogram Bar
To open the Histogram bar, click on the dark gray ribbon on the right margin of the MxMC. To begin with, 
the histogram always shows the entire range of the events logged by the camera.

Fig. 93: Opening the histogram bar

Working With The Histogram

Structure Of The Histogram
The histogram is split into the overview area on the top and the zoomed area of the selected range below. 

The yellow scroll bar in the overview area shows the range that is displayed in the zoomed area. Click on 
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to set the displayed time range in the zoomed area (for example, six hours or one day). If you have set the 

zoomed area to  "Custom," you can modify the displayed time range by dragging the edges of the scroll 
bar.

If you want to see only events in the zoomed area that have triggered recordings, click on .
The pink area indicates the time range for which recordings exist for the logged events.

Note
The range of logged events may reach farther back than the recordings.

Fig. 94: Histogram bar in details

User interface elements in the histogram

① :  Resolution of zoomed area (high / low),  set zoom range (custom or pre-defined),  
② : Zoomed area
③ : Overview area
④ : Current time marker
⑤ : Event type and camera / camera group
⑥ : Time range with recordings
⑦ : Time range in zoomed area

Displayed Time Range
The timestamps at the top and bottom of the histogram show the first and the last of the available events 
logged by the camera, respectively. You can change this range manually. A small cross at the left of the time 
range indicates that it has been changed manually. Click on the cross to reset the timestamps to their ori-
ginal values. 

Filter Feature
You can filter the display by camera, by group or by event type. There two sliders for this purpose: the 

group/camera slider  and the event type slider . To set the filters, move the sliders until you see the 
desired results. The following filters are available:

 n Camera filter
 all cameras

 cameras from the current group

 current camera
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 n Event filter
 MxActivitySensor event

 video motion events

 PIR events

 microphone events

 signal input events

  temperature events

 illumination events

 bell events

 voice mailbox messages

 Door Station events

 RFID rejected

 PIN rejected

 all event types

Distribution Of Frequency

The length of the bars indicates the frequency of logged events per time unit. Click on  to examine the dis-
tribution of frequency for a specific point in time in more detail. The display switches to a higher resolution. 
For more detailed information on a specific point in time with a high event frequency, click on the related 
spot in the zoomed area or the overview area. 
In the Playback view, a red marker is also displayed to indicate the current position.

Smart Data-System
With the MOBOTIX Smart Data System, transaction data can be linked to the video recordings made at the 
time of the transactions. Smart Data source can be e.g. MOBOTIX P7 Apps (no license required) or general 
Smart Data sources (license required) like POS systems or license plate recognition systems.
The  Smart Data System enables you to quickly find and review any suspicious activities. The Smart Data Bar 
and the The Smart Data View, p. 70 are available for searching and analyzing transactions. The Smart Data 
Bar provides a direct overview of the most recent transactions (from the last 24 hours) and for this reason it 
is convenient to use it for reviews and searches.
Smart Data Sources can be added and configured in the The Components View, p. 70.

Overview of recent transactions in the Smart Data Bar
The Smart Data Bar provides a direct overview of the most recent transactions (from the last 24 hours) and 
for this reason it is convenient to use it for reviews and searches.

Opening the Smart Data Bar
The Smart Data Bar is available in all views. To open the Smart Data Bar, click on the right frame border of 
the application. The Histogram bar will appear. Click on the frame border again to switch to the Smart Data 
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Bar. You can also open it from the menu (View > Smart Data Bar).

Fig. 95: Smart Data view

Using the Smart Data Bar
If a Smart Data Source, e.g. a cashpoint is transmitting new data to the camera, the Smart Data Bar is auto-
matically updated. It enables live surveillance of the cash point and of the retail data of a camera. You can 
group transactions that belong together and display them.

 n Displayed time range: The Smart Data Bar only contains the data from the last 24 hours. You can 
search data that is older than 24 hours in the Smart Data-System, p. 190.

 n Search feature/Filter feature: You can filter the entries for each cash point’s camera by search term. 
The hits are highlighted in yellow. You can jump to the next/previous search result using the two 
arrows on the lower edge.

 n Do not show system transactions: By default, the Smart Data Bar shows all transaction that are 
stored on the corresponding camera. Some of the transactions, e.g. from a cash point, show purchases 
and events that are directly associated with the purchases, such as the “Total sum.”  Other trans-
actions show only administrative events, such as when the cashier logs on.  Click on  to enable/dis-

able display of system transactions.

 n Do not group receipts (for VECTRON cashpoints only): Transactions are grouped by receipt number 
or purchase by default. Individual sales can be grouped if the cash point signals the conclusion of the 
transactions by creating a receipt number. Counter sales can be grouped by counter if the counter is 
settled in the cash point system. Click on  to disable display by groups. The data will be reloaded.

 n Playback transactions: Open the Playback view by double-clicking on a transaction line. The trans-
action will be played back.
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Detailed search and analysis in the Smart Data View
You can search and filter data of one or more Smart Data cameras in the Smart Data View.

Fig. 96: Searching in Smart Data view

Defining Search Queries
You can define and store several search queries. Enter a name for each search. The search query will be auto-
matically saved every time the search criteria are changed. This also happens when individual search para-
meters and terms are changed.

 1. By default there is one search query already. Click on the tab and enter the desired name.
 2. Select the desired Smart Data Source. You can select more than one or even all Smart Data Sources for a 

search query.
 3. Specify the period of time for the search. You can also enter a period of time that allows you to enter any 

start and end time stamp, in addition to a series of preset time windows (including “today”).
 4. You define the search criteria to limit the scope of the search once you have selected the Smart Data 

Sources and defined the period of time for the search. Click on   to do so. A new line will be inserted.

    The individual criteria can be linked using AND or OR. The logical search operators can only be applied 
to all search criteria at the same time. Select  to link the search criteria using AND and  to link them 

using OR.
Note that the search criteria apply only at the level of individual line items, such as a search for a total 
of > 100 and < 150. For the time being, it is not possible to apply the search to all the line items of a 
report, for example, finding a specific item linked to a total amount of > 100.

 5. Click on  to delete a search criterion.

 6. Click on  to define further search queries, in addition to the most recent search query. Enter a name 

and repeat steps 1–5.
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Deleting Search Queries
Click on  to the left of the name for the search query to delete a search query.

Reloading Searches
A new search is performed on the transaction data on the camera with the filter when the search query is 
reloaded. The search results are displayed again. Click on  to reload a search query.

Displaying Search Results
The search results are displayed with preview images in a list with a detailed display of the cash point data 
or in tiles, depending on the selected display format from the Command bar (List view  or Tile view ).

Integrating MOBOTIX storage device
With the MxManagementCenter, you can access a MOBOTIX storage device connected to the USB port with 
recordings in MxFFS format (see Adding Devices and Sources). To do this, MxManagementCenter must be star-
ted with administrator rights. Without administrator rights, the storage medium will not be recognized.
Note: To remove an SD card from a MOBOTIX camera, refer to the camera manual.

MAC
The following procedure assumes that the logged on user is allowed to manage the computer or has the 
required administrator privileges. Otherwise, contact your system administrator.

 1. Connect the MOBOTIX storage device with a USB port to your MAC.
 2. Start the Terminal App (e.g. via the spotlight search with CMD+space key).

Fig. 97: Starting the Terminal App

Using The Application
Researching in MxMC

193 / 375



Using The Application
Researching in MxMC

 3. Enter the following command line: sudo "/Ap-
plications/MxManagementCenter.app/Contents/MacOS/MxManagementCenter". Confirm with 
ENTER.

 4. Enter the password for the current user. Confirm with ENTER.

Terminal

MxManagementCenter starts with the administrator profile and is not yet configured, as with a new 
installation.

 4. Start a new project.

MxMC in administrator profile

 5. Open the editing mode by clicking on  at the bottom of the device bar.
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 6. Click  . The Add and Import menu opens.

Fig. 98: Add / Import menu

 7. Click MxFFS Medium. The USB ports are searched for storage media that contain recordings in MxFFS 
format.

Note:
This process can take several minutes for data carriers with large storage volumes.

Windows
The following procedure assumes that the logged on user is allowed to manage the computer or has the 
required administrator privileges. Otherwise, contact your system administrator.
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 1. Connect the MOBOTIX storage device with a USB port to your MAC.
 2. Right-click the executable file or a shortcut of the MxManagementCenter.

Fig. 99: Windows start menu

 3. If necessary, activate the User Account Control query with Yes.

Fig. 100: Windows User Account control

MxManagementCenter starts with the administrator profile and is not yet configured, as with a new 
installation.
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 4. Start a new project.

MxMC in administrator profile

 5. Open the editing mode by clicking on  at the bottom of the device bar.

Using The Application
Researching in MxMC

197 / 375



Using The Application
Researching in MxMC

 6. Click  . The Add and Import menu opens.

Add / Import menu

 7. Click MxFFS Medium. The USB ports are searched for storage media that contain recordings in MxFFS 
format.

Note
This process can take several minutes for data carriers with large storage volumes.
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Management
This section addresses administrators who manage a system using MxMC.

Topics Explanation

Group Views, p. 
200

Editing the layout of the Grid view, editing the layout of the Graphic view, assigning 
group functions, storing information for a camera group, limiting the frame rate of live 
images

Door Station Set-
tings, p. 207

Bell settings, voice mailbox settings

Network Envir-
onments, p. 213

Create and manage environments, customize network data for each environment

Cameras And 
Camera Groups, 
p. 215

Manage cameras, manage camera groups, integrate and manage third-party cameras

User Man-
agement, p. 227

General user rights, manage user rights

Program Set-
tings, p. 230

General settings, network, software update, notifications, monitoring, audio, data 
volume, caches, snapshot images, live recorders, remote control, joystick PTZ, MxMes-
sageSystem

Checking System 
Security, p. 258

Maintenance functions, security functions

License Man-
agement, p. 366

Activate licenses, manage licenses

Group Views
After the initial installation, adjustments of the group views may be necessary. This section contains inform-
ation about more detailed Grid and Graphic view configurations as well as general group parameters.           
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Editing the Grid View layout
When creating the camera groups, the Grid layout - the grid in which the cameras are   arranged - is created 
based on default values that can be customized. To do so,   click             in the Command bar or in the Device bar. 
The Command bar then displays several controls for   configuring the grid layout.

Fig. 101: Editing the Grid View layout

As a first step, before you change the format of the camera images or the size of the focus   window, decide 
whether the grid layout should automatically adjust when you resize the window,   or whether you want to 
manually define the size of the tiles and their position.         

Using Auto Grid Mode

The auto grid mode  is used by default. In auto grid mode,   MxMC always tries to distribute the available 
space as well as possible according to   the specified aspect ratio of cameras images (4:3, 16:9, 8:3), the size of 
the focus   window and the number of cameras. This causes the grid layout to automatically                adapt to any 
changes. In auto grid mode, the following sliders are available for changing   the grid layout:

 n  = Format of the camera images and the focus window (4:3, 16:9, 8:3) 

 n  = Size of the focus window (1x, 2x, ..., 8x the size of the camera images)

 n  = Maximum number of cameras

Move the sliders to the desired settings. To close the edit mode, click on .

Selecting manual mode

In manual mode , you set the size of the individual tiles   and their position based on the selected format of 
the camera images (4:3, 16:9, 8:3). In   contrast to auto grid mode, the layout is not adjusted automatically in 

manual mode. To   switch from auto grid mode to manual mode, move the slider  to the right until you 

reach the position .   The following sliders are available in manual mode:
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 n  = Format of the camera images and the focus window (4:3, 16:9, 8:3) 

 n  = Maximum number of cameras

 1. Move the sliders to the desired settings.

 2. To move a tile to a different position, move the mouse pointer over the tile. Click   on  and drag the tile 

onto the desired position. For better orientation, a blue frame indicates   the target position.
 3. To set the size of a tile based on the selected format, move the mouse pointer over   the border of the tile 

until a double arrow is shown. Drag the tile to the desired size.
 4. To close the edit mode, click on .

Editing the Graphic View layout

Changing the camera position on the background image
In the Graphic view, you can define background images such as a floor plan or a plan   layout. You can then 
arrange the cameras of the group on these according to their actual   position. When opening the Graphic view 

of a camera group for the first time, all cameras   of the group are shown as an icon  at the right-hand mar-
gin of the background image ① .

To adjust the   position of the cameras, open the edit mode ②  by clicking on . Move the mouse pointer 
over the camera image.   Two icons are shown ③ . Click on  and drag the camera icon to the desired loc-
ation.   To close the edit mode, click on .   When you exit the edit mode, the changed settings are saved auto-
matically.

Fig. 102: Changing the camera position on the background image

Editing camera icons
You can change the icon size and rotate the icons to reflect the viewing direction and the angle   of view of 
the cameras.
Open the edit mode ①  by clicking on . Move the mouse pointer over the camera image. A   dotted line in 
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the shape of a square is shown around the camera icon. To make the camera icon   larger or smaller, click on 
the right or bottom left corner of the square and pull it inwards or   outwards ② . To change the orientation of 
the camera icon, hover the mouse pointer over   the icon until a hand is displayed. Hold down the mouse but-
ton and turn the camera icon around its   own axis until you are satisfied with the orientation. To close the 
edit mode, click on . When you exit the edit mode, the changed settings   are saved automatically.

Fig. 103: Editing camera icons

Dragging additional camera group onto the background image
You can position additional camera groups on the background image (floor plan) of a camera group.   If a cam-
era of an added camera group detects an event and the Background Alarm has been   enabled for this camera, 
the camera group icon turns red or green (bell event). Click on the group   icon to open the Grid view of the 
camera group.
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Fig. 104: Dragging additional camera group onto the background image

Open the edit mode            and drag the desired camera group(s) from the Group or Camera bar onto the floor 
plan. To close the edit mode,   click on . When you exit the edit mode,   the changed settings are saved auto-
matically.

Positioning controls on the background image
The Command bar at the bottom of the Graphic view contains several controls. If a camera has been set   up 
to control a light, for example, you can switch the lights of this camera in the Graphic view. You   can drag 
these controls onto the background image (floor plan) and simply click on them to execute the cor-
responding function for easier operation later on. 
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Fig. 105: Positioning controls on the background image

Open the edit mode . To open   the shortcut menu, right-click on the desired operating function. Then drag 
the control to the floor   plan with the mouse pointer. To close the edit mode, click on . When you exit the 
edit mode, the changed settings are saved   automatically.

Assigning group functions

Note
Group functions are not supported by MOBOTIX MOVE cameras and third-party cameras   that provide an 
ONVIF S-compatible interface. For an overview of how the camera functions differ,   see Camera Feature Over-
view, p. 13.

In the Grid, Graphic and Info view, you can use group functions to turn on a light, open a door, or make an 
announcement for one camera in the currently selected group.
 In addition, the Switch Light and Open Door group functions can be assigned to multiple cameras, so you 
can switch multiple lights or open multiple doors at once with a single click.

Fig. 106: Assigning group functions

Proceed as follows to assign group functions:

 1. Open the edit mode in the Device bar by clicking on  at the bottom of the bar.

 2. To do so, move the mouse pointer over the group name. Three icons appear. Click on  . The Group 

Functions dialog opens.
 3. Assign the desired functions to the cameras by activating the respective checkboxes. 
 4. Once you have defined all group functions, you can deactivate the edit mode by clicking on .

Adding Information For A Camera Group
You can assign an information page to a camera group in order to show special instructions for this   camera 
group, for example.
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 1. Open the edit mode in the Device bar by clicking on  at the bottom of the bar. Next,   click on  and   
then on . The Group Configuration dialog   opens.

 2. Move the slider  to the right until you reach the  position.

 3. Click on the arrow in the gray field and select the file you want to use.

Limiting the frame rate of live images
If a very large number of cameras is displayed in the Grid view, the performance may decline. To avoid this, 
you can limit the frame rate of the live images within the tiles. Note that this limit does not apply to the cam-
era displayed in the focus window.

Fig. 107: Limiting the frame rate of live images

 1. Open the Group or Camera bar by clicking on the upper gray frame border. Click on the frame border 
again to switch to the camera Group view. 

 2. Right-click on the group icon and select the maximum number of frames per second and the maximum 
image size.

 3. Use ONVIF LoRes Profile: Use this checkbox to limit the frame rate for MOBOTIX MOVE cameras and for 
third-party cameras that provide an ONVIF S-compatible interface. If the checkbox is enabled, the set-
tings for the live images in the tiles captured in the Bandwidth Settings as the LoRes profile for these 
cameras will be used.
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Door Station Settings
There are several ways that MxMC can respond to ringing and mailbox notifications. Here you will find 
information on how to set these notification options.

Note
Door Station functions are not supported by MOBOTIX MOVE cameras and third-party cameras that provide 
an ONVIF S-compatible interface. For an overview of how the camera functions differ (see Camera Feature 
Overview, p. 13.

See also:

 n Operate Door Stations, p. 143

 n Door Station Wizard, p. 272

Bell Settings

Setting the ring tone

Fig. 108: Setting the ring tone

 1. Open Settings in the MxManagementCenter > Settings (Mac) or File > Settings (Windows) menu and 
click on Notifications.

 2. Select the desired ring tone and adjust the volume.
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Setting bell signaling
When a bell is rung, this can be indicated in different locations in MxManagementCenter. Consult the fol-
lowing table to learn which signaling options can be combined and where they can be configured.

Note
The alarm signaling must be activated in the camera settings, a bell profile must be set up and the correct 
bell profile must be selected in MxMC for bell notification to work.
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Notifications Settings

Alarm bar, Alarm info 
bar, doorbell noti-
fication,
 counter on the bell 
icon
 in the Live view

You need to configure the alarm notification for the doorbell ringing to be indicated 
at these places.

 1. To do so, open the Camera Configuration dialog box by right-clicking on the 
corresponding camera in the Camera bar.
Another option is to open the dialog box in the Device bar by clicking on  

and then right-clicking on the corresponding camera.
 2. Click Alarms and activate the Alarm notification and the doorbell ringing.

Ring tone off
You can switch off the ring tone of the signaling by setting its volume to "0"(See Set-
ting The Ring Tone).

Counter on the bell 
icon only

Deactivate doorbell ringing in the Alarms dialog box and only the counter on the 
bell icon will increase by one each time.              

 1. To do so, open the Camera Configuration dialog box by right-clicking on the 
corresponding camera in the Camera bar.
Another option is to open the dialog box in the Device bar by clicking on  

and then right-clicking on the corresponding camera.
 2. Click Alarms and deactivate doorbell ringing.

Completely off Disable the Bell checkbox in the Bell Settings  to switch off the bell completely 

(See Turning Off The Bell Completely).
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Selecting a bell profile
A bell profile basically controls the reaction if someone is ringing at the door station. The camera provides 
several predefined bell profiles. 

Profile Explanation

No phone ring MxMC and all other remote stations will not react, i.e., you will not notice if someone is 
ringing (neither visually nor by sound).

Ringing You will hear if someone rings the doorbell. The visitor cannot leave a message.

Ring and Mail-
box

You will hear if someone rings the doorbell. If no configured remote station reacts within a 
given period of time, the Door Station plays back a previously recorded announcement and 
the visitor can leave a message.

Voice Mailbox After ringing, the Door Station immediately plays back an announcement and the visitor 
can leave a message.

Announcement 
only

After ringing, the Door Station immediately plays back an announcement. The visitor can-
not leave a message.

Fig. 109: Selecting a bell profile

 1. Switch to the Live view of the Door Station.
 2. In the Live view, right-click on the Bell icon  to open the Bell Settings.

 3. Click on Bell Profile and select the profile you want from the list.
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Resetting the ringing counter

The counter next to the bell icon  in the Live view is incremented each time the doorbell is rung, regard-
less of whether or not you react to the ringing. Resetting the counter will help in recognizing if you have 
missed a ringing, which is why you are encouraged to regularly reset the counter. Once you have reset the 
counter, you will be informed how long ago the last reset took place.

 1. Switch to the Live view of the Door Station.
 2. In the Live view, right-click on the Bell icon  to open the Bell Settings.

 3. Click on Reset Counter.
 4. The counter has been reset and is no longer shown next to the Bell Settings  button.

Turn bell off completely
If you do not want to be disturbed by the doorbell, you can deactivate a specific bell or contact number. 
This means that ringing is neither signaled at any of the remote stations, nor is the "ringing counter" 
increased. In this case, you will not be informed about missed visitors and visitors will not be able to leave 
any messages.

Fig. 110: Turn bell off completely

 1. In the Live view, right-click on the Bell icon  to open the Bell Settings.

 2. Disable the Bell checkbox.
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Mailbox settings

Selecting a voice mailbox
Depending on the installed options and the configuration of the Door Station, you may have several bell but-
tons or – in case a MOBOTIX Keypad module has been installed – several contact numbers. Each of these 
bells or contact numbers has its own mailbox. The corresponding mailboxes are presented in the list (below 
the name of the bell).

Note
All settings made in the Mailbox function always apply to the selected mailbox. This also means that the 
new messages counter only applies to this mailbox. To get the messages and recordings of a different mail-
box, select that mailbox first. 

Fig. 111: Selecting a voice mailbox

 1. In the Live view, right-click on the Voice Mailbox icon  to open the Mailbox Settings.

 2. Click on Voice Mailbox to select the desired mailbox from the list.

You can select a bell profile for each voice mailbox. For instructions on how to do this, see Selecting A Bell 
Profile.

Activating The Voice Mailbox And Selecting A Welcome Message

 1. Enable the Active checkbox.
 2. Click on the Announcement button. Select the announcement to be played to the visitor.
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Enabling the Message
If visitors should be allowed to leave a message, activate the Leave Message option.

Network Environments
Using MxManagementCenter, you can access cameras from different locations. For example, you can monitor 
the cameras at home over the local area network (LAN) or while on the move via a pre-configured DynDNS 
access over the Internet. These two methods require the use of different network access data. To avoid hav-
ing to change the network access data every time, you can set up different network environments for the cor-
responding network access data in MxManagementCenter. Switching to a different environment causes the 
network address data for connecting to the cameras to be switched automatically (see Working In Different 
Network Environments, p. 150).

Creating and Managing Environments

Creating environments

 1. Click on  in the Header bar. The Projects and Network Environments dialog opens.

 2. Click on Environment and then on . This adds an environment with the name "New Environment". 

Assign a suitable name.

Fig. 112: Creating environments
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Changing names and deleting environments

 1. Open the Network Environments dialog box.

 2. Editing names: Click on  . Highlight the name and overwrite it. 

 3. Deleting environments: Click on  next to the environment you want to delete. Click on the red Delete 

box to the right of the environment.

Configuring network data for each environment

 1. To set network data, open the Camera Configuration dialog. To do this, either right-click on the indi-
vidual cameras in the Camera bar or open the Edit mode in the Device bar and right-click on the indi-
vidual cameras. The Camera Configuration dialog opens.

 2. Environment: Shows the current network environment. After starting the program for the first time, it 
shows the standard environment. All existing network environments are shown in the blue bar. Click on 
the environment you want to use. Next, perform the required network settings for this environment.
 n Background alarm calls: Specify whether a permanent event stream connection to the camera should 

be established in the selected environment or not. You can deactivate this option if a permanent 
event stream connection is not required or even unwanted (when using MxMC in low-bandwidth net-
works, for example). If this option has been deactivated, the application will only open an event 
stream connection if necessary, such as for showing the live stream of the camera or recordings via 
the camera. In this case, alarms will only show for this camera, while the connection has been estab-
lished.

 n Remote: Only activate this option if you want to access the camera from a remote location (e.g., via 
DynDNS).

 n SSL: If you rather want to use an encrypted connection for the selected environment, activate this 
option (recommended setting). Note that HTTPS needs to be activated on the camera (in the browser 
in Admin Menu > Network Configuration > Web Server > HTTPS Settings).

 n Bandwidth: Select the bandwidth to use for this environment:
HiRes: The images are transferred using the settings made in the camera. 
LoRes: Images are delivered at the frame rate, resolution and image quality as defined in the Program 
Settings, p. 230 for LoRes.

Camera configuration
This section describes basic options to configure cameras.
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Cameras And Camera Groups
Here you will find information on the administration of cameras and camera groups. This includes topics 
such as changing the network data of a camera or exchanging cameras between camera groups.

Note
Administrator rights are required to perform these administrative functions.

Managing cameras

Editing camera data
To change a camera's access data and network data, open the Camera Configuration, p. 219 dialog.

Fig. 113: Editing camera data

 1. To do this, either right-click on the desired camera in the Camera bar ①  or open the edit mode in the 
Device bar and right-click on the corresponding camera ② . The Camera Configuration dialog opens.

 2. Edit the data as desired.

Editing Camera Data Of Multiple Cameras
In the Multi-Camera Configuration dialog, you can change the authentication data used by MxMC as well as 
the environment settings of multiple cameras in one step.

 1. To do this, open the edit mode in the Device bar by clicking on .

 2. Select the cameras as needed.
 Mac: CMD + click, Windows: CTRL + click

 3. Right-click on one of the selected cameras. The Multi-Camera Configuration, p. 226 dialog opens.
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Activating / Deactivating camera background alarms

Note
Background alarms are not supported by MOBOTIX MOVE cameras and third-party cameras that provide an 
ONVIF-S-compatible interface. For an overview of how the camera functions differ (see Camera Feature Over-
view, p. 13).

An activated option means that the application maintains an active event stream connection to the camera, 
regardless of whether or not MxMC is showing the live stream. Using the event stream connection, the cam-
eras will send event information to MxMC , which will show them as alarms depending on the settings (see 
Adding Cameras, p. 83). You can deactivate this option if a permanent event stream connection is not 
required or even unwanted (due to high system loads on systems with very many cameras or when using 
MxMC in low-bandwidth networks, for example).
If this option has been deactivated, the application will only open an event stream connection if necessary, 
such as when MxMC shows the live stream of the camera or recordings via the camera. In this case, alarms 
will only show for this camera, while the connection has been established. This option is deactivated by fact-
ory default.

 1. To open the Camera Configuration dialog, either right-click on the corresponding camera in the Camera 
bar ①  or open the edit mode in the Device bar and right-click on the corresponding camera ② . The 
Camera Configuration dialog opens. 

 2. De-/activate the Background Alarms function.
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Deleting cameras

Fig. 114: Deleting cameras

 1. Open the Camera Configuration dialog by right-clicking on the corresponding camera in the Camera bar 
①  or open the edit mode in the Device bar and right-click on the corresponding camera ② . The Camera 
Configuration dialog opens.

 2. Click on Remove.

Managing Camera Groups

Moving cameras between Camera Groups
The Device bar lets you quickly drag and drop cameras from one group to another.

 1. In the Device bar, open the edit mode by clicking on  and then drag and drop the cameras as desired.

 2. Close the Edit mode by clicking .
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Removing cameras from a Camera Group

Fig. 115: Removing cameras from a Camera Group

 1. Open the edit mode in the Device bar by clicking on .

 2. Drag and drop the camera from the appropriate group to .

 3. Once you have deleted the cameras from the groups, you can deactivate the edit mode by clicking on 

.

Deleting Camera Groups
Deleting a camera group will not delete the cameras that are assigned to the group.
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Fig. 116: Deleting Camera Groups

 1. Activate the Edit mode by clicking .

 2. Drag a group from the corresponding section to .

 3. Next, activate the edit mode by clicking on .

Camera Configuration

Fig. 117: Camera Configuration

Management
Camera configuration

219 / 375



Management
Camera configuration

After you have added the cameras, you should enter the remaining camera data. Even when the system is up 
an running, you may have to make some changes. Open the Camera Configuration dialog to enter and edit 
the camera data.

Entering and Editing Camera Access Data
Name: The camera name is displayed automatically. If required, you can enter an individual name for each 
camera.
Connection Protocol: In order for MxMC to be able to establish a connection to the camera, a suitable con-
nection protocol must be selected depending on the available interface of the camera manufacturer. If you 
have integrated the camera with the Welcome wizard, the corresponding protocol is used automatically. 
When manually adding the camera, select the appropriate protocol. The following protocols are available:

 n MOBOTIX: Select this protocol to establish a connection to a MOBOTIX IoT camera.

 n MOBOTIX with Pelco-D: The requirements to use Pelco-D protocol are:
 n MOBOTIX IoT Camera with MxBus orMxBus Module RS232

 n A PT Head with Pelco-D support 

 n The serial interface must be activated and configured in the camera software (for the parameter 
settings see the cameras reference manual the documentation of the pan and tilt head)

 n MOBOTIX MOVE: Select this protocol to establish a connection to a MOBOTIX MOVE camera.

 n ONVIF: Select this protocol to connect to an ONVIF compatible camera.

 n Axis PTZ: Select this protocol to connect to a camera with Axis PTZ control.

URL: The IP address is either discovered automatically via Bonjour or it has been entered manually.
Remote URL: You can enter the corresponding external address of the camera (such as a DynDNS name) 
when adding it to access the camera from outside the local network.  Please note: Before you can access the 
camera from outside of the local network, you need to activate the Remote option.
User name, password: Access data that had been entered when adding the camera. 

Entering and Editing Network Data

 1. Environment: Shows the current network environment. After starting the program for the first time, it 
shows the standard environment. All existing network environments are shown in the blue bar. Click on 
the environment you want to use. Next, enter the network settings you want to use for this environment.
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 2. Background alarm calls: An activated option means that the application maintains an active event 
stream connection to the camera, regardless of whether or not MxMC is showing the live stream.
      Using the event stream connection, the cameras will send event information to MxMC, which will show 
them as alarms depending on the settings (see Adding Cameras, p. 83). You can deactivate this option if a 
permanent event stream connection is not required or even unwanted (due to high system loads on sys-
tems with very many cameras or when using MxMC in low-bandwidth networks, for example).   
      If this option has been deactivated, the application will only open an event stream connection if neces-
sary, such as when MxMC shows the live stream of the camera or recordings via the camera. In this case, 
alarms will only show for this camera, while the connection has been established. This option is deac-
tivated by factory default.       

Note
This option is not supported by MOBOTIX MOVE cameras and third-party cameras that provide an 
ONVIF-S-compatible interface. For an overview of how the camera functions differ, see Camera Feature 
Overview.

 3. Remote: When adding the camera in the local network, you do not change this setting. Only activate this 
option if you want to access the camera from a remote location (via DynDNS). 

 4. SSL: By default, the connection between MxMC and the camera is not encrypted. If you rather want to 
use an encrypted connection, activate this option. Note that HTTPS needs to be activated on the camera 
(in the browser in Admin Menu > Network Configuration > Web Server > HTTPS Settings).       

Note: This option is not supported by MOBOTIX MOVE cameras and third-party cameras that provide an 
ONVIF S-compatible interface. For an overview of how the camera functions differ, see Camera Feature 
Overview.
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 5. Bandwidth and Bandwidth Settings:       
 n Bandwidth and Bandwidth Settings (MOBOTIX Cameras):

Use the Bandwidth to specify whether you want to get the images from the camera in HiRes or 
LoRes by default. The values (frame rate, image size and image quality) used for HiRes and LoRes 
connections are set in Bandwidth Settings. 
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 n Bandwidth and Connection Data (MOBOTIX MOVE / ONVIF Cameras): 
Use the Bandwidth to specify whether you want to get the images from the MOBOTIX 
MOVE / ONVIF camera in HiRes or LoRes by default. The Connection Data option allows you to set 
the frame rate, image size and image quality for receiving images from the camera using a HiRes or 
LoRes connection.

Click on Connection Data to open the dialog for assigning and changing the HiRes and LoRes pro-
file of the camera. 
By default, adding a MOBOTIX MOVE / ONVIF camera creates two profiles (MxHiQuality for HiRes 
and MxLoQuality for LoRes). To create profiles manually, click on Create MxProfiles. 
To change the settings of a selected profile, select the desired profile parameters in the respective 
selection boxes and transfer the changes by clicking on Transfer Changes.

Note
In contrast to bandwidth settings of MOBOTIX cameras, changes to the media profiles of 
MOBOTIX MOVE / ONVIF cameras are made directly on the cameras. Therefore, these changes 
affect all applications that use these profiles.

Determining recording settings
Saved recordings can be accessed in a variety of ways, depending on the connection protocol.
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With MOBOTIX cameras:

 n Via camera (MOBOTIX cameras): The camera is handling access to the recordings. 

 n Via recording path: The camera is handling access to the recordings via a previously defined record-
ing path. Recording paths can be defined in the program settings (Mac: MxManagementCenter > Set-
tings > Recording Paths; Windows: File > Settings > Recording Paths).

 n Via a local directory: Local path (recordings are accessed on the local computer).

With MOBOTIX MOVE / ONVIF cameras:

 n Via MOBOTIX NAS: Access to recordings via a previously defined MOBOTIX NAS. Access data can be 
defined in the program settings (Mac: MxManagementCenter > Settings > Recording Paths; Win-
dows: File > Settings > Recording Paths).

Click on Recording settings to adjust the settings to your needs. This opens another dialog box.

 1. Choose the desired recording path:
Access via the camera:
    No further settings are necessary.
Access via recording path:     

 n Select the corresponding recording path and set the corresponding recording format: Use 
MxFFS if the recordings have been stored in an MxFFS archive. Use 
MxFileServer if the recordings have been stored in the classic MOBOTIX folder/file structure.

 n MxMC searches for the corresponding recordings in the subdirectories of the predefined file server 
path. Once the search has been completed, you can select the folder for this camera in the Device Dir-
ectory selection box.

Access via local directory:      
 n Select the Local path option and set the corresponding recording format:

 n Enter the file path in the Local path text box. 
Note: Click on the pen icon in the text field to open a file selection dialog.

Access via MOBOTIX NAS:     
 n Select the appropriate MOBOTIX NAS and then select the appropriate device directory based on the 

displayed IP addresses.

 2. Close the dialog box. The settings will be saved automatically when you close the dialog box.

Setting up and changing Alarm Notification

Note
The alarm feature is not supported by MOBOTIX MOVE cameras and third-party cameras that provide an 
ONVIF S-compatible interface. For an overview of how the camera functions differ (see Camera Feature Over-
view, p. 13).
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This section allows selecting the event types that will lead to an alarm if the corresponding event is 
triggered. An alarm will be indicated at the following locations: 

 n Alarm Bar, p. 305 Turns red or green (door bell), the alarm images are shown in the Alarm bar.

 n Alarm Info Bar, p. 342 Turns red or green (door bell) in the live images.

 n  Alarm Settings, p. 329 In addition, you can set up visual and sound notifications for alerting (Mac: 
MxManagementCenter > Settings, Windows: File > Settings).

 1. Click on Alarms to adjust the settings to your needs. The Alarm Events dialog opens.

Fig. 118: Setting up and changing Alarm Notification

 2. Make sure that the Alarms option has been activated.
 3. Select the event types that should create an alarm.
 4. In addition, you can select a weekly profile for every event type that should trigger an alarm. As long as 

no other weekly profile has been selected, the setting is valid from Monday 00:00 to Sunday 24:00.

 n To create new weekly profiles, click on  . The Weekly Profiles dialog opens. Several predefined pro-

files are available, such as the Weekend profile (Saturday 00:00 to Sunday 24:00).

 n To add a profile, click on  . Enter a description. Highlight the desired active times in the table. You 

can resize an active time block by clicking on the time block and then moving the borders accord-
ingly It is also possible to move a block. Click on the block to select it, then drag the block to the new 
position. To delete a time block, click on  .

 n You can change the description of an existing profile. Right-click on the name and overwrite it.

 5. To select a weekly profile, click on the Weekly Profile dropdown list next to the event type and high-
light the desired profile. The calendar icon turns white.
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 6. To easily invert the settings of the weekly profile, simply click on the calendar icon. For example, if you 
have created a profile with opening hours and would like to activate the alarms for the closing times, 

click on the calendar icon  to invert the profile. The icon turns red.

Multi-Camera Configuration
The Multi-Camera Configuration dialog box allows changing authentication data used by MxMC and the 
environment settings of many cameras in one step. When opening the dialog, the application shows the cur-
rent settings of the cameras. The field is labeled with "multiple values" or a minus sign is shown in the  
checkbox if one option has several different settings.

Meaning of the setting options
The meaning of the entries can vary depending on the field type. The following table therefore gives a brief 
overview of the possible entries per field type and their meaning. 

Field type Current status

All cameras have the user name admin.
The cameras have different user names. 

This settings has been activated for all cameras.
This settings has been deactivated for all cameras.
The cameras have different settings. 

"HiRes" has been set as bandwidth setting for all cameras.
The cameras have different values. 

Editing Settings
The fields and settings in the Multi-Camera Configuration dialog are much the same as those in the Cam-
era Configuration dialog. One difference is the way settings are edited. Therefore, only the editing will be 
explained here. For more information about the general meaning of the settings, see the Entering And Editing 
Camera Access Data help topic instead. 
Unlike the Camera Configuration dialog, the Multi-Camera Configuration dialog allows you to reset set-
tings that have not yet been saved. Depending on the field type, you can use different methods.
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Field type Explanation

If you change the text box of a setting, such as User name, a small cross appears 
on the right-hand side.  Click on the cross to reset the entry to its original value.

When closing the dialog, the previous setting will be restored. 

If you select Several Values in a selection box, closing the dialog will restore the 
previous setting.

Notes on the settings
When processing the following fields, these special features must be observed:

 n Recording path:
Local path: The Local Path option can be selected for all cameras. Note that you will need to enter 
the paths individually for each camera in the Camera Configuration dialog (see Recording Path in 
Entering and Editing Network Data).
Recording path: If you select a recording path (see Recording Path in Entering and Editing Network 
Data), MxMC automatically searches the device directory for each camera. The search has been com-
pleted if the progress bar is replaced by OK. If you close the dialog beforehand, you will have to enter 
the device directory for each camera in the Camera Configuration dialog.

 n Alarms:
The Alarms option activates or deactivates the alarm notification for all cameras. Note that you will 
have to set the alarm settings for the event types individually for each camera. Use the Camera Con-
figuration dialog to do this (see Setting up and Changing Alarm Notification).

User Management
The user management in the application header allows for the centralized management of user data and 
access rights (see also: Adding Users, p. 98).

Managing users
Open the User Management in the application header by clicking on .
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Fig. 119: Managing users

Deactivating users
If - for security reasons - you want to prevent a particular user from logging in, you can deactivate that user. 
This prevents the user from logging in, but all settings remain in the system. To do this, select the user and 
deactivate the Active option.

Fig. 120: Deactivating users
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Deleting Users

Click on  and then on  next to the user you want to remove.

Changing access rights
Click on the user whose settings you want to edit. Then configure the user rights by enabling or disabling the 
corresponding rights in the User Rights section.

Fig. 121: Changing access rights

Temporarily assigning supervisor passwords to functions
Certain situations may require users to execute functions for which they usually do not have access rights. 
These functions can be made available temporarily using a supervisor password.

 1. Click on Supervisor  to protect functions with a supervisor password.
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Fig. 122: Temporarily assigning supervisor passwords to functions

 2. In addition, you can specify after how many minutes of inactivity this user will be logged out auto-
matically.

Note
While a recording is being played back in Playback view or in Grid Playback, MxMC does not auto-
matically terminate the supervisor mode after the specified period of time.

 3. Select the functions that can be accessed after entering the password.

Program Settings
For MxMC, you can choose from various options and set preferences. To do so, open Settings in the MxMan-
agementCenter  > Settings (Mac) or File > Settings  (Windows) menu.
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General Settings

Fig. 123: General Settings

Language: Sets the program language. You may have to restart the software in order to apply your change.
Behavior: Deactivate this option to prevent that a double-click triggers the full-screen view on the main mon-
itor or on other monitors.
Display Area: If you are working with the Camera/Group bars or the Alarm/Export bars, you can change the 
width of the bars. Use this option to automatically resize the display area in such a case.
Graphics Mode: If you want to correct hemispheric images, make sure that this option has been activated. A 
prerequisite for using this feature is a graphics card with OpenGL V2.1 support, since it performs the actual 
distortion correction of transferred hemispheric images. Deactivate OpenGL if your graphics card does not 
support this mode or if you experience problems when displaying the camera images.
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Network

Fig. 124: Network

Proxy Server: Select the desired proxy here.
No Proxy, a direct connection will be established.
System Proxy will apply the proxy settings of the system, including the exceptions defined.
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Software Update

Fig. 125: Software Update

MxMC can use the update feature to automatically search for new program versions. To do this, check the 
Check for Updates checkbox and set the polling interval. The update function requires an Internet con-
nection.
The search for new versions can also be performed manually. To do so, click on Search Now. If a new pro-
gram version is available, you will see this here.
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Notifications

Fig. 126: Notifications

Alarms: In addition to the event notifications in the Alarm bar or the Alarm Info bar, you can set up an alarm 
notification and/or alarm sound that signals new alarms. Enable Alarm Notifications to receive an alert. 
Select the desired alarm sound and set its duration and volume.
Bell: When the bell is rung, a ringing notification is displayed. Select the desired ring tone for the notification 
and adjust its volume using this option (see Operate Door Stations, p. 143).
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Monitoring

Fig. 127: Monitoring

Lost Connections: If the connection to a camera is lost (e.g., due to a network failure or changed camera 
access data), the application can show a warning. 
    This is where you configure the warning. Activate the Lost Connection Detection checkbox and specify 
how you want MxMC to react if the connection to a camera is lost (warning sound and window).
Action Log: MxMC can log any action, such as starting playback or export actions, activating the sound, etc. 
This means that you can log all user actions and thus deliver the entire chain of events for legal purposes. 
Activate the Action Log checkbox and specify the interval at which the action log is to be archived and a 
new log created. After enabling this feature, you must restart the application for the activation to take effect.
The action log can be accessed from the menu via Window > Action Log.
Application Error Report: After an unexpected program termination, a service report is usually created. If 
you do not want this, uncheck the Show Dialog checkbox.

Management
Program Settings

235 / 375



Management
Program Settings

Audio

Fig. 128: Audio

Use the slider to set the sensitivity for recording the sound from the camera microphone. The default setting 
has been optimized for Intercom connections and should only be touched in very noisy or very quiet door 
station surroundings.
Hands-Free Talking and Push to Talk
   The Hands-Free Talking option is activated by default. If the surroundings are very noisy or if intercom 
problems persist, you should try to use the Push to Talk option.
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Data Volume

Fig. 129: Data Volume

Maximum Number of Events/Maximum Time Range: The number of events and the time range are con-
trolling how far into the past MxMC will look for event information after the next launch of the application. 
The settings apply to the event counter in Live View and the event preview images in Events View. This 
avoids long loading times and saves storage space when initially loading the event information.
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Caches

Fig. 130: Caches

Recording Path Cache Sizes: To improve playback performance, you can set the internal cache sizes for 
playback here. This applies to both playback via the camera and playback from a file server. Please be aware 
that the cache size set here will reduce the available RAM for other processes, which in turn can influence 
the performance of other applications.
Event Images Harddisk Cache: To load event images faster and reduce network load, you can increase the 
disk cache for event images. If you do not want the system to save event images to disk, clear the Event 
Images Harddisk Cache checkbox.
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Snapshot Images

Fig. 131: Snapshot Images

You can save individual camera images as snapshot files. These settings control the location and the quality 
of the snapshot images stored by MxMC. If you do not specify a folder, the files will be created on the 
desktop. 
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Live Recorder

Fig. 132: Live Recorder

If you observe a suspicious situation that you want to record, you can start a manual recording in Live view 
as well as in Grid view. While you keep track of the situation in the live image, the images are recorded and 
saved as an MXG file. Here you can configure where the clips are stored and how long they are recorded. If 
you do not specify a folder, an MXG file will be created on the desktop.
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Remote Control

Fig. 133: Remote Control

MxMC can be remote-controlled from other programs using HTTP requests. Activate this feature and set a 
proper port if you want to use this feature. Click on one of the example links to see a list of executable com-
mands.
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Joystick PTZ

Fig. 134: Joystick PTZ

You can adapt the joystick behavior to your personal requirements. Start by setting the PTZ type, then set 
the behavior for each axis.
PTZ Type

 n Screen PTZ: The PTZ actions are taking place in the application. This means that only the visible 
image section of the current live image is modified. Any zooming does not influence the recordings of 
the current camera image that may be taking place.

 n Camera PTZ: Zooming actions are executed on the camera and also influence the recordings unless 
you are recording in full-image mode.

 n External PTZ: If you are using the camera of a different manufacturer, you can set its joystick behavior 
in this dialog.

Axes

 n X Axis: Horizontal movement

 n Y Axis: Vertical movement

 n Z Axis: Zooming

Invert
Use this option to invert the joystick actions for that axis.
Sensitivity
If the PTZ actions are reacting too slowly, you can increase the sensitivity. If the reactions are too fast, 
reduce the sensitivity.
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Progression
 Click on the  button to change the progression of the joystick movements. The default setting is linear pro-
gression. 

MxMessageSystem

Fig. 135: MxMessageSystem

This setting is currently required for the MxThinClient. Since the live camera images are switched to the 
MxThinClient via the MxMessageSystem, you must first activate the MxMessageSystem here. Make sure that 
the same parameters are set as in the MxThinClient.
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Customization

Fig. 136: Customization

This setting enables you to adapt MxMC optically to your needs. You user can freely select the primary color 
of the headers and the font displayed there. You also can add an individual logo.
Select header color:Click to select an individual header color
Select font color: Click to select an individual font color.
Select logo: Click to select a graphic file to be displayed as individual logo in the header. Possible file 
formats are .JPG, .PNG, .GIF

Components Settings
In the  Component View, you can manage the following components:

 n File Servers that are used to store video recordings (see File Server Settings, p. 245

 n Smart Data Sources (license required for general sources) from which you can read transaction data, 
e.g. from MOBOTIX P7 Apps (no license required), POS systems or license plate recognition systems 
(see Smart Data Settings, p. 250).

 n MxThinClients,  which allow you to display live images from MOBOTIX cameras on a monitor or TV set 
with HDMI connection (see MxThinClient Settings, p. 254).
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File Server Settings
Stored images can be accessed in two ways: Access via the camera or directly to a file server where the 
recordings are stored. If access is to be direct, you can create recording paths here that can be assigned to 
the cameras. (See Camera Configuration, p. 219).

Adding a File Server

 1. Click the  icon ①  and select a File Server type. 
 2. Configure the file Server in the Settings area ② . 

Configuring File Servers 
Name:
Enter a name for the file server here. Use this name to select the path in the Camera Configuration dialog as 
recording path.
Type:

 n Local: Contains a local folder on this computer or on a connected network drive. You can either enter 
the folder path manually, drag&drop a folder to the text box or select the folder.

 n Network Share: The program directly accesses a shared folder on a file server. In this case, you need 
to enter the computer, the folder and the access data. 

 n MOBOTIX NAS: Data is accessed directly on a shared folder on a MOBOTIX NAS. 

 n MOBOTIX NAS (ONVIF):The ONVIF recordings are accessed  by Videomanagement Software QVR Pro 
which must be installed on a MOBOTIX NAS.
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     Local

Path:
you must select the path that contains the recording folders created by the camera.

Network Share

  File Server (IP): IP address or DNS name of the file server with the share.

  Directory: Name of the share on the file server.

Note
Make sure that the path ends before the folder containing the factory IP address of the camera.         

  User Name/Password: Access data for the network share.

MOBOTIX NAS
Data is accessed directly on a shared folder on a MOBOTIX NAS. 
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  File Server (IP): IP address or DNS name and port of the MOBOTIX NAS.
  Directory: Name of the share on the MOBOTIX NAS. 

Note
Make sure that the path ends before the folder containing the factory IP address of the camera.

  User Name/Password: Access data for the MOBOTIX NAS.

MOBOTIX NAS (ONVIF)
The ONVIF recordings are accessed  by Videomanagement Software QVR Pro which must be installed on a 
MOBOTIX NAS.
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Fig. 137: MOBOTIX NAS settings

  File Server (IP): IP address or DNS name of the file server.
  User Name/Password: Access data for the file server.
  Use Expert settings ( ONVIF access): If special access data are required for ONVIF access, enter them here.
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MOBOTIX NAS Configuration

Fig. 138: MOBOTIX NAS Configuration

The following functions are available for configuring and maintaining a MOBOTIX NAS or MOBOTIX NAS 
(ONVIF) system

Quick Guides 
Links to download installation or configuration manuals for MOBOTIX NAS systems

Installation and Configuration 

 n Open Device Finder:
The Device Finder finds MOBOTIX NAS systems in the network, making initial configuration easy.

 n Configure NAS:
Opens the web interface of the MOBOTIX NAS system with which you can configure the NAS device.

 n QVR Pro Settings:
Opens the web interface of the video management software QVR Pro. This software must be installed 
on the MOBOTIX NAS system first.

 n Recording Storage Space:
Opens the web interface of the MOBOTIX NAS system with the interface for setting up the storage 
space for video recordings.

 n Troubleshooting:
 n Here you can download the log files of the MOBOTIX NAS system or the QVR Pro software.
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 n Download links:
Links to useful resources for installation, configuration and maintenance. 

  Container App: You need the Container App to install the QVR Pro App on a MOBOTIX NAS system.

  QVR Pro App: The software for managing recordings from MOBOTIX MOVE or ONVIF cameras on a 
MOBOTIX NAS system.

  Device Finder App - macOS: Use the Device Finder App to find MOBOTIX NAS systems in the network.

  2Bay and 4Bay NAS Firmware: The latest firmware for your MOBOTIX NAS system.

  8Bay NAS Firmware: The latest firmware for your MOBOTIX NAS system.

Smart Data Settings
With the MOBOTIX Smart Data System, transaction data, for example from POS systems, can be linked to the 
video recordings of transactions in MxMC.

Note
A license is required to activate the general Smart Data interface from which you can read transaction data, 
e.g. from POS systems or third party license plate recognition systems.
No license is required to use Smart Data from MOBOTIX P7 Apps. 

Fig. 139: Smart Data settings

Adding a Smart Data Source

 1. Click the  icon ①  and select a Smart Data type. 
 2. Configure the Smart Data Source the Settings area ② . 
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 Configure General Smart Data Sources (license required)
Edit here Smart Data sources (e.g. POS systems or license plate recognition systems).

Fig. 140: Settings for general Smart Data sources

 n Description
Enter a meaningful name for the Smart Data Source here. Under this name, the source can be iden-
tified and selected in the MxMC for research.

 n Name
Enter the name (without spaces) for the Smart Data Source exactly as it was assigned in its con-
figuration (also without spaces).

 n Smart Data Type
Select the type of Smart Data device here.

 n Data Source
Select the camera in which the Smart Data source (identified by the name given above) stores its trans-
action data.

 n Video Source
Select the camera that provides recordings for the transaction data. The video source and the data 
source do not have to be identical.

Configure P7 Apps as Smart Data Sources  (no license required)
Edit here P7 Apps as Smart Data sources.
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Fig. 141: Settings for general Smart Data sources
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Note
The minimum Firmware Version on the MOBOTIX IoT Camera is 7.1.2.24.

 
Follow these steps in the Camera user interface to prepare the camera to run properly with the Smart Data 
interface of MxMC:

 1. Go to Admin Menu > Smart Data Configuration and click Add Smart Data source.

 2. Enter the specific identifier for a P7 App:

  Vaxtor: VaxALPR.plate

  FF Group: FFLPR.plate

  Visage: VT_Face.face

 3. Click Set

 4. Store and reboot the camera

 5. Go to Setup Menu > General Event Settings and enable Arming.

 6. Click Set

 7. Go to Setup Menu > Recordingand select

  Arming = Enabled

  Recording (REC) = Continuous Recording,  2 fps

 8. Click Set

 9. Go to Setup Menu > Certified App Settings and check "Active"

 10. Click "Set"-button

 n Description
Enter a meaningful name for the P7 App as Smart Data Source here. Under this name, the source can 
be identified and selected in the MxMC for research.

 n Name
Enter the name (without spaces) for the Smart Data Source exactly as assigned in its configuration on 
the camera .

 n Smart Data Typ
Select the type of Smart Data device here.

 n Data Source
Select the camera in which the Smart Data source (identified by the name given above) stores its trans-
action data.

 n Video Source
Select the camera that provides recordings for the transaction data. The video source and the data 
source do not have to be identical.
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MxThinClient Settings
MxThinClients allow you to display live images from MOBOTIX cameras on a monitor or TV set with HDMI 
connection.

Fig. 142: MxThinClient settings

Adding a MxThinClient

 1. Click the  icon ①  . 
 2. Configure the MxThinClient the Settings area ② . 

MxThinClient-Settings
Edit the MxThinClient setting here. 
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Fig. 143: MxThinClient settings

Name
Enter the name for the MxThinClient.
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URL
Enter the URL or IP address of the ThinClient.
User Name
Enter the user name of the MxThinClient user here.
Password
Enter the password of the ThinClient user here.
Display resolution
Select the resolution of the camera image to be displayed on the monitor of the MxThinClient.
Camera display
Select here how long the assigned camera image should be displayed on the monitor of the ThinClient. After 
the selected time period the ThinClient will display the configured setting (e. g. sequences, still images etc.).

Wizards & Tools
MxMC provides cross-system maintenance and security features, such as creating backup copies of current 
camera configurations or checking and improving system security. This section provides an overview of the 
currently available system functions.

Note
The system functions described below are not supported by MOBOTIX MOVE cameras and third-party cam-
eras that provide an ONVIF S-compatible interface. For an overview of how the camera functions differ, see 
Camera Feature Overview.

Fig. 144: Wizards & Tools
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 1. To open the Wizards & Tools view, right-click on the navigation key in the Command bar and select 
Wizards & Tools.

Fig. 145: Opening Wizard & Tools View

 2. Select the related camera or camera group in the Device bar or the Camera/Group bar.
 3. Select the desired function:

Maintenance Functions

Reboot Devices
When it is required to reboot a device, for example to fix network issues. Click  Reboot Devices to do so. 
You can determine which cameras are rebooted from the current selection of cameras or camera groups.

Back Up Devices
The current configuration of cameras or the cameras of one group are saved when you click Backup Devices. 
You can enter a name for each backup. The name should be meaningful enough enabling you to quickly 
select the desired configuration when you want to restore a configuration later on.

Restore Devices
The configurations you save when using Backup Devices can be used to restore a configuration, for example, 
if a camera is no longer operational due to a problem with a configuration.  Click on Restore Devices and 
select the desired configuration. 

Update Devices
You can apply a software version to a larger number of cameras at one time. Download the desired software 
version from the MOBOTIX download directory: www.mobotix.com > Support > Download Center > Mar-
keting & Documentation. Next, click Update Devices and open the *.mpl file. The new software will be 
uploaded to the cameras. The cameras will automatically reboot when the update is complete.
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Attention
that the software you select to install is compatible with all cameras in the group. Otherwise, the update 
cannot be performed.

Reset Devices
Click Reset Devices in order to reset one or more cameras to the factory settings. In the process, you can 
select whether or not security settings (user names and passwords) and network settings should be reset, as 
well. The cameras will then automatically reboot.

Note
Project data will not be automatically updated when you reset the camera(s) to factory settings. You will 
need to update them manually. 

Security Functions

Secure System
This feature helps administrators when securing camera systems. It shows them exposed points of attack and 
prevents unauthorized or unencrypted access to cameras.
To check system security and secure the system, see Checking System Security, p. 258.

Health Check
A MOBOTIX camera independently checks its system status permanently. The results of this check are avail-
able in the Wizards & Tools view by using the Health Check function. 
Also see Health Check, p. 261.

SSL Certificates
SSL is the standard technology for securing an Internet connection by encrypting the data sent between a 
website and a browser (or between two servers). This function allows an administrator to upload or create a 
SSL certificate to the selected cameras.
Also see Managing SSL Certificates, p. 262.

Initialize Door Station
The door station wizard will guide you through the basic configuration steps of the selected door station.
Also see Door Station Wizard, p. 272.

Checking System Security
After completing the basic configuration of the system, you can check its security. The Wizards & Tools, p. 
256 view offers the Secure System wizard. It analyzes the security of the cameras and assesses their status 
based on common best practices. If test criteria are not met, possible measures to protect the cameras are 
provided. 
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Note
The system security check feature is not available for MOBOTIX MOVE cameras and third-party cameras 
that provide an ONVIF S-compatible interface. For an overview of how the camera functions differ, see    Cam-
era Feature Overview, p. 13   .

Verifying Settings for System Security

 1. To open the Wizards & Tools view, right-click on the navigation key in the Command bar. Select the 
Wizards & Extras view.

 2. Select the desired camera or camera group in the Device bar or the Camera/Group bar.
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 3. Click Secure System. The following criteria are checked:
 n Usage of the "meinsm" password with standard or ONVIF user accounts on MOBOTIX cameras. It is 

easy for cyber attackers to guess the standard "meinsm" password.

 n Enabled Public Access: If Public Access is enabled, a number of different camera functions can be 
used without a password.

 n Activated HTTP web server: It is possible for data, including user data such as passwords and images, 
to be transmitted via the network without encryption when HTTP is used. 

The result of the check is displayed for each camera in the Secure System dialog. It will also show all cases 
in which cameras were not checked due to a connection error, for example.

Status Explanation

 Not secured There was at least one criterion that was listed as not secure.

 Software too old Please check the camera software and update it, if necessary.

 Connection error Check your network connection to the camera and perform the security check again. 

 Not supported The camera (s) cannot be analyzed or secured using the wizard.

 Secured Camera is secure; no further action is necessary.
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Secure System

 4. In the Secure System dialog, click on Next. Cameras resulting in a Not secure status are displayed 
together with whichever of the three criteria that were fulfilled as well as the measures that need to be 
taken to properly secure the cameras: 

Criterion Explanation

Password Changes the password of all user accounts on the cameras that use the standard “meinsm” pass-
word. It also include ONVIF users whose passwords have never been changed.
      Enter a new password and confirm it. A suitable password has at least eight characters. It can 
consist of lowercase and uppercase letters, digits and special characters (see ). If you set a 

password that does not meet these criteria, a red frame appears around the text field. The frame 
turns green once you have entered a valid password.
     The new password is automatically entered in the MxMC project data. 

SSL 
encryption

Disables camera connections via unencrypted HTTP and configures the cameras to accept 
HTTPs connections only.
      The TCP port and the SSL setting will be automatically updated in the MxMC project data, if 
necessary. 
      The TCP port will not be updated for cameras that are connected via a remote URL. For remote 
URL connections, you may need to change port forwarding in the router to the appropriate set-
ting.
Please note that different services, such as network messaging etc., will no longer work when 
you disable HTTP. 

Public 
Access

Disables access that does not require password entry to the web interface and the APIs of the 
cameras. 

 5. Click on OK in the dialog box. The selected security measures will be performed. The security status for 
the selected camera or camera group will be analyzed once again and the result for each camera is dis-
played. 

Health Check
A MOBOTIX camera independently checks its system status permanently. The results of the health check are 
available in the Wizards & Tools, p. 256 view.
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Fig. 146: Health Check

 1. Click on Health Check.
 2. The camera-internal checking data is now queried and listed in tabular form.

The Health Check dialog provides a  overview of the proper operation or functional status of your MOBOTIX 
cameras. The Health Check is divided into two areas:

Area Explanation

Overview Summary of the examined areas of the polled cameras by means of a color-coded system status 
report:
Red = error
at least one functional area signals an error condition.
Orange = Warning
one or more functional areas signal a warning.
Green = OK
all functional areas are working properly
The overview area shows how many of the polled cameras are in an error state or warning state 
① . The table lines indicate the system health for each camera, including a summary of the error 
messages and warnings for each scanned area ② .

Details Detailed listing of the system state of the camera in the checked areas, which is displayed by 
clicking on the Camera bar in the overview area ③ .

Managing SSL Certificates
SSL is the standard technology for securing an Internet connection by encrypting the data sent between a 
website and a browser (or between two servers). This function allows an administrator to upload or create a 
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SSL certificate to the selected cameras. 

Upload a SSL certificate to a camera

 1. Open the Wizards & Tools view, right-click on the navigation key in the Command bar.

 2. Select the desired camera or camera group in the Device bar or the Camera/Group bar.

 3. Click SSL Certificates.The SSL Certificate Wizard appears:
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 4. If the status of the camera is OK click Next.

 5. Click Upload to upload of an existing SSL Root Certificate including private key

 6. Select an existing certificate, the Private Key and enter the certificate Password.

 7. Click Verify Data. If data verification was successful click Next. 

Note
If data verification fails check your certificate
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 8. Click Upload A summary of about successful uploads or errors appears and the camera will be rebooted. 
See Summary about successful uploads and errors, p. 270.

Generate a SSL certificate

 1. Open the Wizards & Tools view, right-click on the navigation key in the Command bar. Select the 
Wizards & Extras view.
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 2. Select the desired camera or camera group in the Device bar or the Camera/Group bar.

 3. Click SSL Certificates.The SSL Certificate Wizard appears:

 4. If the status of the camera is OK click Next.

 5. Click Create to create a new SSL Root Certificate including private key
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 6. Enter a Key Name and a Key Password for the private key and click Create and Save.

 7. After saving the private key click Next. The dialog Create Certificate Authority appears.
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 8. Fill out at least the mandatory fields and click Generate Cert. If 
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 9. Optionally you can create a backup of the SSL certificate. When clicking on Backup Certyou can select a 
directory to save the certificate file.

Note
A backup of your certificate is recommended e. g. if you need to distribute it on other 
MxManagementCenter installations in within your project.

 10. Click Next.

 11. Enter the certificate Password you defined in Enter a Key Name and a Key Password for the private key 
and click Create and Save., p. 267.

 12. Click Verify Data. If data verification was successful click Next.

Note
If data verification fails check your certificate. 
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 13. Click Upload A summary of about successful uploads or errors appears and the camera will be rebooted. 
See Summary about successful uploads and errors, p. 270.

Summary about successful uploads and errors

The certificate could not be verified
There is no matching root certificate in MxMC’s “Certificates“ folder.

The certificate hostname does not match the camera hostname
E.g. the camera still has the MOBOTIX factory certificate but is connected using an IP address other than the 
factory supplied IP address.
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Four or more cameras report SSL errors.
When four or more camera connections report SSL errors at the same time a list of untrusted cameras is 
shown.

Display the SSL certificate information
If an SSL error occurs it is now possible to display detailed certificate information.
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SSL error on one camera

 1. Click View certificate information.

List of multiple cameras with SSL errors

 1. Select a camera in the camera list

 2. Click on the exclamation mark icon on the right ① . The related Certificate information appears.

 

Door Station Wizard
The Door Station wizard will guide you through the basic configuration of a selected door station.
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Also see:

 n Door Station Settings, p. 207

 n Operate Door Stations, p. 143

Basic requirements

 n Make sure that the devices run the latest software otherwise the configuration could fail.

 n Additional door stations (including S1x, S2x cameras) to be configured must be listed in the Device 
Bar.

 n Apply the default password "meinsm" to all door stations. To do so, you can use the Secure System 
Wizard.

 n Apply the default password "meinsm" to MxDisplay devices to be configured.

Step by step

 1. To open the Wizards & Tools view, right-click on the navigation key in the Command bar. Select the 
Wizards & Extras view.

 2. Select the related door station (camera) Device bar or the Camera/Group bar and click Initialize Door Sta-
tion. The Door Station Wizard starts up.
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 3. Read the introduction text and make sure you meet the basic requirements for the further configuration. 
Click Continue.

 4. Select the devices you want to configure and click Continue. The Selected devices will be configured. 
This can take while.

Note:
Only devices with suitable software can be selected. The Master door station cannot be deselected.
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 5. Check the summary of the configured devices and click Continue.

 6. Follow the next remaining configuration steps and click Finish.  
 n Initialization of door station RFID module

 n Add MxBell as remote Station

 n Define all relationships between addresses and remote stations

 n Configure I/O-wiring

 n Final configuration of all door station (cameras)

 n Setup MxDisplay
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Licensing
Activation or purchase of a license is required to use certain features. This includes licenses for the following 
features:

 n Smart Data: industry-specific solutions and special features, such as integration with POS systems.

 n H.264 De-/Encoder: for displaying and exporting videos in H.264 format.

 n Cameras from third-party manufacturers: Integrate cameras from other manufacturers than 
MOBOTIX.

 n Advanced Config: Collection of functions for simplified configuration of cameras.

For license activation see MxMC Licensing, p. 276
For camera models from the MOBOTIX M73 series there is the possibility to use apps. Apps, for example, offer 
extended functions for image analysis which may be supported by algorithms of artificial intelligence. Vari-
ous apps are pre-installed on the camera and must be activated for use with a valid license key (seeCamera 
App Licensing, p. 278).

MxMC Licensing

Activate licenses
After purchasing and receiving the activation IDs, enable them in MxMC as follows:

 1. Open the License Management (Window > Licenses menu item) and click on Activate Licenses.

Activate license

 2. Enter a valid activation ID and establish the number of licenses that will be installed on this computer. 
 3. Click on  if you want to license an additional product. Enter the corresponding activation ID in the 

new line and enter the number of desired licenses.
 4. Click on  to delete a line.
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 5. When you are finished entering all activation IDs, click on Activate. MxMCconnects to the license server 
for activation. It needs to establish an Internet connection.

Fig. 147: Entering license key

 n Successful activation
If the activation was successful, you will need to sign in again to apply the changes. Alternatively, you 
can also return to License Management .

 n Activation failed (no Internet connection)
MxMC connects to the license server for activation. It needs to establish an Internet connection. An 
error message appears if there is no Internet connection. It will then save an offline request file (*.lic). 
This file enables the partner/installer from whom you purchased the licenses to generate a func-
tionality response (.bin file) on the license server. If you have received such a response, open the 
Activate Licenses window (Window > Licenses > Activate Licenses menu). Click on Load Func-
tionality Response File. 
Once you have loaded the functionality response file, you will need to log back in to apply the 
changes. Alternatively, you can also return to License Management .
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Managing Licenses

Fig. 148: Managing licenses

You can view a list of all licenses that have been activated on this computer in License management. To 
open the License Management, click on Window > Licenses in the Menu bar.

Designation Explanation

Product Name of the licensed function.

Expiration 
date

This column indicates whether the license is temporary and when the licensing period may 
end. 

Number Number of licenses that were purchased for a product. 

Device ID Unique identifier that is determined by MxMC for the used device. Note the device ID and keep 
it accessible if you should run into any problems during licensing.

Synchronizing licenses with the server
  When launching the program, it does not automatically compare the licenses on the computer with the 
license server. For this reason, you need to click on Update to reload the licenses from the server. 
Updating licenses
  To update temporary licenses, click on Activate Licenses. The dialog box used for updating/activating 
licenses is shown.

Note:
You need administrator rights to synchronize and update licenses.

Camera App Licensing
For camera models from the MOBOTIX M73 series there is the possibility to use apps. Apps, for example, offer 
extended functions for image analysis which may be supported by algorithms of artificial intelligence. Vari-
ous apps are pre-installed on the camera and must be activated for use with a valid license key.
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Online-Activation
After receiving the activation IDs, activate them in MxMC as follows:

 1. Select from the menu Window > Camera App Licenses.
 2. Select the camera on which you want to license apps and click Select.

 3. An overview of the licenses installed on the camera may be displayed. Click Activate License.

Note
If necessary, correct the time set on the camera.

 4. Enter a valid Activation ID and specify the number of licenses to install on this computer.
 5. If you want to license another product, click on . In the new row, enter the appropriate Activation ID 

and the number of licenses you want.
 6. If necessary, click  to remove a line.
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 7. When you have entered all Activation IDs, click Activate License Online. During activation, MxMC con-
nects to the license server. This requires an Internet connection.

Successful activation

After successful activation, a new log in is required to apply the changes. Alternatively, you can return to 
license management. 
Failed activation (missing internet connection)
  If the license server cannot be reached, e.g. due to a missing internet connection, apps can also be activated 
offline (see Offline activation).

Offline-Activation
For offline activation, the partner/installer from whom you purchased the licenses can generate a capability 
response (bin file) on the license server to activate their licenses..
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 1. Select from the menu Window > Camera App Licenses.
 2. Select the camera on which you want to license apps and click Select.

 3. An overview of the licenses installed on the camera may be displayed. Click Activate License.

Note:
If necessary, correct the time set on the camera.

 4. Enter a valid Activation ID and specify the number of licenses to install on this computer.
 5. If you want to license another product, click on . In the new row, enter the appropriate Activation ID 

and the number of licenses you want.
 6. If necessary, click  to remove a line.

Management
Licensing
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 7. When you have entered all Activation IDs, click Download Capability Request File (.lic). and send it to 
your partner/installer. This file allows the partner/installer from whom you purchased the licenses to gen-
erate a capability response file (.bin ) on the license server.

 8. Click Load Capability Response File and follow the instructions.

Successful activation

After successful activation, a new login is required to apply the changes. Alternatively, you can return to 
license management .

Manage licenses
In the license management screen, you get a tabular overview of all licenses that have been activated for a 
camera. 
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 1. Select from the menu Window > Camera App Licenses.
 2. Select the camera on which you want to license apps and click Select.

 3. An overview of the licenses installed on the camera may be displayed.

Field 
name

Explanation

Name Name of the licensed app.

Product The feature of the licensed app

Expiration the time limit of the license 

Quantity Number of licenses purchased for a product.

Serial 
number

Unique identification determined by MxMC for the device used. If problems occur during licens-
ing, please have the device ID ready.

Management
Licensing
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Synchronize licenses with server

When the program starts, there is no automatic comparison of licenses between the computer and the 
license server. Therefore, click on Update to reload the licenses from the server.

Update licenses

to update temporary licenses, click Activate Licenses. The dialog for updating/activating licenses opens.

Note
You need administrator rights to synchronize and update licenses.
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System Configuration
The MxManagementCenternow allows you to configure MOBOTIXcameras directly. This section addresses 
administrators and system installers. It provides an overview of the operation of the Configuration view 
and the Configuration bar and provides information on how to operate the graphical elements. 

Topics Explanation

Configuration: Overview, 
p. 285

Overview of the structure and working with the Configuration view and the Con-
figuration bar

Graphical operation, p. 
292

Explanations of how to operate the graphical configuration elements.

Configuration: Overview
The Configuration view you to directly access and make settings for MOBOTIXcameras. In general, the view is 
divided into a Basic Settings section and an Advanced Configuration section containing Configuration 
Groups.
The controls at the bottom can be used for actions such as storing the changed settings permanently or reset-
ting the parameter values to their factory settings.
The settings are made for one camera at a time. The Configuration bar on the right margin also offers the pos-
sibility to change the settings of several cameras of a group simultaneously without having to change the 
camera or the camera group.

Note
The Configuration view is not supported by MOBOTIX MOVE cameras and third-party cameras that provide 
an ONVIF S-compatible interface. For an overview of how the camera functions differ, see Camera Feature 
Overview, p. 13.

System Configuration
Configuration: Overview
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System Configuration
Configuration: Overview

Structure of the camera configuration view

Fig. 149: Structure of the camera configuration view

Basic Settings
The Basic Settings ①  contain basic configuration settings that are important for the setup of cameras and 
camera system. The Basic Settings include the following areas: 

 n General Settings,

 n Network,

 n Time,

 n Image Settings,

 n MxActivitySensor and Recording.

The parameters of the respective topic areas are grouped in tabs. For information about each tab, see Con-
figuring Basic Camera Settings, p. 100.
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Fig. 150: Basic settings

Advanced Configuration (license required)
The available configuration parameters are thematically grouped in tiles. The Advanced Configuration tiles ②  
are only visible if the required license key has been installed, otherwise only the basic settings are available. 
Clicking on a tile opens the topic area and tabs for the associated sub-topics.
Some of the topics contain graphical configuration items, such as those for defining exposure windows or 
detection areas. For more information on how to operate these configuration items (see Graphical operation, 
p. 292).
Extensive information on the setting options and parameters of the individual subject areas are currently 
available only via the help pages of the camera. You can access the camera help table of contents directly 
from MxMC by pressing CMD+Shift+H (Mac) / CTRL+Shift+H (Windows).

Fig. 151: Advanced Configuration

System Configuration
Configuration: Overview
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System Configuration
Configuration: Overview

Advanced Configuration - Users and Groups

Configuring Advanced Settings

Caution
By modifying User Settings, you can loose access to your cameras. Make sure you do not delete or move 
user or passwords you do not know!

 1. Click on the respective tab to open the corresponding topic area.
 2. Make your settings as required by topic. 

Note
Clicking on the relevant topic area in the table opens an information page for the individual topic areas 
of the Advanced Configuration settings. 
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Fig. 152: Advanced Configuration - Users and Groups

Applying and saving changed settings

Warning
By modifying User Settings, you can loose access to your cameras. Make sure you do not delete or move 
user or passwords you do not know!

Fig. 153: Applying and saving changed settings

System Configuration
Configuration: Overview
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System Configuration
Configuration: Overview

You can use the controls at the bottom of the view to permanently save changed settings or to reset the para-
meter values to factory settings, among other things:

Resetting To Factory Settings
Click on  to reset all parameters for the current camera tab to the factory settings.

Undo/Redo Last Change
Click on  to undo the last change. Click on   to redo the change you previously undid.

Apply Changes
You can make changes by pressing Enter or selecting the new value in the Configuration view. The changes 
made here are not automatically adopted because it could potentially cause problems with the network set-
tings.
    When a value is changed, the checkmark in the Command bar turns red, indicating that the change has not 
been implemented yet. Click  to make this change.

Saving Configurations
If parameter values are changed, the Store Configuration  icon turns red in the Command bar. Initially, 
changes are always temporarily stored in the camera. To ensure that the current settings are also used after 
the next restart, the changes must be saved permanently.

 1. To do so, click on Store configuration . The program opens a system prompt. In the prompt, click on 

Store.
 2. If you do not want to keep the changes, click on Discard. This discards the changes and restores the last 

permanently saved overall configuration.

Expert Settings
Various sections of the configuration provide additional settings that can be used to change parameters that 
are not necessary for the daily work with MxMC. Note that these settings have been combined as expert set-
tings in the different sections. Click on    to open the expert settings.

Changing Parameter Values For Multiple Cameras In The Configuration 
Bar

Warning
By modifying User Settings, you can loose access to your cameras. Make sure you do not delete or move 
user or passwords you do not know!
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You can enter parameters for a single camera in the Configuration view. You can use the Configuration bar to 
check which parameter values are available for the other cameras in the group. There you can also change 
the settings of one or multiple cameras in the group without having to switch to a different camera or cam-
era group.

Checking parameter values of other cameras in the group

Fig. 154: Checking parameter values of other cameras in the group

Example: Check arming for multiple cameras

 1. Click on the relevant parameter name ① .
 2. It turns yellow and the Configuration bar shows all values associated with this parameter that were 

defined for cameras in this group ② .

System Configuration
Configuration: Overview
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System Configuration
Graphical operation

Changing a value for one camera or for multiple cameras

Fig. 155: Changing a value for one camera or for multiple cameras

Example: Change a value using the Configuration bar

 1. Click the appropriate parameter name in the Configuration view ① . It turns yellow and the Configuration 
bar shows all values associated with this parameter for this group ② . The cameras for which this value is 
set are assigned to the individual values.

 2. Highlight the desired camera and drag it onto the parameter value you want to set. The destination area 
turns yellow.

 3. If the same value is set for several cameras and you want to change this value, click on the parameter 
selection field in the Configuration bar ③ . Then select the desired value.

Graphical operation

Graphical window definition
In the configuration, graphical elements such as exposure windows and detection areas can now be easily 
edited with the mouse. The processing of these graphic elements is subject to a uniform operating concept, 
which is explained in the following table.        
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Action Explanation

Create expos-
ure/detection win-
dow

Draw a window using the mouse pointer.

Move the exposure 
window/detection 
area

Left-click on the exposure window / detection area and move it to the desired position.

Change the expos-
ure win-
dow/detection 
area

Move the mouse pointer over one of the white "handles" until the  icon is displayed. 

Left-click with the mouse and drag the window making it larger or smaller.

Rotate the expos-
ure win-
dow/detection 
area

Click on  and, while holding the mouse button down, rotate the green area clock-

wise or counterclockwise.

Change the shape 
of the exposure 
window/detection 
area

Switch to polygon mode by clicking on . You will see white corner points on the 

corners. Drag the corner points to the desired position. You can insert new corner 
points by right-clicking on the white line or in the green area. Right-click on a dot to 
delete a corner point. Then click on .

Delete expos-
ure/detection win-
dow

Click on  .

Exclude area from 
analysis

Pull open a window of the appropriate size at the position that should be excluded 
from the analysis. Click in the window and keep the mouse button depressed until two 
icons appear. Click on  to determine the exclusion window. The window turns red. 

Note
The processing status of graphical window elements is indicated by a yellow or a green window color. If a 
window is yellow, it cannot be edited. An example of this are predefined exposure windows. On the other 
hand, green windows, such  as custom exposure windows, can be graphically edited.

System Configuration
Graphical operation
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Context Help
Temporarily Assign Supervisor Passwords to Functions

Context Help
The section is a reference of all context help topics.

 Temporarily Assign Supervisor Passwords to 

Functions
Certain situations may require users to execute functions for which they usually do not have the 
rights. These functions can be made available temporarily using a supervisor password. The user will have 
access to all cameras available for the project when launching the Supervisor mode. 

 1. In addition, you can specify after how many minutes of inactivity this user will be logged out auto-
matically.

Note
While a recording is being played back in Playback view or in Grid Playback, MxMC does not auto-
matically terminate the supervisor mode after the specified period of time.

 2. Select the functions that can be accessed after entering the password.

Histogram Bar 
The histogram illustrates the distribution of event frequency and thus provides a quick overview of the 
events of one or more cameras.

Opening The Histogram Bar
To open the Histogram bar, click on the dark gray ribbon on the right margin of the MxMC. To begin with, 
the histogram always shows the entire range of the events logged by the camera.
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Fig. 156: Opening the histogram bar

Working With The Histogram

Structure Of The Histogram
The histogram is split into the overview area on the top and the zoomed area of the selected range below. 

The yellow scroll bar in the overview area shows the range that is displayed in the zoomed area. Click on   
to set the displayed time range in the zoomed area (for example, six hours or one day). If you have set the 

zoomed area to  "Custom," you can modify the displayed time range by dragging the edges of the scroll 
bar.

If you want to see only events in the zoomed area that have triggered recordings, click on .
The pink area indicates the time range for which recordings exist for the logged events.

Note
The range of logged events may reach farther back than the recordings.

Fig. 157: Histogram bar in details

User interface elements in the histogram

① :  Resolution of zoomed area (high / low),  set zoom range (custom or pre-defined), 

Context Help
Histogram Bar
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Context Help
Histogram Bar

② : Zoomed area
③ : Overview area
④ : Current time marker
⑤ : Event type and camera / camera group
⑥ : Time range with recordings
⑦ : Time range in zoomed area

Displayed Time Range
The timestamps at the top and bottom of the histogram show the first and the last of the available events 
logged by the camera, respectively. You can change this range manually. A small cross at the left of the time 
range indicates that it has been changed manually. Click on the cross to reset the timestamps to their ori-
ginal values. 

Filter Feature
You can filter the display by camera, by group or by event type. There two sliders for this purpose: the 

group/camera slider  and the event type slider . To set the filters, move the sliders until you see the 
desired results. The following filters are available:

 n Camera filter
 all cameras

 cameras from the current group

 current camera

 n Event filter
 MxActivitySensor event

 video motion events

 PIR events

 microphone events

 signal input events

  temperature events

 illumination events

 bell events

 voice mailbox messages

 Door Station events

 RFID rejected

 PIN rejected

 all event types

Distribution Of Frequency

The length of the bars indicates the frequency of logged events per time unit. Click on  to examine the dis-
tribution of frequency for a specific point in time in more detail. The display switches to a higher resolution. 
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For more detailed information on a specific point in time with a high event frequency, click on the related 
spot in the zoomed area or the overview area. 
In the Playback view, a red marker is also displayed to indicate the current position.

Smart Data Bar
With the MOBOTIXSmart Data System, transactions in the MxMC can be linked to the video recordings made 
at the time of the transactions. It enables you to quickly find and review any suspicious activities. The Smart 
Data Bar and the The Smart Data View, p. 70 are available for searching and analyzing transactions. The 
Smart Data Bar provides a direct overview of the most recent transactions (from the last 24 hours) and for 
this reason it is convenient to use it for reviews and searches.

Opening the Smart Data Bar
The Smart Data Bar is available in all views. To open the Smart Data Bar, click on the right frame border of 
the application. The Histogram bar will appear. Click on the frame border again to switch to the Smart Data 
Bar. You can also open it from the menu (View > Smart Data Bar).       

Fig. 158: Smart Data Bar

Using the Smart Data Bar
If a Smart Data Source, e.g. a cashpoint is transmitting new data to the camera, the Smart Data Bar is auto-
matically updated. It enables live surveillance of the cash point and of the retail data of a camera. You can 
group transactions that belong together and display them.

 n Displayed time range: The Smart Data Bar only contains the data from the last 24 hours. You can 
search data that is older than 24 hours in the Searching Transaction Data, p. 352 dialog.

Context Help
Smart Data Bar
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Export Bar

 n Search feature/Filter feature: You can filter the entries for each cash point’s camera by search term. 
The hits are highlighted in yellow. You can jump to the next/previous search result using the two 
arrows on the lower edge.

 n Do not show system transactions: By default, the Smart Data Bar shows all transaction that are 
stored on the corresponding camera. Some of the transactions, e.g. from a cash point, show purchases 
and events that are directly associated with the purchases, such as the “Total sum.”  Other trans-
actions show only administrative events, such as when the cashier logs on.  Click on  to enable/dis-

able display of system transactions.

 n Do not group receipts (for VECTRON cashpoints only): Transactions are grouped by receipt number 
or purchase by default. Individual sales can be grouped if the cash point signals the conclusion of the 
transactions by creating a receipt number. Counter sales can be grouped by counter if the counter is 
settled in the cash point system. Click on  to disable display by groups. The data will be reloaded.

 n Playback transactions: Open the Playback view by double-clicking on a transaction line. The trans-
action will be played back.

Export Bar
The Export bar provides a quick and easy way to take camera recordings and MXG clips by dragging and drop-
ping and create a list of recordings for subsequent exporting. From the bar, you can export recording time 
ranges as combined clips. You can add the clips in the Playback view, in Grid Playback, in the Research view 
and in the Smart Data View. The Export bar is not automatically deleted after an export. It is deleted when 
the program is closed.

Adding Clips for Exporting

Adding Clips for Exporting in the Playback View

 1. Drag the desired camera or the desired clip from the camera bar or from the Device bar.
 2. Find the recording you are interested in.
 3. Mark the start of the time range by clicking on the gray flag on the left . Play the recording until you 

have reached the end of the clip you want to export. Mark the end of the time range by clicking on the 
gray flag on the right . Both flags are now green.

      You can set the end marker first (gray flag on the right), then play the recording from the beginning so 
you can set the start marker (gray flag on the left) at the desired point.

 4. Click on the image of the recording and maintain the position until you see a scaled-down image.
 5. Drag this image to the Alarm bar (regardless of whether or not it is open). The Alarm bar automatically 

turns into the Export bar, allowing you to place the image there. 
      Another option is to: Activate the Alarm bar. Click on the lower frame border of the open Alarm bar. The 

Export bar opens. Click on . The selected time range will be copied to the Export bar.
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Adding Clips for Exporting in Grid Playback
The Export bar in Grid Playback is the best way to combine sequential time ranges of different cameras. For 
example, you can use it to follow one person who passes by several cameras. 

 1. Drag the desired camera to the focus window in the grid and find the relevant recording.
 2. Mark the start of the time range by clicking on the gray flag on the left . Play the recording until you 

have reached the end of the clip you want to export. Mark the end of the time range by clicking on the 
gray flag on the right . Both flags are now green. 

 3. Click on the image of the recording in the focus window and maintain the position until you see a 
scaled-down image. Drag this image to the Alarm bar (regardless of whether or not it is open). The Alarm 
bar automatically turns into the Export bar, allowing you to place the image there.

 4. After you have set the end marker of the time range, the recordings of all other cameras will reposition to 
show the same time. Drag the camera with the next recording in the sequence of events into the focus 
window. Mark the start and the end of the clip as described above, then drag the recording into the 
Export bar.

 5. Repeat these steps until you have added all recordings you want to export.

Note
that you can also add time ranges from several cameras in the Export bar.

 1. Simply drag the desired camera group from the Group bar or from the Device bar and search for the rel-
evant recording.

 2. Mark the start and the end of the clip as described above. The recordings of the other cameras will repos-
ition accordingly.

 3. Right-click on Export . A selection box with a checkmark appears in the top left corner of the record-

ings. If you do not want to add the recording range of a specific camera to the list, deactivate that cam-
era.

 4. Click on the image of the recording in the focus window and maintain the position until you see a 
scaled-down image. Drag this image to the Alarm bar (regardless of whether or not it is open). The Alarm 
bar automatically turns into the Export bar, allowing you to place the image there. This means that all 
selected clips have been added to the Export bar.

 5. Repeat these steps until you have added all time ranges you want to export.

Adding Clips for Exporting in the Research View
In the Research view, you can add recorded event sequences to the list. The length of the event sequences is 
currently 10 seconds.

 1. Set filters by camera, by group or by event type as needed.
 2. Right-click on Export . A selection box appears on the event images in the top left corner. Select the 

desired events by clicking on the corresponding selection boxes.

Context Help
Export Bar
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Export Bar

 3. Open the Export bar by clicking on the lower frame border of the open Alarm bar. Click on an event 
image and maintain the position until you see a scaled-down event image. Drag this image to the Export 
bar. The clips of all selected event images are added to the Export bar.

Another option is to: In the Export bar, click on . The clips of all selected event images are added to 

the Export bar.
 4. If needed, you can set new filters and add more event images to the Export bar.

Adding Clips for Exporting in the Smart Data-View
You can add clips for the individual Smart Data transactions to the Export bar. The default clip length is ten 
seconds on either side of the transaction time stamp, that is, for a total of 20 seconds.   

 1. Right-click on Export . A selection box appears on the preview images in the top left corner. Select 

the desired transactions by clicking on the corresponding selection boxes. 
 2. Open the Export bar by clicking on the lower frame border of the open Alarm bar. Click on an preview 

image and maintain the position until you see a scaled-down preview image. Drag this image to the 
Export bar. The clips of all selected preview images are added to the Export bar.

      Another option is to: In the Export bar, click on  . The clips of all selected preview images are added 

to the Export bar.

You can also add clips for the individual preview images of the selected transaction to the Export bar. To do 
so, drag the transaction preview image in the Preview Image section and drop it on the Export bar. 

Editing Clips
If you have added a recording to the Export bar, for which you had activated distortion correction or zoom 
features during playback, you can choose to export the clip with or without PTZ settings. Likewise, you can 
export the clip with or without audio. To do so, move the mouse pointer over the recording in the Export 
bar. Three icons appear:

 n : Clip is exported with PTZ.

Click on  to export the clip without PTZ. The icon is disabled. 

 n : By default, the clips are exported with audio (provided that audio had been recorded).

To export without audio, click on . The icon is disabled.

 n : Note that you can review the clips before exporting by playing back individual clips directly in the 

Export bar. Click on   to do so.

Right-click on a clip to open a context menu with these functions: Manually adjust time range, activ-
ate/deactivate audio and PTZ for all clips, duplicate a clip, delete one or all clips.

Exporting
Click on Export , then select MOBOTIX to export an MXG clip. Select a different profile to create an AVI 
file. Select a target folder in the Export dialog and enter a file name. Activate the Automatically import 
after export checkbox to automatically add the MXG clips to the Export bar after exporting.
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 Door Station Events
You can limit the display of event images so that only door station events are displayed. These   events 
include:

 n  Ringing 

 n  Mailbox Message

 n  Door Station

 n  RFID Rejected

 n  PIN Rejected

Right-click on  and select the desired event types.

 Status Display

Door Status Display
 = Door is closed.
 = Door is open.
 = Door is locked.
 = Bolt is locked, but door is open!

Light Status Display
 = Light is off.
 = Icon is on: Lights are on, need to be switched off manually. 

Microphone Status Display
: Microphone is switched off, no announcements possible.

: Microphone is switched on, announcements are possible.

: Microphone connection is blocked; possibly because a connection exists from another remote station. 

 Highlighted Images
Images that you have marked while examining them in the Playback view, can be displayed here. Click on  
to show only the marked images.

Context Help
Door Station Events
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Context Help
Internal Events

           Internal Events
You can limit the display of event images so that only internal events are displayed. These   events include:

 n  Action Group Termination

 n  Custom Signal State

 n  Recording

Right-click on  and select the desired event types.

 Refresh
If the response to an action takes too long, you can click on Refresh to close and reopen the connection.

 n Click on  to close and reopen the connections to the currently visible cameras.

 n Click on  and hold the button for at least one second to close and reopen the connections to all 

cameras attached to MxMC.

Multi-camera Configuration
The Multi-camera Configuration dialog box allows changing authentication data used by MxMC and the 
environment settings of many cameras in one step. When opening the dialog, the application shows the cur-
rent settings of the cameras. The field is labeled with “multiple values” if one option has several different 
settings. 
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Status Display
Field type Current status

All cameras have the user name admin.
The cameras have different user names. 

This settings has been activated for all cameras.
This settings has been deactivated for all cameras.
The cameras have different settings. 

"HiRes" has been set as bandwidth setting for all cameras.
The cameras have different values. 

Changing the Settings
For more information on the individual settings, please see the Camera Configuration help topic. As opposed 
to the configuration of only one camera, you can revert the changes that have not been stored. Depending on 
the field type, you can use different methods.

Field type Explanation

If you change the text box of a setting, such as User name, a small cross appears 
on the right-hand side.  Click on the cross to reset the entry to its original value.

When closing the dialog, the previous setting will be restored. 

If you select Several Values in a selection box, closing the dialog will restore the 
previous setting.

Notes on the Settings
Here are several tips that will help properly edit the contents of the boxes, although the boxes and settings 
in this dialog box are identical to the Camera Configuration dialog box (see Camera Configuration). These 
tips will be described in the following:

Context Help
Multi-camera Configuration
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Context Help
Program Call

 n Recording path:
Local path: The Local Path option can be selected for all cameras. Note that you will need to enter 
the paths individually for each camera in the Camera Configuration dialog (see Recording Path in 
Entering and Editing Network Data).
Recording path: If you select a recording path (see Recording Path in Entering and Editing Network 
Data), MxMC automatically searches the device directory for each camera. The search has been com-
pleted if the progress bar is replaced by OK. If you close the dialog beforehand, you will have to enter 
the device directory for each camera in the Camera Configuration dialog.

 n Alarms:
The Alarms option activates or deactivates the alarm notification for all cameras. Note that you will 
have to set the alarm settings for the event types individually for each camera. Use the Camera Con-
figuration dialog to do this (see Setting up and Changing Alarm Notification).

Program Call
The desired dialog could not be opened. This can have the following causes:

 n MxMC was not started.

 n The online help was not opened from MxMC.

 n You do not have the required permission to access the dialog.

Live images
The Grid view shows the live images of all cameras of the selected camera group. The focus window can be 
used to closer examine the camera's live image, the grid area shows the live images of the other cameras.    
 If you move the mouse over the bottom of one of the live images, the Alarm Info bar with the  slider 
appears. Move the slider to the left. This opens the Instant Player with the last event image. Drag the red 
counter along the bar to show the preceding images. Click on  to play back the corresponding recording.
By activating the edit mode, you can set the format of the Grid layout – and thus the size of the live images 
and the focus window directly in the Grid view. Click on   to do so. The Command bar will display several 
controls.
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Alarm Bar
The Alarm bar turns red if events occur that lead to an alarm. This happens only if the Alarms option has 
been activated in the Camera Configuration dialog box and if the corresponding event types have been 
activated.
 You can filter the displayed alarm images in the bar by event type or by camera and play back the recording 
of an event directly from the Alarm bar. Click on the frame border to show the Alarm bar. To hide the Alarm 
bar, pull down the upper frame border. 
 If you click on the lower frame border with the alarm bar open, the bar changes to show the Export bar. 
Using drag, the Export bar provides a quick and easy way to collect recordings for subsequent exporting.

Detecting and Acknowledging New Alarms
You can activate the Alarms option in the Camera Configuration dialog box (right-click on the respective 
camera in the Device bar) for the corresponding camera and environment if you want events to trigger an 
alarm in a camera. In addition, you can select the event types that will cause an alarm. If the bar is hidden, 

new alerts will be indicated by a red frame border . If the bar is open, the info bar of the event image 

turns red. A ringing at the door bell will color the bar in green .
To acknowledge a new alarm, right-click on the event image and select Confirm. To acknowledge all new 
alarms at once, select Confirm All. 

Viewing the Live Image of the Triggering Camera
To quickly check the current situation, a single click into the Grid view of the corresponding camera group is 
sufficient. The live image of the triggering camera is automatically displayed in the focus window. The 
advantage is that you see not only the live image of the triggering camera, but also the live images of the 
cameras in the same area, thus giving you a complete overview of the situation. Of course, you will have to 
combine the cameras into corresponding groups beforehand. To switch to the Grid view, move the mouse 
pointer over the alarm image. Three icons appear. Click on  . 

Filtering the Display of Alarm Images
The alarm images in the Alarm bar are sorted chronologically. You can filter the event images by camera and 
group, by alarms or by event type. There are three slider bars for this purpose: camera filter, alarm filter and 
event filter. To set the filter, move the sliders until you see the desired results:

 n Camera filter:

All cameras , cameras from the current group , current camera . 

 n Alarm filter:
All events , alarm events , unconfirmed alarms .

 n Event filter:

MxActivitySensor events , video motion events , PIR events , microphone events , signal 

input events , temperature events , illumination events , bell events , voice mailbox mes-

sages , Door Station events , RFID rejected , PIN rejected , all event types .

Context Help
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Note
If background alarm calls have been deactivated in the Camera Configuration dialog box (see Entering and 
Editing Network Data), the application will only open an connection for the cameras if necessary, such as 
when live stream of the camera or recordings are played back via the camera.  This means that if you set 
the camera filter to All cameras when background alarm calls are deactivated, only the alarms of the cur-
rently connected cameras are displayed.

Playing Back Recordings

 n You can play back the recordings of an alarm directly from the Alarm bar. To do so, move the mouse 

pointer over the alarm image. Three icons appear. Click on  .

 n To play back the alarm in the Playback view, move the mouse pointer over the alarm image. Click on 
 to switch to the Playback view.

Deactivating Alarms
You can use the Camera Configuration dialog box or the Alarm bar to deactivate alarms.

 n Deactivating alarms for a specific camera and event type: 
Right-click on the desired alarm image and select Deactivate As Alarm.

 n Deactivating alarms for all event types: 
Right-click on an alarm image and select Deactivate All Alarms

 List View
The search results from the Smart Data Search can be displayed either as a list or as tiles. Click on  to dis-
play the results in a list.

Event Images
In the Research view, the program displays an overview of all event images. To narrow down the number   of 
displayed event images, click on the desired event type in the command bar. All event images are shown 
with the date/time of the triggering event and an icon for the event type.
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Playing Back Event Recordings

 n The event image provides direct access to the event recording. To do so, move the mouse pointer over 

the image. Three icons appear. Click on  to start the playback.

Note
A click into the image after starting the playback opens the recording in full screen mode in the cur-
rent program window.

 n To play back the event in the Playback view, move the mouse pointer over the event image. Click on 
 to switch to the Playback view.

Loading Additional Event Images
It can happen that the number of recordings of a camera is quite large. In such a case, loading all event 
images would take very long. In order to prevent long wait times, the camera loads only a certain amount of 
images. However, you can manually load the remaining images. Click on Load more  at the end of the 

list.

Note
If the            Load more  icon at the end of the list is not present, there are no remaining event images in the 

selected category.

 Freezing Grid Layout
In Auto Grid mode, MxMC always tries to distribute the   available space as well as possible according to the 
specified grid parameters, such as the aspect ratio of the tiles (4:3, 16:9, 8:3) and the number of cameras. This 
may cause the grid layout to change when resizing the program window.
Click on  to freeze the displayed layout and to prevent the automatic layout adjustment. This means that 
the frozen grid layout will be used regardless of the window size.

 Establishing/Closing Audio Connections
By clicking on , you can establish a two-way audio connection to any camera equipped with a micro-
phone and speaker or to any door station. If you only want to hear what the camera’s audio channel is 
recording, you can activate/deactivate the microphone of the computer by right-clicking on . To close the 
audio connection, click on .

Context Help
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Search Results in Tiles
The individual search results are displayed in the Tile view as preview images. You can either directly view 
the recording for the transaction in this preview image as an instant playback or you can switch to the cam-
era’s Playback view and view it there. In addition, you can switch to this camera’s Live view directly from 
the preview image.

Switching to the Live View
To do so, move the mouse pointer over a preview image. Three icons appear. Click on  to switch to the 
Live view. 

Preview Image Playback
You can either directly view the recording for the transaction in the preview image or you can switch to the 
Playback view and view it there. To do so, move the mouse pointer over the preview image. Three icons 
appear.

 n Click on  to activate the Instant player.

Note
A click into the image after starting the playback opens the recording in full screen mode in the cur-
rent program window.

 n To see the recording directly in Playback view, click on .

Adding Recordings for Exporting
The Export bar provides a quick and easy way to add clips for exporting. The default clip length is ten 
seconds on either side of the transaction time stamp, that is, for a total of 20 seconds. 

 Connection Monitoring
If the connection to a camera is lost (due to a network failure, for example), the application can show a 
warning.  To set up this warning, select MxManagementCenter > Preferences > Monitoring (Windows: File 
> Settings > Monitoring) from the menu. Activate the Lost Connection Detection checkbox and specify 
how you want MxMC to react if the connection to a camera is lost.

Setting the Behavior When Detecting a Lost Connection
Play sound
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 1. You can choose to always play a sound when a lost connection is detected or only if the camera is in 
HiRes mode. If the camera is not in HiRes mode, you are probably accessing the camera remotely, that is, 
from a mobile network, which makes dropped connections more likely. The HiRes Only option excludes 
unnecessary warnings.

 2. Then select the desired sound.

Visual warning

 1. Specify if you want to see a visual warning in addition to the sound. As above, you can choose to always 
show a warning when a lost connection is detected or only if the camera is in HiRes mode. 

 2. Adjust the dead time for the sound and the visual warning. The application will wait for the dead time to 
pass before playing a sound or showing a warning. 

Note
You should not set the dead time too short, since this would cause many unnecessary warnings.

Checking for Dropped Connections
At any time, you can manually check the connection status of the cameras. This check is independent of the 
lost connection settings in the preferences. To see the status, click on Windows > Lost Connections in the 
menu. 

Detecting Lost Connections
Depending on your lost connection settings, the application will play a sound and show a warning or it will 
only play a sound or only show a warning if a connection is lost. If you have deactivated both the sound and 
the visual warning, the lost connections icon  appears in the header bar and shows the number of lost 
cameras. 

 n Sound: To manually stop the sound, click on  in the header bar or on Mute in the visual warning. If 

you do not manually stop the sound, it will stop automatically once all connections have been re-
established.

 n Visual warning: The warning shows the preview images of the cameras that cannot be reached. Note 
that you can temporarily ignore the visual warning. To do so, click on Ignore and select the time span 
for which no visual warning should appear when detecting lost connections.
 If you do not manually close the warning, it will disappear automatically once all connections have 
been re-established.

 n Icon in Header bar: If you have deactivated both the sound and the visual warning, only the red  

icon in the Header bar will inform you about dropped connections. Click on the icon to show the cam-
eras that cannot be reached. A warning will open, showing the corresponding preview images.

Context Help
 Connection Monitoring
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 Cameras of the Camera Group
When opening the Graphic view of a camera group for the first time, all cameras of the group are shown as 
icons at the right-hand border. You can then move the cameras to their actual position on the ground or 
floor plan, just like in reality. 
 If you have activated the Alarms option in the Camera Configuration dialog box, the corresponding camera 
icon turns red upon detecting an alarm or green if the bell rings. You can quickly check the current situation 
in the Graphic view by showing a small live image (move the mouse pointer over the icon) or by showing a 
large live image (click on the camera icon). If a second monitor is available, double-clicking on the icon will 
show the live image on that monitor.

Instructions:
Activate the edit mode to arrange the cameras. Click on   to do so. To save the changes, click on  .     

 Adding Cameras, Devices, Clips and Recordings, 

Creating Groups
Please select the desired action: Adding cameras in the local network, adding cameras manually, creating 
camera groups, importing clips and recordings, creating recording paths or adding a MxThinClient. 

Adding Cameras in the Local Network
All cameras and door stations in the local network are detected automatically.

 1. Click on  . The Installation Wizard opens and lists all cameras that were found on the local network.

 2. Select the camera you want to add (use CMD-click on a Mac or CTRL-click on Windows to select several 
cameras).

 3. Specify a user name and a password. Click on   to do so. When multiple cameras have been selected, 

all of these cameras will get this user name and password.
 4. Click on  and then on Finish. All new cameras are shown in the device bar in the Cameras section and 

you can already see the live images of the cameras.
 5. You should now complete the data for the individual cameras. Open the Camera Configuration dialog 

box for this purpose. To open the dialog box, you can either right-click onto individual cameras or you 
click on the  icon, which is shown if you position the mouse pointer over the camera name. The Cam-

era Configuration dialog opens. 
 6. Close the dialog once you have completely filled in the camera data in the Camera Configuration dia-

log. Then deactivate the edit mode of the device bar by clicking on .
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Adding Cameras Manually
Cameras outside of the local network (for example, on the Internet) need to be added manually.

 1. Click on  . The Camera Configuration dialog opens.

 2. Enter the camera access data:
Name: Enter a descriptive camera name. 
URL: IP address of the camera.
Remote URL: You can enter the corresponding external address of the camera (such as a DynDNS name) 
when adding it to access the camera from outside the local network. 
      Please note: You need to activate the Remote option for the corresponding environment in order to use 
the remote URL to connect the camera. The camera connection may be switched when the environment 
is changed.
User name, password: Enter the user name and password of the camera.

 3. Complete the network data and set up alarm notification as described in Camera Configuration.
 4. Close the dialog once you have completely filled in the data in the Camera Configuration dialog. Then 

deactivate the edit mode of the device bar by clicking on .

Creating Camera Groups
You can combine individual cameras into camera groups. For example, you can combine all cameras situated 
on the same floor in one group.  This allows checking on entire surveillance areas at one glance and – in case 
of an alarm, you are quicker to access the relevant cameras.

 1. To create a camera group, click on . The Group Configuration dialog opens.

 2. Fill in the data as described in Creating Camera Groups.
 3. Close the dialog once you have completely filled in the data in the Group Configuration dialog. Then 

deactivate the edit mode of the device bar by clicking on .

Adding Clips and Recordings

Adding Clips
You can use MxMC to play back exported MxPEG clips. Click on   to do so. The Load Clips dialog opens: 
Select the desired MXG file and click on Open. The clip appears in the device bar in the Clips & Recordings 
section. 

The  icon indicates that a clip file cannot be located anymore.

Adding recordings
You can directly access recordings that are saved on a file server, even if the respective camera is not integ-
rated in MxMC. Click on  to import a recordings folder. Select the desired folder and click on Open. The 
sequences will appear in the Device bar in the Clips & Recordings section. 

Context Help
Adding Cameras, Devices, Clips and Recordings, Creating Groups
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Creating Groups for Clips and Recordings
Clips and recordings can be compiled into groups and subgroups to better organize the clips and recordings. 
Click on  to create a group. A new group will be added. By default, this group will be called “New Group.” 
Click on the selected new entry and enter the desired name. Drag and drop the desired clips and recordings 
onto the group.

The  icon indicates that there are no clips or recordings in the group.

Adding a MxThinClient and Activating Live Images
You can now also integrate one or more MxThinClients in MxMC. For example, you can an additional display 
unit (monitor or TV) by double-clicking on the camera live images of P3 and Mx6 cameras from MxMC. 

Adding a MxThinClient

 1. The MxMessageSystem needs to be activated in the settings and you need to make sure that the Broad-
cast port and Password fields contain the same settings as you configured in the MxThinClient because 
the camera live images are switched on with MxMessageSystem (Mac: MxManagementCenter > Set-
tings > MxMessageSystem; Windows: File > Settings > MxMessageSystem).
      You also need to make sure that the MxThinClient and the computer running MxMC are synchronized via 
the same time server.

 2. Click on  to add a MxThinClient. The MxThinClient Configuration dialog box opens. Complete the 

entries as described under Entering MxThinClient Settings.
 3. Close the dialog box once you have completely filled in the data in the MxThinClient Configuration dia-

log box. Then deactivate the edit mode of the device bar by clicking on .

Activating Camera Live Images
There are two options for activating a camera live image on an additional display unit:

 n Double-click: Double-click on the desired camera live image.
The images are displayed directly on the display unit connected to the MxThinClient if there are not 
any other monitors connected to the MxMC computer and the MxMC is only connected to one MxTh-
inClient.
If there are more than one monitors connected to the MxMC computer or several MxThinClients con-
nected with MxMC, you are prompted to select the desired display unit for displaying the images.

 n By drag and drop: Drag and drop the desired camera live image from the Camera bar or from the 
Device bar onto the desired MxThinClient in the Device bar.

Note
The MxThinClient section is only visible in the Device bar if a MxThinClient has been integrated. 
You need to possess administrator rights to add, manage or delete a MxThinClient.
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 Playback Speed
Use the Playback speed  button to adjust the speed when playing back the recordings in the selected play-
back mode.

 Tile View
The search results from the Smart Data-Search can be displayed either as a grid or as a list. Click on  to dis-
play the results as tiles.

       Time Events
You can limit the display of event images so that only time events are displayed. These   events include:

 n  Periodic Event

 n  Random Event

 n  Time Task

Right-click on  and select the desired event types.

 Edit Mode
To change the Graphic, Grid, and Info views, click on  in the corresponding view. To save the changes, 
click on .     

 Bell Settings
New bell events will increase the counter on the icon. Click on the icon to show these events. Click again on 
the icon to open the Playback view and to display the most recently viewed bell event. To edit the settings, 
open the shortcut menu by right-clicking .

Context Help
Playback Speed
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Note
You can set the bell sound and its volume in Notifications (Mac menu MxManagementCenter > Prefer-
ences, Windows menu File > Preferences).

Possibilities of Doorbell Notification
You can have the doorbell ring at various places in MxMC:

 n Alarm bar: The Alarm bar turns green.

 n Alarm info bar: The Alarm info bar in the   live images turns green.

 n Doorbell message: A blue dialog box appears with the live image of the door camera. You   can start a 
conversation and open the door directly.

 n Counter on the bell icon: The red counter on the bell icon  increases by one. 

You can configure the following options for notifications in MxMC:

Notifications Setting options

Completely off Deactivate the Bell checkbox in the Bell Settings to switch off the bell completely. 
(see  Turn Off Bell Completely, p. 315)

Doorbell message, 
 Alarm bar, 
 Alarm Info bar 
and 
 Counter on the 
bell icon

You need to configure the Alarm notification for the doorbell to ring at these places.                  

 1. To do so, open the Camera Configuration dialog box by right-clicking on the cor-
responding camera in the Camera bar.
 Another option is to open the dialog box in the Device bar by clicking  and then 

right-clicking the corresponding camera.
 2. Click Alarms and activate the Alarm notification and the doorbell ringing.
                   See also: Setting Up and Changing Alarm Notification

Counter on the 
bell icon only

Deactivate doorbell ringing in the Alarms dialog box and only the counter on the bell 
icon will increase by one each time.             

 1. To do so, open the Camera Configuration dialog box by right-clicking on the cor-
responding camera in the Camera bar.
 Another option is to open the dialog box in the Device bar by clicking  and then 

right-clicking the corresponding camera.
 2. Click Alarms and deactivate doorbell ringing.

Bell sound on or 
off

You can turn the bell sound on/off in Notifications (Mac menu MxManagementCenter > 
Preferences, Windows menu File > Preferences).

Note
You need to make sure that Alarm notifications are activated and a bell profile has been set up in order for 
doorbell notification to work. 
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Turn Off Bell Completely
Deactivate the Bell checkbox if you want to switch the bell off completely. It means that a doorbell ringing 
will not be indicated at other remote stations and the counter for the doorbell will not increase. In this case, 
you will not be informed if you missed any visitors, they cannot leave a message and the camera will not 
store any recordings. 

Selecting a Bell Profile
You can now also select the bell profile in the Bell Settings. This specifies how MxManagementCenter reacts 
when the doorbell rings. The camera provides several predefined bell profiles. You can also create your own 
bell profiles. Use the Configuration view for this purpose. 

 n No ringing: MxManagementCenter and all other remote stations will not react, meaning that you will 
not notice if someone is ringing (neither visually nor by sound).

 n Ring and message: You will hear if someone rings the doorbell. If you do not react within a given 
period of time, the Door Station plays back an announcement and the visitor can leave a message.

 n Message only: After ringing, the Door Station immediately plays back an announcement and the vis-
itor can leave a message.

Click Profile and select the desired profile.

 Camera Configuration
After you have added the cameras, you should enter the remaining camera data. Even when the system is up 
an running, you may have to make some changes. Open the Camera Configuration dialog to enter and edit 
the camera data.

Entering and Editing Camera Access Data

 1. Name: The camera name is displayed automatically. If required, you can enter an individual name for 
each camera.

 2. Connection Protocol: To enable MxMC to establish a connection to the camera, the appropriate con-
nection protocol must be selected depending on the available interface of the camera manufacturer. If 
you have integrated the camera with the Welcome Wizard, the corresponding protocol is automatically 
selected. When manually adding the camera, select the appropriate protocol.

 3. URL: The IP address is either discovered automatically via Bonjour or it has been entered manually.

Context Help
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 4. Remote URL: You can enter the corresponding external address of the camera (such as a DynDNS name) 
when adding it to access the camera from outside the local network. 
      Please note: You need to activate the Remote option for the corresponding environment in order to use 
the remote URL to connect the camera. The camera connection may be switched when the environment 
is changed.

 5. User name, password: Access data that had been entered when adding the camera.

Entering and Editing Network Data

 1. Environment: Shows the current network environment. After starting the program for the first time, it 
shows the standard environment. All existing network environments are shown in the blue bar. Click on 
the environment you want to use. Next, enter the network settings you want to use for this environment.

 2. Background alarms: An activated option means that the application maintains an active event stream 
connection to the camera, regardless of whether or not MxMC is showing the live stream. Using the event 
stream connection, the cameras will send event information to MxMC, which will show them as alarms 
depending on the settings (see Setting up and Changing Alarm Notification). You can deactivate this 
option if a permanent event stream connection is not required or even unwanted (due to high system 
loads on systems with very many cameras or when using MxMC in low-bandwidth networks, for 
example).   
      If this option has been deactivated, the application will only open an event stream connection if neces-
sary, such as when MxMC shows the live stream of the camera or recordings via the camera.  In this case, 
alarms will only show for this camera, while the connection has been established. This option is deac-
tivated by factory default.       

Note: This option is not supported by MOBOTIX MOVE cameras and third-party cameras that provide an 
ONVIF S compatible interface. For an overview of the camera function differences, see Cameras Function 
Overview.

 3. Remote: When adding the camera in the local network, you do not change this setting. Only activate this 
option if you want to access the camera from a remote location (via DynDNS).

 4. SSL: By default, the connection between MxMC and the camera is not encrypted. If you rather want to 
use an encrypted connection, activate this option. Note that HTTPS needs to be activated on the camera 
(in the browser in Admin Menu > Network Configuration > Web Server > HTTPS Settings).

 5. Bandwidth: Depending on the bandwidth of the current camera connection, you can choose to see the 
images in HiRes, in LoRes.

Determining Recording Settings
Stored recordings can be accessed in different ways depending on the connection protocol.
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For MOBOTIX cameras:

 n Via camera (MOBOTIX cameras): The camera is handling access to the recordings.

 n Via recording path: The camera is handling access to the recordings via a previously defined record-
ing path. Recording paths can be defined in the program settings (Mac: 
MxManagementCenter > Settings > Recording Paths; Windows: File > Settings > Recording 
Paths).

 n Via a local directory: Local path (recordings are accessed on the local computer).

For MOBOTIX MOVE / ONVIF cameras:

 n Via MOBOTIX NAS: Access to recordings via a previously defined MOBOTIX NAS. You can specify the 
access data in the application settings (Mac: MxManagementCenter > Settings > Recording Paths; 
Windows: File > Settings > Recording Paths).

Click on Recording settings to adjust the settings to your needs. This opens another dialog box.

 1. Choose the desired recording path:
Access via the camera:
    No further settings are necessary. 
Access via recording path:     

 n Select the corresponding recording path and set the corresponding recording format: 
        Use MxFFS if the recordings have been stored in an MxFFS archive. 
        Use MxFileServer if the recordings have been stored in the classic MOBOTIX folder/file structure. 

 n MxMC searches for the corresponding recordings in the subdirectories of the predefined file server 
path. Once the search has been completed, you can select the folder for this camera in the Device Dir-
ectory selection box.

Access via local directory:     
 n Select the Local path option and set the corresponding recording format:

 n Enter the file path in the Local path text box. 

Note
 Click on the pen icon in the text field to open a file selection dialog.

Access via MOBOTIX NAS:     
 n Select the appropriate MOBOTIX NAS and then select the appropriate device directory based on the IP 

addresses displayed.

 2. Close the dialog box. The settings will be automatically saved when you close the dialog box.

Context Help
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Setting up and Changing Alarm Notification
This section allows selecting the event types that will lead to an alarm if the corresponding event is 
triggered. An alarm will be indicated at the following locations:

 n Alarm bar: Turns red or green (door bell), the alarm images are shown in the Alarm bar.

 n Alarm info bar: Turns red or green (door bell) in the live images.

 n Alarm messaging: In addition, you can set up visual and sound notifications for alerting.

Click on Alarms to adjust the settings to your needs. The Alarm Events dialog opens.  

 1. Make sure that the Alarm notification option has been activated.
 2. Select the event types that should create an alarm.
 3. In addition, you can select a weekly profile for every event type that should trigger an alarm. As long as 

no other weekly profile has been selected, the setting is valid from Monday 00:00 to Sunday 24:00.
 n Click on Edit weekly profiles to create new weekly profiles. The Weekly Profiles dialog opens. 

Several predefined profiles are available, such as the Weekend profile (Saturday 00:00 to Sunday 
24:00). 

 n To add a profile, click on  . Enter a description. Highlight the desired active times in the table. You 

can resize an active time block by clicking on the time block and then moving the borders accord-
ingly It is also possible to move a block. Click on the block to select it, then drag the block to the new 

position. To delete a time block, select one first and then click on  .

 n You can change the description of an existing profile. Right-click on the name and overwrite it.

 4. To select a weekly profile, click on the Weekly Profile dropdown list next to the event type and select 
the desired profile.

 5. Click on the calendar icon to easily invert the settings of the weekly profile. For example, if you have cre-
ated a profile with opening hours and would like to activate the alarms for the closing times, click on the 
Invert weekly profile checkbox and the profile is used in inverted fashion.

 Post Video Motion Detection
This is where all functions in MxMC are listed that have been added as plug ins. Post video motion detection 
(Post VM) has already been added as a plugin. The post video motion detection allows searching recordings 
for changes in one or more image areas of a camera. This is done with the help of “motion windows.” 

Creating Motion Windows
 1. Open the context menu of the plug in by right-clicking on . Select Post Video Motion detection. The dia-

log for setting up the post VM settings opens.

 2. Click on  in the image area on the right-hand side of the settings dialog. A new window with a predefined 

video motion window opens.
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 3. You can execute the following commands: 

 n Modify the size of the video motion window: By moving the sides or the corners of the window. 

 n Create additional video motion windows: Draw a new window with the mouse. 

 n Duplicate a video motion window: Click on .

 n Delete a video motion window: Click on .

 n Deactivate a video motion window: Click on .

To close the editor window, click on  in the top right corner of the window. 

Setting Trigger Conditions
The Post VM windows allows setting different parameters that influence the detection results:

 n Trigger level: (White bar in diagram)
Controls the trigger threshold of the video motion windows. Move the bar to the bottom to recognize 
a movement if only a few pixels change from one image to the next. Move the bar to the top to recog-
nize a movement only if many pixels change.

 n Sensitivity:

 This setting controls how large the change of each pixel in a video motion window must be to count 
as movement. Together with a low threshold value, this setting can be used to fine-tune video motion 
detection. If you move the slider to the right, the detection's sensitivity increases, i.e., even smaller 
changes will trigger the detection.

 n Correct Changes in Illumination:

 Activate this option to avoid false alarms, such as when lighting conditions change rapidly (for 
example, from sun to a cloudy sky).

 n Deadtime:

 This sets the amount of time after the last detected post video motion event, during which pixel 
changes in a video motion window are ignored.

 n Median Value:

 Enter a long duration (2.0 sec., for example) to improve the detection of slow movements.  
Note: Setting a value that is too high can lead to smears in the preview window.

 n  Color Filter:

 Select a color to limit the motion detection to a specific range or colors. The Post VM event will trig-
ger if this color changes during post video motion detection.

Searching for Changes in Video Motion Windows
Once you have defined the video motion windows and have set the trigger conditions, you can search the   
recordings for changes in the video motion windows. Use the playback buttons in the command bar at the 
bottom.
It is best to use the Backward/Forward playback  buttons when searching continuous recordings. For 
searching in event images, use the Previous/Next image  buttons. If MxMC detects a change within a 
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video motion window, the frame of that window turns red and the search stops. 

Device Bar
The device bar has a tree structure and provides for quick navigation of camera groups, cameras, devices   and 
clips by opening/closing the branches. The tree structure makes it easy to manage camera groups and their 
associated cameras thanks to the sorting options. At the same time, you can use the Device bar to create 
camera groups, as well as add and edit cameras, clips and devices (a MxThinClient, for example).
Note: Note that you need administrative rights for most of the functions of the device bar. This is why   the 
command bar  with the buttons for deleting, adding and the edit mode at the bottom of the 
device bar is only available to users with administrative rights.     

Adding Cameras and Devices, Creating Groups,  Importing Clips and 
Recordings
Activate the Edit mode if you want to add cameras and devices (a MxThinClient, for example), create groups   
(for cameras and clips) or import clips and recordings. To do so, click on   and then on  at the bottom of 
the device bar. The Add and Import dialog opens. 

Note
If you have administrative privileges, you can drag an MxPEG clip into the Clips section   of the device bar to 
import it.

Adding Cameras to a Camera Group
After you have added cameras and created camera groups, you now need to assign cameras to the proper 
groups.

 1. Activate the edit mode by clicking on  .

 2. Simply drag the desired camera (use CMD + click on a Mac, Ctrl + click on   a Windows computer to 
select multiple items) from the Cameras section to the desired group in the Camera Group section.
Note: If you have assigned a camera to one group, you can copy this assignment to other groups by drag-
ging the assignment from the first group to other groups.

 3. Once you have assigned the cameras to the desired groups, you can deactivate the edit mode by clicking 
on . 

Setting Group Functions
You can define group functions in the Grid and the Graphic views. For example, you can switch the lights   of 
several cameras at once, make an announcement via several speakers or open a door without having to   
select a specific camera.
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 1. To define the group functions, activate the edit mode by clicking on .
 2. To do so, move the mouse pointer over the group name. Three icons appear. Click on  .

 3. The Group Functions dialog opens.
 4. Once you have defined all group functions, you can deactivate the edit mode by clicking on .

Changing the Data of Many Cameras
The Multi-Camera Configuration dialog allows changing authentication data used by MxMC and the   envir-
onment settings of many cameras in one step.

 1. Activate the edit mode by clicking on .

 2. Select the cameras as needed.
 Mac: CMD + click, Windows: CTRL + click

 3. Right-click on one of the selected cameras. The Multi-Camera Configuration dialog opens.

Deleting Cameras, Removing Cameras from Groups, Deleting Groups
Note: Use CMD + click on a Mac or CTRL + click on Windows to select  several cameras or groups. 

Deleting Cameras

 1. Activate the edit mode by clicking on .

 2. Drag the camera from the Cameras section to .

 3. Once you have deleted the cameras, you can deactivate the edit mode by clicking on .

Note
Deleting a camera from the Cameras section will also delete the group assignments of   that camera.

Removing Cameras from Groups

 1. Activate the edit mode by clicking on .

 2. Drag the camera from the Camera Groups section to .

 3. Once you have deleted the cameras from the groups, you can deactivate the edit mode by clicking on 

.

Deleting Groups

 1. Activate the edit mode by clicking on .

 2. Drag a group from the corresponding section to .

 3. Next, activate the edit mode by clicking on .
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Working With the Device Bar
The device bar supports you in many ways: not only can you use it to create camera groups, add cameras   
and clips and manage these objects. The device bar's main purpose is to give you a quick overview over all 
camera groups, cameras and projects. By opening/closing the branches, you can simply navigate the camera 
groups and the corresponding cameras. The sorting options help in managing these objects.

Opening/Closing Sections
Click on  to   close a section, click on  to open it again.

Moving Sections
If you move the mouse over the upper part of the section, the  icon appears and the mouse pointer 
changes to   the Move cursor. You can now click and drag the section up or down.

Setting Display Options
You can select how the cameras are listed, i.e., by camera name, IP address, factory IP address or   reference 
image. Note that you can set different display options for the Cameras and Camera Groups sections. For 
clips, you can choose to list the clips by name or by path.
 Click on  and select the desired display option.

Sorting the Cameras
The Cameras section allows sorting the list. Click on  and select the desired sorting mode. 

Overview of the Different Camera Statuses
An icon next to the camera name or the camera IP address will indicate the current status of the   camera:

 n  Camera is not reachable.

 n  Wrong camera password

 n  Privacy mode is active

 n  Limited functionality (only live image access) due to old firmware (<4.0), old camera model 

(M/D/V12, M/D/Q22M) or proxy issue.

 n  Camera user does not possess permissions for Event Stream connection or admin permissions
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Selecting Favorites from Cameras and Groups
You can filter the displayed cameras in the Camera bar and the groups in the Group or camera bar using dif-
ferent filter criteria (by favorites, for example). Before   you can use favorites, however, you need to label the 
desired cameras and groups in the device bar as favorites.
 Activate the Edit mode by clicking on . Move the mouse pointer over the camera or group name. Several 
icons are shown. Click on  . Next, deactivate the edit mode by clicking on .

Selecting Views
The device bar allows selecting a specific view for a group of cameras or one camera. Move the mouse   
pointer over the camera or group name. Different icons will appear depending on whether you have moved 
the mouse over a camera or a group name. Click on the icon of the view you want to use.
Camera views: : Live view, : Playback view, : Research view
Group views: : Grid view, : Graphic view, : Grid Playback, : further views (Research view, Info view)

Editing Names
Using the device bar, you can quickly modify the names of cameras and groups. Activate the edit mode by   
clicking on .   Click on the camera or group name you want to change – it will turn yellow. Click again on 
the name and   edit it as needed. Deactivate the edit mode by clicking on .
 

 Live Recorder
The Live recorder is available in the Live view and the Grid view. Click on  to record directly from the dis-
played camera live images and save as *MXG files. In the Grid view, the camera’s live image that is in the 
focus window is always recorded. For this reason, live recording can also only be used in the Grid view when 
there is a focus window.
  Users with administrator rights can determine where the clips are saved and how long the recordings can be 
in Settings (Mac menu: MxManagementCenter > Preferences > Live Recorder, Windows menu: File > Set-
tings > Live Recorder).

Note:
Audio can only be recorded with the Live Recorder under these conditions:

 n Audio transmission must be activated on the camera side.

 n In the Live View of the MxManagementCenter, the audio connection must be activated by clicking on 
.
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Starting and Stopping Recording
To start recording, click on . To stop the recording before the set period of time has elapsed, click on  
again. A message appears shortly before the set period of time has elapsed. You can stop the recording using 
this message or extend the set period of time.
  The recording is also stopped when you switch to a different view from the Live view or the Grid view. 
However, the recording is not stopped when the camera is changed in the Live view or the group in the Grid 
view (unless this group does not have a focus window, in this case the recording is also stopped).

Play Clip
The live image data is stored in an *MXG file at the location specified in Settings during recording. The clip 
file is automatically imported into the current project when the live recording stops and the Device bar lists 
it using the  icon in the Clips section. You can click on the clip name to playback the *MXG clip file via the 
Device bar.

         Meta Events
You can limit the display of event images so that only meta events are displayed. These   events include:

 n  Event Counter

 n  Event Logical AND

 n  Event Logic

Right-click on  and select the desired event types.

 Next Image
You first set the desired mode for browsing the recordings in the Playback mode, for example, using one 
hour or all highlighted events.  Depending on this setting, this button will jump to the next image in the 
recording (starting from the current image).
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   View History
Use the two Previous view  and Next view  buttons to browse the view history. Note that the history 
will also store temporary views, such as briefly viewing the live image in the Graphic view or a temporary 
bandwidth adjustment for a specific network environment. When browsing the view history, the views will 
be shown with exactly the same settings as before.

 Image Analysis Events
You can limit the display of event images so that only image analysis events are displayed. These   events 
include:

 n  MxActivitySensor

 n  Video Motion

 n  Behavioral Detection

Right-click on  and select the desired event types.

 Camera Sequencer
If you want to see a different camera in the focus window, simply drag that camera to the focus window. 
Note that the camera sequencer can also switch cameras automatically.

Instructions:

 1. Click on the camera sequencer icon  to activate the automatic switching. 

 2. Right-click on  to change the following settings:

 n Duration Slider: Move the slider to the desired duration (1 sec to 60 sec) to show each camera.

 n Autostart: Once you switch to the Grid view, the sequencer starts automatically.

 n Stop at event: The sequencer stops when an event has occurred, allowing you to further investigate 
the situation. To start again, click on .

 n Restart after confirmation: Activate this option if you want to avoid having to restart the sequencer 
over and over again.
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Search Results in Lists
The search results are displayed in the List view in a table in which the individual transactions are entered 
with detailed information. Click on a transaction line to view the receipt data and a preview image of the 
selected transaction.

Displaying Search Results
The most recently selected search query is automatically performed when you open the Smart Data View. 
Click on the desired tab to perform a previously saved search. The search results are displayed in the table as 
individual transactions.

Displaying Transaction Data
Click on a row in the table to select a transaction. The matching receipt data of the selected transaction is 
displayed in the Transaction details section. 
Do not show system transactions
  E.g. the transactions of a cash point contain events that are directly associated with the purchase, such as 
the total or subtotal.   Some transactions also show administrative events only, such as when the cashier logs 
on or off.   The system transactions can be hidden in the table with the receipt data. To do so, click on   in 
the Title bar of the Receipt section. 

Showing Preview Images
When you click on the row in the table, you do not only receive a display of the transaction data in the 
Receipt section, you also receive a preview image that belongs to the camera recording for the transaction 
in the Preview Image.
Switch to Live view
  To do so, move the mouse pointer over the preview image. Three icons appear. Click on  to switch to the 
Live view. 
Playback recording for the transaction
  You can either directly view the recording for the transaction in the preview image or you can switch to the 
Playback view and view it there. To do so, move the mouse pointer over the preview image. Three icons 
appear.

 n Click on  to activate the Instant player. 

Hint: A click into the image after starting the playback opens the recording in full screen mode in the 
current program window.

 n To see the recording directly in Playback view, click on . 

Adding Individual Clips for Exporting
The Export bar provides a quick and easy way to create clips on individual Smart Data transaction for sub-
sequent exporting. To do so, drag the transaction preview image in the Preview Image section and drop it 
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on the Export bar. The default clip length is ten seconds on either side of the transaction time stamp, that is, 
for a total of 20 seconds.

 Image Correction: PTZ and Display 

Modes in Recordings
You can zoom and move the visible image area not only in live images but also in recorded images (PTZ). It 
enables you to examine specific image areas more closely while the recorded video stream plays back.  On 
Dual cameras, the program also shows the  slider. Use this slider to show the images of either the right, 
the left or both image sensors. When playing back the recordings of hemispheric cameras, you can set dif-
ferent display modes . 

Zooming and Moving Image Sections
You can zoom using the slider  or the mouse wheel. To see other image areas, you can move the recorded 
image using the mouse.

Choosing a Sensor 
On Dual cameras, you can opt to see the recordings of the right, the left or both image sensors. To do so, 
move the  slider to the right to  (left sensor) or further to the right to  (right sensor).

Display Modes and Panorama Correction 
When showing recorded images of hemispheric cameras or cameras with the lenses L12/B016, L23/B036, 
L25/B041, you can select different display modes. In order to get naturally-looking images, the camera will 
automatically correct the distortion in these modes. This distortion correction can be refined even further 
when using the panorama correction. Note that this type of correction only takes place locally. This means 
that the distortion correction of the recorded images only takes place on this computer. The stored record-
ings (from the camera or a file server) are not influenced in any way.       

Select the Display Mode

 n Full image: Shows the entire (distorted) full image.

 n Normal: Shows a distortion-corrected image and allows executing PTZ actions. This is the factory 

default for hemispheric cameras.

 n Panorama: Shows the distortion-corrected image of an entire room (corrected 180° panorama view) 

from the left to the right wall. The aspect ratio (width to height) is 8 to 3. 

Context Help
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 n Surround: Shows four image sections (one for each cardinal direction: N, E, S, W) in one joint view. 
Note that you can use PTZ actions to modify all four views independently from one another.

 n Double panorama: This mode shows a panorama view for the Northern half of the image and a 

second panorama view of the Southern half of the image using an aspect ratio (width to height) of 4 to 
3. This mode only makes sense for a hemispheric camera that is mounted to the ceiling.

 n Panorama focus: This display mode combines the panorama view (aspect ration 8 to 3) with two 

smaller images (each with aspect ratio 4 to 3) in one large image.

Move the slider  to the right until you see the desired view. This slider position will be stored auto-
matically until you change it again.

Panorama Correction
The distortion-corrected images of the different display modes can be further refined using the panorama cor-
rection. Move the  slider to the right to  and use the mouse to correct the image. To store the corrected 
setting, click on the  slider and hold it until the slider icon briefly appears in the center of the image.

 Mailbox Settings
If new mailbox messages are available, the counter at the icon shows the corresponding number. Click on 
the icon to show the messages. Click again on the icon to open the Playback view and to position it on the 
mailbox message you viewed the last time. In the Mailbox settings, you can activate the mailbox and select 
the announcement, among other things. To edit the settings, open the shortcut menu by right-clicking on 
.

Selecting a Voice Mailbox and a Bell
Depending on the installed options and the configuration of the door station, you may have several bell but-
tons or – in case a MOBOTIX keypad module has been installed – several contact numbers. Each of these 
bells or contact numbers has its own mailbox. The corresponding mailboxes are presented in the list (below 
the name of the bell). Select the desired voice mailbox.

Note
All settings made in the Mailbox function always apply to the selected mailbox. This also means that the 
new messages counter only applies to this mailbox. To get the messages and recordings of a different mail-
box, select that mailbox first.

 1. Click on Mailbox and select the desired bell. 
 2. Proceed by selecting one bell profile for each mailbox.
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Activating the Voice Mailbox and Selecting a Welcome Message

 1. Activate the mailbox with Active. Select the message that will be played to the visitor.
 2. Click on Welcome message. Select the desired message.

Enabling the Message
If visitors should be allowed to leave a message, activate the Leave Message option. 

 Highlight Recorded Images
When you come across events that you want to examine later, you can add markings to the corresponding 
images. The images thus marked can be shown one after the other in the Playback view or you can display 
them in the Research view and examine them more closely. 
 Click on  to highlight a recorded image.

 Image Settings
The display of the current camera can be easily adjusted to the current environment. 

 Brightness
 Contrast

Instructions:
Move the sliders upwards and downwards. The new settings are stored automatically for the current camera. 
The default values can be restored by double-clicking on the corresponding sliders.

Note
Adjusting the image settings does not have any effect on the camera settings. These will not be changed.

 Alarm Settings

New events will increase the counter at the Alarms button . Click on  to see the event that triggered 
the alert. Click again on  to open the Playback view and to position it on the event you viewed the last 

Context Help
Highlight Recorded Images

329 / 375



Context Help
Bandwidth

time.      
If the Alarms option has been activated in the Camera Configuration, the alarm and alarm info bars will 

turn red and will inform you about the events that triggered the alert.  In addition, you can 
choose to receive an alarm message and an alarm sound. To do so, activate the Alarms option in Noti-
fications (Mac: menu MxManagementCenter > Settings; Windows: menu File > Settings) and select the 
alarm sound, alarm duration and volume.     
Note that you can also activate the Privacy Mode in the alarm settings. This feature can disable and lock cer-
tain features of the camera for a specific period of time. This mode is valid for 24 hours. Note that you can 
also deactivate the mode manually before the 24 hours have passed. Click on  and select the features that 
you want to switch off. If the Privacy Mode icon  appears in the top right corner of the camera image, this 
mode has been activated.

 Bandwidth
Using MxManagementCenter, you can access cameras from different locations. To do so, you need to define 
different environments, which will store the access data for the individual cameras. By assigning a band-
width to an environment, you can specify how the images are pulled from the cameras given different con-
nection speeds. This basically controls how the images can be displayed for live viewing and event research. 
Note that you can temporarily overwrite the bandwidth setting without actually changing the setting for the 
current environment.

 n  HiRes: The images are transferred using the current camera settings.

 n  LoRes: The images provided are in CIF size and with low frame rate.

 n  Unchanged: If you have changed the bandwidth several times, you can use this setting to quickly 

revert to the camera settings for this environment.

 Control Elements of the Focus Window
This window provides the same controls as the Live view. You can thus open the doors of the camera in the 
focus window, control the lights or show the temperature.
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Focus Window
The Grid view shows the live images of all cameras of the selected camera group. You can drag the camera 
image that is most interesting to you into the focus window. Use the switching and control functions at the 
bottom to control the camera.

 Save Snapshots
You can save snapshots from live images or from recordings. The snapshot also contains the camera name 
and date/time of its creation. To set a different destination folder or quality for the snapshot images, open 
the Settings in the menu (Mac: MxManagementCenter > Preferences > Snapshot Images, Windows menu: 
File > Settings > Snapshot Images). To save a snapshot, click on .

 Projects and Network Environments
A project comprises all access data of the attached cameras in MxManagementCenter, the settings of these   
cameras and camera groups with assigned layouts, among other information. You can store such a project in 
order to install the same environment on other computers.  
 You can use MxManagementCenterto access cameras from different locations. This usually means that each 
location requires using different network access data. To avoid having to change the network access data 
every time, you can set up different network environments with the corresponding network access data.

Saving and Providing Projects
If you save a project, you can include the encrypted access data for each camera (user name and password).   
This access data is automatically used when the project is opened in MxManagementCenter. If you do not 
include the access data, the user name and password will have to be entered manually for each camera. The 
same applies to a project sent by email; you can opt to include the encrypted camera access data (user name 
and password).

Saving Projects
In the header bar, click on Projects and Environments  and then on Save as . Fill in all remaining fields 
of the dialog.
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Providing Projects via Email
Note that you need a properly configured email client for this purpose. In the header bar, click on            Projects 

and Environments  and then on Email to . The file is automatically attached to a new email.

Opening Projects

In the header bar, click on Projects and Environments  and then on Open . Decide if you want to save 
the current project   as a backup or if you want to replace the current project. Fill in all remaining fields of the 
dialog.

Opening Projects Received by Email

Store the attached file on your computer. In the header bar, click on Projects and Environments  and 
then on Open . Decide if you want to save the current project as a backup or if you want to replace the cur-
rent project. Fill in all remaining fields of the dialog.

Creating Network Environments

Creating Environments

 1. In the header bar, click on Projects and Environments  and then on Environment.

 2. Click on  . This adds an environment with the name "New Environment". You should change the name 

by clicking on  and entering a descriptive name. 

Deleting Environments
Click on  and then on  next to the environment you want to remove.

Changing Network Data and Selecting Environments
After creating the environments, you can select the cameras that will be active for each environment and 
adjust the network data as needed.

 1. In the command bar, right-click on the desired camera to open the Camera Configuration dialog box.
 2. Select the environment and bandwidth you want to use for the environment for this camera.
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Selecting Environments 

In the header bar, click on Projects and Environments  and then on Environment.

 Display Focus Window
Click on  to switch the focus window of the current group on or off.

        Message Events
You can limit the display of event images so that only message events are displayed. These   events include:

 n  IP Receive

 n  MxMessageSystem

Right-click on  and select the desired event types.

 Forward Playback

You first set the desired mode for browsing and playing back the recordings in the Playback mode . For 
example, you can play back the entire recording or just intervals of one hour between images. Use the  but-
ton to start and stop the playback. Starting with the currently displayed image of a full recording, the pro-
gram plays back all recorded sequences in regular (forward) direction. If you set the playback mode to one 
hour, the program will play back the images with one-hour intervals (time-lapse playback) in forward dir-
ection.

Camera Group
To display additional camera groups, drag them from the Group bar or the Device bar onto the current 
Graphic view. Click on the group icon to open the Grid view of the camera group. If a new alarm occurs (the 
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bar at the bottom of the group icon turns red or green), you only need one click to open the live image of the 
alerting camera as well as the live images of the other cameras of that group.

Instructions:
Activate the edit mode by clicking on . Drag the desired camera group from the Group bar or the Device 
bar onto the Graphic view.

 Environment Events
You can limit the display of event images so that only environment events are displayed. These   events 
include:      

 n  Shock Detector

 n   Illumination 

 n  Microphone

 n  Passive Infrared Detector

 n  Temperature

Right-click on        and select the desired event types.

 Creating Users or Administrators
You need administrator rights to add a new user or establish an additional administrator.
User type and user name

 1. Enter the corresponding user name. 
 2. Select the desired user type: user or administrator.

 The user type is set to User by default. The sections Weekly profiles and User rights are available for 
users, in contrast to administrators. All other settings apply to both user types and will be used in the fol-
lowing description; however, reference will only be made to User.

 3. Use the Active option to enable the new user immediately or later on.

Password

 1. Enter a password and confirm it.
 2. Use the Expires option if you want to require the user to change the password at regular intervals.
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 3. If the user is to change the original password upon the next log in, select the Force change on next log 
in option. 
Note: Activating this option automatically gives the user the "Change Password" right, even if it had 
been disabled before.

 4. The Force Complex Password option ensures that users can only set secure passwords. 
 A secure password has at least eight characters, consists of lowercase and uppercase letters, including at 
least one special character, one digit and one character. Furthermore, it cannot be one of the last thir-
teen passwords used on this user account. If you are trying to set a password that does not meet the cri-
teria, a red frame around the text field will appear.

Log in

 1. You can establish a specific setting for time ranges in a weekly profile for users who can only access 
MxMC at specific times. This section is not displayed when creating an administrator because the admin-
istrator always has all rights and access to MxMC.
 Click on Edit weekly profiles to create a weekly profile. The Weekly Profiles dialog opens. There are 
two predefined profiles available from the beginning: the Weekend profile (Saturday 00:00 to Sunday 
24:00) and the Working days profile (Monday 00:00 to Friday 24:00). 

 n To add a profile, click on  . Enter a description. Highlight the desired active times in the table. 

You can resize an active time block by clicking on the time block and then moving the borders 
accordingly It is also possible to move a block. Click on the block to select it, then drag the block 
to the new position. To delete a time block, select one first and then click on  .

 n You can change the description of an existing profile. Right-click on the name and overwrite it.

 2. Close the dialog box to finish editing the weekly profiles. You can then use the new (or modified) weekly 
profile in user management. To do so, click on the Weekly Profile box and select the desired profile.
Note: 24 hours is set by default. In this example, the user always has access to MxMC.

 3. Click on the calendar icon to easily invert the settings of the weekly profile. For example, if you have cre-
ated a profile with access on the weekend and would like to activate the alarms for working days, click 
on the Invert checkbox and the profile is used in inverted fashion.

Log out
In addition, you can specify after how many minutes of inactivity this user will be automatically logged out.

User Rights
Every user has all user rights initially. Deactivate the rights that should not be available for a specific user in 
the User Rights section.
 This section is not displayed when creating an administrator because the administrator always has all rights.
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 Access and Save the Home View
You can save any view of the program as "Home view". To load the view, simply click on . In addition, you 
can set this view as Start view that is automatically loaded when starting the program. If no Start view has 
been set, the program starts with the view that was visible when exiting the last time.

Instructions:
To set the current view as Home view, right-click on . Then click on Save as Home view. This will save 
the current view just as you have configured it. 
 If you also want to use the selected Home view as Start view, right-click on   and activate the Start view 
option. 

 Select View
Use the Navigation button to select a specific view for a group or a camera. Right-click on the Navigation but-
ton. Then click on the arrow to the right of the view and select the desired group or camera. 

 Searching Recordings for a Specific Point in 

Time
You can use this slider in the Playback view to search for events at a specific point in time. 

Instructions:
Click on  . The date and time will be shown above the slider. Move the slider until you reach the date and 
time that is closest to the point in time you want to examine. Once you release the slider, the event image 
jumps to the event in the recordings that is closest to the specified date and time. 

Note
The farther away you move the mouse pointer from the slider, the more precisely you can adjust the slider. 
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        Signal Events
You can limit the display of event images so that only signal events are displayed. These   events include:

 n  Signal Input

 n  User Click

Right-click on  and select the desired event types.

   Setting the Playback Mode
In the Playback view, you can search for recordings and play them back. This is done using the  
buttons and the playback mode. You first set the desired mode for browsing the recordings, such as event 
images only or with one hour time-lapse, in the Playback mode. Next, use the playback buttons to browse 
and play back the images one-by-one   or continuously  in backward or forward direction.

Playback Mode Playback Buttons

Complete 
Recordings 

Jumps one image backward/forward.

Plays back all recordings backward/forward. 

Event Record-
ing 

Jumps to the end/the start of the recorded 
sequence.

Plays back until the start/the end of the recorded 
sequence has been reached.

Event Images Shows the previous/next image every time you click 
on the button.

Pre-alarm 
Images 

Marked 
Images 

The previous/next images are shown automatically 
one after the other. 

1 day time 
lapse 

1 hour time 
lapse 
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Playback Mode Playback Buttons

10 minute 
time lapse 

1-minute
 time lapses           

   Controls of a Camera Group
You can use the group buttons to control the functions of a camera group (provided that group functions 
were defined in the Group functions dialog box). A group function enables you to switch on/off lights, open a 
door and make an announcement for a predefined camera of this group, regardless of the currently displayed 
camera. You can also assign the functions for switching on/off lights and opening doors to several cameras of 
this group, enabling you to switch on/off several lights or open several doors. 
 In addition, you can right-click on the group buttons to open the corresponding shortcut menu and even 
control cameras that are not part of the current group. Before you can do this, the cameras have to be set up 
accordingly, that is, they need to be connected to door openers/light contacts and have to be configured 
properly. 

 Backward Playback
In Playback mode , you first set the desired mode for browsing and playing back the recordings. For 
example, you can play back the entire recording or just intervals of one hour between images. Use the  but-
ton to start and stop the playback. Starting with the currently displayed image of a full recording, the pro-
gram plays all recorded sequences in backward direction. If you set the playback mode to one hour, the 
program will play back the images with one-hour intervals (time-lapse playback), starting from the current 
image.

 Open Doors 
If a camera is connected to a door opener and has been configured accordingly, you can open the door in   the 
Live view by clicking on . If the door opener is connected to the proper door accessories, the door icon in 
the status display indicates when the door has been opened and when it has been shut again.
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Opening Doors of Other Cameras
Right-click on . All cameras connected to a door station are listed in the context menu, including the door 
status. To open a door, click on the door camera. 

Viewing the Clip of the Last Opening
From the Live view, you can jump directly to the clip of the last time the door opened and play the clip 
without having to search for it in the Playback view.

Right-click on  and then on Last Opened . The view switches to the Playback view. 

  Audio Functions of a Camera Group
If you have defined audio functions for a camera from a group in the Group functions dialog box, you can 
control these audio functions using these two buttons.

Creating Camera Groups
To show the camera groups, you can use the Grid view (cameras are grouped according to various criteria   on 
a grid) and the Graphic view (realistic arrangement of the cameras on a graphical background). You are   set-
ting the grid layout for showing the cameras in the Grid view when creating camera groups. Likewise, you   
can select a background image (for example, ground/floor plan) on which you will be showing the cameras in   
Graphic view. In addition, you can assign a picture or icon to a group for easier identification.
Note: If you have created a group and have not added any cameras yet, the application will show the icon 

.

Instructions:

 1. Enter a group name and – if desired – add an image or an icon that will be used to represent the group   in 
the group bar later on. To do so, click on the gray field and select one of the predefined icons. If   you 
want to use one of your own images, click on Custom.

 2. Add a background image: Move the slider  to the right until you reach   the  position.   Click on the 

arrow in the gray field and select the file with the background image (for example, ground or floor plan).
 3. You can add an information page to a camera group in order to show special instructions for this   cam-

era group, for example.  Move the slider  to the right until you reach the  position.   Click on the 

arrow in the gray field and select the file you want to use.

Context Help
Audio Functions of a Camera Group
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 4. Grid Tiles Bandwidth Limits: If a very large number of cameras are displayed in the Grid View,   this can 
lead to an impairment of the performance. To avoid this, you can limit the frame rate and   image size of 
the live images of the tiles here. This limitation has no effect on the camera displayed   in the focus win-
dow.
Use ONVIF LoRes Profile: Use this checkbox to limit the frame rate for third-party cameras that   provide 
an ONVIF S compatible interface and MOBOTIX MOVE cameras. If this checkbox is checked, the   settings 
for the live images in the tiles that were captured in the Bandwidth Settings as   LoRes profile for these 
cameras are used.

 Notification
The Alarm bar and the Alarm Info bar will notify you if new alarms occurred. In addition, you can add visual 
and sound notifications for ringing and alarm messages (Live view > Command bar > Alarm settings > Noti-
fication). You can temporarily deactivate the alarm messaging and/or the alarm sound, for example, if you do 
not want to be disturbed during a meeting.  Note that by deactivating messaging, you will deactivate all noti-
fications at once. Enabling messaging again activates all notifications.

 n  Notification on: Signaling in case of ringing and alarm messages

 n  Notification off: No signaling in case of ringing and alarm messages

 Exporting Recordings
Using the Playback view, you can export recorded video data from one camera, while the Grid Playback   
allows exporting from several cameras at once. Use the Export bar to combine several clips to one export.

Exporting from the Playback View

 1. Drag the desired camera from the Camera bar or the Device bar.
 2. Find the start of the relevant recording.
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 3. Specify the export range. There are two possibilities for this export: 
 n Select export range using visual markers:

 Mark the start of the clip by clicking on the gray flag on the left . Play back the recording until 

you have reached the end of the clip you want to export. Mark the end of the clip by clicking on 
the gray flag on the right. Click on Export  and select the export profile. The Export dialog box 

appears. Select a target folder and enter a file name.

 n Manually capture export range:
 Click on Export  and select the export profile. The dialog box used for defining the export range 

appears. Specify the export range. Click on OK and then on Save.

Exporting From the Grid Playback
The Grid Playback allows setting a time range on several cameras for a recording (event or continuous record-
ing) and to select it for exporting.

 1. Drag the desired camera group from the Group bar or the Device bar.
 2. Find the start of the relevant recording for the camera in the focus window.

 At the same, the search is extended to the other cameras in the group, and the recordings with the 
closest relevance to those in the focus window recording will be displayed in the tiles. 

 3. Specify the export range. There are two possibilities for this export:

Select export range using visual markers:

 1. Mark the start of the clip by clicking on the gray flag on the left . Play back the recording until you 

have reached the end of the clip you want to export. Mark the end of the clip by clicking on the gray flag 
on the right.

 2. Instead of exporting all cameras of this group, you can also select one or more cameras for exporting. To 
do so, right-click on Export . A circle appears on the camera images in the top left corner. To do so, 

select the desired cameras by clicking on the corresponding circles.
 3. Click on Export  and select the export profile. The Export dialog box appears. Select a target folder 

and enter a file name.

Manually capture export range:

 1. Before you determine the export range, you can limit the selection if you do not want to export all of 
the recordings that appear in the tiles. To do so, right-click on Export . A circle appears on the tiles in 

the top left corner. To do so, select the desired cameras by clicking on the corresponding circles.
 2. Click on Export  and select the export profile. The dialog box used for defining the export range 

appears. Specify the export range. Click on OK and then on Save.

Context Help
Exporting Recordings
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Alarm Info Bar

Alarm Info Bar
Events that lead to an alarm are also shown on the Alarm Info bar. This is done only if the Alarms option has 
been activated in the Camera Configuration dialog box for the individual cameras and if the corresponding 
event types have been activated. The bar beneath the corresponding live image turns red or green (door bell) 

if the camera detects an event. Move the mouse over the image to show the slider . Move the slider to the 
left. This opens Instant Playback and shows the last alarm image.

 
Drag the red counter ①  along the bar to show the preceding alarm images; the number in the counter 
increases as you move the slider. Click on Playback ②  to see the recording for the corresponding event 
image.
Note that the Alarm Info bar in the Live view works differently. When moving the mouse over the lower frame 
border of the live image, the Alarm Info bar appears. When moving the mouse to the left on the Alarm Info 
bar, a still image of the corresponding alarm shows and the counter near the still image increases by one.

 Image Correction: PTZ and Display 

Modes
To better identify objects in an image section, you can zoom the live image and move the resulting image 
area around (PTZ). This depends on the image settings (Panorama or Full Image, for example) of the camera 
images.  To quickly load these image sections, several image positions are already pre-configured, which can 
be loaded by using the  slider. 
The program also shows the  slider on Dual cameras. Use this slider to show the live images of either the 
right, the left or both image sensors.
When showing the live images of hemispheric cameras, you can set different display modes .

Zooming and Moving Image Sections
You can zoom using the slider  or the mouse wheel. Zooming with the slider takes place only on the com-
puter. This means that only the image section of the current live image is modified. 
 To see other image sections, you can move the live image using the mouse.
If you want to execute the PTZ actions on the camera, you can also switch to camera PTZ. In this case, the 
PTZ actions are applied to the camera's live image and also influence the recordings (but only if the camera 
does not record the full image). To use this feature, click on the  slider and keep it pressed until it starts 

342 / 375



flashing. You can now adjust the zoom level as needed. To store the setting, click again on the slider and 
keep it pressed until the slider stops flashing.

Selecting and Adjusting Image Sections

Selecting Image Sections
To quickly focus on a specific image section, you can use one of the factory default image positions that are 
predefined in the camera. 

 n Preview , detail , overview  and point of interest

 n Top , bottom , left , right

The camera will then move to the selected position. Note that the PTZ actions are executed on the camera 
and also influence the recordings (only if the camera does not record the full image).   Move the  slider to 
the next position or until you have found a suitable position.

Adjusting Image Sections
You can adjust the predefined image positions of the factory default. Select a position and modify it as 
needed. Keep the slider on this position until it flashes once. The new image section has been stored. 

Choosing a Sensor 
If you want to show the live images of only the right or the left image sensor, you can move the  slider to 
the right to  (left sensor) or further to the right to  (right sensor). 

Display Modes and Panorama Correction
When showing the live images of hemispheric cameras or cameras with the lenses L12/B016, L23/B036, 
L25/B041, you can select different display modes. Note that the OpenGL option in the settings (Mac menu 
MxManagementCenter > Preferences > General, Windows menu File > Settings > General) needs to be 
activated for this purpose. In order to get naturally-looking images, the camera will automatically correct the 
distortion in these modes. This distortion correction can be refined even further when using the panorama 
correction. The selection of a display mode is always done locally and thus does not influence the camera 
settings. However, the selection is also applied to the other program views. When selecting a display mode 
in the live view for a specific camera, this mode is also applied if the camera shows up in the focus window 
of the Grid view as well as in the live images of the Graphic view. Consequently, the alarm images in the 
Alarm bar and in the Research view are also shown in the selected display mode.

Select the Display Mode

 n Full image: Shows the entire (distorted) full image.

 n Normal: Shows a distortion-corrected image and allows executing PTZ actions. This is the factory 

default for hemispheric cameras.

Context Help
Image Correction: PTZ and Display Modes
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Context Help
Adjust the Volume

 n Panorama: Shows the entire distortion-corrected image (corrected 180° panorama) from the left to 
the right border. The aspect ratio (width to height) is 8 to 3. 

 n Surround: Shows four image sections (one for each cardinal direction: N, E, S, W) in one joint view. 

Note that you can use PTZ actions to modify all four views independently from one another.

 n Double panorama: This mode shows a panorama view for the Northern half of the image and a 

second panorama view of the Southern half of the image using an aspect ratio (width to height) of 4 to 
3. This mode makes sense for a hemispheric camera that is mounted to the ceiling.

 n Panorama focus: This display mode combines the panorama view (aspect ration 8 to 3) with two 

smaller images (each with aspect ratio 4 to 3) in one large image.

To select a mode, move the slider  to the right until you reach the desired position. This slider position 
will be stored automatically until you change it again.

Panorama Correction
The distortion-corrected images of the different display modes can be further refined. For example, if the 
image in Panorama mode is not centered, you may see a trapezoidal distortion.  The panorama correction 
allows adjusting the skewed (vertical) lines of the image to produce a more naturally-looking image. To do 
so, move the  slider to the right to  and use the mouse to correct the image. To store the corrected set-
ting, click on the  slider and hold it until the slider icon briefly appears in the center of the image.

 Adjust the Volume
You can adjust the audio volume of the displayed camera to the current environment.

Instructions:
Move the Volume slider . The new setting is stored automatically for the displayed camera. To restore the 
default value, simply double-click on the slider.

Camera Live Images
If you want to display individual camera live images, drag them from the Camera bar or the   Device bar onto 
the current Graphic view. You can place live images either temporarily or   permanently. Temporarily means 
that these live images will be removed if you open a different   view.
 You can use the switching on/off and control functions at the bottom of the live   image, similar to in the 
focus window of the Grid view:
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 n PTZ and Display Modes

 n Establishing/Closing Audio Connections

 n Controls

 n Alarm Info Bar

Note
 If the live image was corrected for distortion in the tile afterward, this is also   adopted when playing an 
instant playback for the configured image mode.

Instruction:
Temporary placing: Drag the desired camera from the Camera bar or the Device bar onto the   Graphic view.
Permanent placing: Activate the Edit mode by clicking . Drag the desired camera from the Camera bar   or 
the Device bar onto the Graphic view. Close the Edit mode by clicking .

Recording Date/Time
This field contains the date and time of the currently displayed image. At the same time, you can use this 
field to search the recordings for a specific date and time. Enter the date and time you are looking for and 
press the Return key to start the search. The image jumps to the event in the recordings that is closest to the 
specified date and time.

Note
that you can move the date box to a different location. To do so, grab the red storage card icon and move 
it to the desired position.

 Temperature Display
MOBOTIX cameras have a built-in temperature sensor that measures the temperature inside the housing. If 
an ExtIO module or an MX-GPS-Box is connected to the camera, you can also show the ambient temperature 

measured by the module or the box. Click on    to display the temperature profile of the current camera.

Display the Current Temperatures of All Cameras
Right-click on Temperature . The context menu shows all attached cameras with their current internal 
temperatures and, if available, with the ambient temperatures of connected modules/boxes. In addition, you 
can display the temperature profile of each listed camera. To do so, click on the desired camera.

Context Help
Recording Date/Time
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Change the Temperature Unit
The default temperature unit is Celsius. To change the unit, right-click on Temperature  and then on Set 
Up.

 Group Sequencer
If you want to display a different camera group in the focus window, drag and drop that camera group into 
the focus window. A grid with all cameras of the group will be displayed and each camera of the group will 
be shown sequentially in the grids focus window for a defined time. You can automate this camera group 
change with the group sequencer.

Instructions:

 1. Click on the group sequencer icon  to activate the group sequencer.

 2. To change the sequencer settings right-click on :

 n Duration: set the duration to show each group. You can set a value between 1 sec and 60.  The “Com-
bined Sequencer”  activates the group sequencer together with the camera sequencer (“Autostart” on 
the camera sequencer is not needed). The group sequencer waits until all cameras on a grid or graphic 
have been cycled before switching to the next group. When the “Combined Sequencer” is active then 
the camera sequencers “Stop at Event” and “Restart after Confirmation” also apply to the group 
sequencer.

 n Autostart: Once you switch to the Grid view, the group sequencer will start automatically.

   Zoom and Change the Views of Event 

Images
To better identify objects in an image section, you can zoom the event images. If you have set reference 
images (one overview and one detail) when adding the cameras, you can display the event image in the over-
view or the detail view. Use the  slider to control the number of columns and thus the size of the dis-
played event images.

Instructions:
Move the  slider to the right or left to make the event images larger/smaller, respectively. Move the  
slider to the right to switch from the overview to the detail view of the preview images. Move the  slider 
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to the right to increase the number of columns to show.

Camera Bar and Camera Group Bar
The camera bar and the camera group bar at the upper border of MxManagementCenter provide the means 
for quickly selecting the camera groups or individual cameras. These bars also allow switching views.
 In addition, the icons in the camera images of the camera bar indicate the current status of the cor-
responding camera:     

 n  Camera is not reachable.

 n  Wrong camera password

 n  Privacy mode is active

 n  Limited functionality (only live image access) due to old firmware (<4.0), old camera model 

(M/D/V12, M/D/Q22M) or proxy issue.

 n  Camera password does not grant administrator rights.

Instructions:
Click on the gray frame border to show the bars. To switch between the camera bar and the camera group 
bar, click on the upper frame border of the activated bar. Pull up the lower frame border to close the bars. 

     Set Grid Layout

Auto Grid Mode

By default, the auto grid mode  is used in the grid layout. In auto grid mode, MxMC always tries to dis-
tribute the available space as well as possible according to the specified grid parameters, such as the aspect 
ratio of the tiles (4:3, 16:9, 8:3), the size of the focus window and the number of cameras.    When you change 
the window size, the grid layout adjusts automatically. The following sliders are available to adjust the grid 
layout:

 n : Format of the camera images and the focus window (4:3, 16:9, 8:3) 

 n : Size of the focus window (1x, 2x, ..., 8x the size of the camera images)

 n : Maximum number of cameras

Move the sliders to the desired settings. To close the edit mode, click on .

Context Help
Camera Bar and Camera Group Bar
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Manual Mode

You can use this mode  to position every grid tile of a group (including focus windows) applying the con-
figured primary grid (4:3, 16:9, 8:3) as the basis and change their sizes. You can scale either along the hori-
zontal or vertical axis using multiples of whole numbers for the primary grid tiles. In contrast to the 
automatic grid mode used previously, this feature enables you to use different image formats within one 
group. For example, if the primary grid has an aspect ratio of 4:3, the formats 4:3, 8:3, 16:3, 4:6, etc can be 
used. Likewise, tiles with an aspect ratio of 16:9, 32:9, 16:18, etc. can be created for a primary grid with an 
aspect ratio of 16:9.
 MxMC automatically reduces the absolute size of all tiles and inserts columns and rows to ensure that the 
tiles will be displayed in the desired area if the available space is not sufficient when a tile is moved or 
enlarged (because there is already one in the new position).
 Tiles that are automatically arranged in this manner will be fixed for each window size, which means that 
the tile layout will not be changed when the program window size changes, as opposed to the automatic 
grid layout. 

To switch from auto grid mode to manual mode, move the slider  to the right until you reach the pos-

ition . The following sliders are available in manual mode:

 n : Format of the camera images and the focus window (4:3, 16:9, 8:3) 

 n : Maximum number of cameras

Move the sliders to the desired settings. To move a tile to a different position, move the mouse pointer over 

the tile. Click on  and drag the tile onto the desired position. For better orientation, a blue frame indic-
ates the target position.
 To set the size of a tile based on the selected format, move the mouse pointer over the border of the tile 
until a double arrow is shown. Drag the tile to the desired size. To close the edit mode, click on .

 Executing Hyperlinks
If you have defined hyperlinks, you can execute them by clicking on   . When defining hyperlinks, you can 
select an individual button icon for the hyperlink (there are several predefined icons to choose from) or set 
one button from which to run all hyperlinks.

Instructions:
To define a hyperlink, right-click on  and then on .
 In case you did not assign an icon for the individual hyperlinks, they will be combined under one  button. 
To execute such a hyperlink, click on  and then on the name of the desired hyperlink. 

348 / 375



 User Management
If you want to set up users with different rights for MxManagementCenter, you need to add these users first. 
For this purpose, the application differentiates between "administrator" and "user" roles. You can assign 
rights for users depending on the specific functions they need, whereas the administrator possesses all rights.

Creating Users or Administrators
You need administrator rights to add a new user or establish an additional administrator. Open the user man-

agement  and click on .
User Type and User Name

 1. Enter the corresponding user name. 
 2. Select the desired user type: user or administrator.

 The user type is set to User by default. The sections Weekly profiles and User rights are available for 
users, in contrast to administrators. All other settings apply to both user types and will be used in the fol-
lowing description; however, reference will only be made to User.

 3. Use the Active option to enable the new user immediately or later on.

Password

 1. Enter a password and confirm it.
 2. Use the Expires option if you want to require the user to change the password at regular intervals.
 3. If the user is to change the original password upon the next log in, select the Force change on next log 

in option. 
Note: Activating this option automatically gives the user the "Change Password" right, even if it had 
been disabled before.

 4. The Force Complex Password option ensures that users can only set secure passwords. 
 A secure password has at least eight characters, consists of lowercase and uppercase letters, including at 
least one special character, one digit and one character. Furthermore, it cannot be one of the last thir-
teen passwords used on this user account. If you are trying to set a password that does not meet the cri-
teria, a red frame around the text field will appear.

Log in

Context Help
User Management
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 1. You can establish a specific setting for time ranges in a weekly profile for users who can only access 
MxMC at specific times. This section is not displayed when creating an administrator because the admin-
istrator always has all rights and access to MxMC.
 Click on Edit weekly profiles to create a weekly profile. The Weekly Profiles dialog opens. There are 
two predefined profiles available from the beginning: the Weekend profile (Saturday 00:00 to Sunday 
24:00) and the Working days profile (Monday 00:00 to Friday 24:00). 

 n To add a profile, click on  . Enter a description. Highlight the desired active times in the table. 

You can resize an active time block by clicking on the time block and then moving the borders 
accordingly It is also possible to move a block. Click on the block to select it, then drag the block 
to the new position. To delete a time block, select one first and then click on  .

 n You can change the description of an existing profile. Right-click on the name and overwrite it.

 2. Close the dialog box to finish editing the weekly profiles. You can then use the new (or modified) weekly 
profile in user management. To do so, click on the Weekly Profile box and select the desired profile.
Note: 24 hours is set by default. In this example, the user always has access to MxMC.

 3. Click on the calendar icon to easily invert the settings of the weekly profile. For example, if you have cre-
ated a profile with access on the weekend and would like to activate the alarms for working days, click 
on the Invert checkbox and the profile is used in inverted fashion. 

Log out
In addition, you can specify after how many minutes of inactivity this user will be automatically logged out.
User Rights
Every user has all user rights initially. Deactivate the rights that should not be available for a specific user in 
the User Rights section.
 This section is not displayed when creating an administrator because the administrator always has all rights.

Managing Users

Changing the Rights
Click on the user whose settings you want to edit. Then configure the rights by setting the appropriate 
switches in the User Rights section. 

Deactivating Users
If – for security reasons – you want to prevent a particular user from logging in, you can deactivate that user. 
This prevents the user from logging in, but all settings remain in the system. To do this, select the user and 
deactivate the Active option.

Deleting Users
Click on  and   then on  next to the user you want to remove.
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Temporarily Assigning Supervisor Passwords to Functions
Certain situations may require users to execute functions for which they usually do not have the rights.   
These functions can be made available temporarily using a supervisor password.

 1. Click on Supervisor to protect functions with a supervisor password.
 2. In addition, you can specify after how many minutes of inactivity this user will be logged out auto-

matically.
Note: While a recording is being played back in Playback view or in Grid Playback, MxMC does not auto-
matically terminate the supervisor mode after the specified period of time.

 3. Select the functions that can be accessed after entering the password.

 Setting Group Functions
Group functions in the Grid and the Graphic views enable you to switch on/off a light, open a door or make 
an announcement for one camera group, regardless of the selected camera. You can also assign the functions 
for switching on/off lights and opening doors to several cameras of this group, enabling you to switch on/off 
several lights or open several doors by clicking on the corresponding group button.

 Set Reference Time
Use this option if you want to see whether and what several cameras have recorded at a specific point in 
time.

Instructions:

 1. Right-click on  and enter the date and time to search for.

 2. Drag the cameras from the Camera bar or the Device bar one by one.
 3. The application shows the event images of each camera that are closest to the specified point in time.

Entering MxThinClient Settings
Name 
 The name for the MxThinClient that is shown in the Device bar. You can freely select the name and it does 
not have to be unique.

Context Help
Setting Group Functions
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Serial Number
 The serial number is the factory-defined IP address that is printed on the housing of the MxThinClient. 
Remember that you need to enter the number correctly because it represents the address at which the MxTh-
inClient is accessed in the MxMessageSystem.
URL (optional setting)
 The IP address or DNS domain name at which the MxThinClient can be accessed.
User Name and Password (optional setting)
 The access data on the MxThinClient that you entered when installing the MxThinClient.
Display Resolution
 Here you can select the resolution that the camera’s live image uses when data is sent to the display unit. If 
the display unit does not support the desired format, the MxThinClient displays the message Resolution not 
supported on the monitor.
Camera Display Time
 You can select how long the armed camera’s live image is displayed before the MxThinClient continues with 
displaying the normal sequence of configured image sources.
 If you select Unlimited for the display length, the camera’s live image is displayed until the MxThinClient 
receives a new command, such as when an event is triggered when it receives MxMessages from other cam-
eras/devices in the network. 
 If you want to stop the display of the camera’s live image before the set display length elapses, click on the 

 icon. It appears when you move the mouse pointer over the name of the MxThinClient in the Device bar.

Searching Transaction Data
In the Smart Data View you can search and filter Smart Data (transaction data) of one or more MOBOTIX IOT 
Cameras.

Defining Search Queries
You can define and store several search queries. Enter a name for each search. The search query will be auto-
matically saved every time the search criteria are changed. This also happens when individual search para-
meters and terms are changed.

 1. By default there is one search query already. Click on the tab and enter the desired name.
 2. Select the desired cash points. You can select more than one or even all cash points for a search query.
 3. Specify the period of time for the search. You can also enter a period of time that allows you to enter any 

start and end time stamp, in addition to a series of preset time windows (including “today”). 
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 4. You define the search criteria to limit the scope of the search once you have selected the cash points and 
defined the period of time for the search. Click on   to do so. A new line will be inserted.

    The individual criteria can be linked using AND or OR. The logical search operators can only be applied 
to all search criteria at the same time. Select  to link the search criteria using AND and  to link them 

using OR.
Please note that the search criteria are only applied to individual transaction rows, e.g., a search for a 
total > 100 and < 150. For the time being, it is not possible to apply the search to all transaction rows of a 
receipt, e. g., the search for a specific item linked to the total amount > 100.

 5. Click on  to delete a search criterion.

 6. Click on  to define further search queries, in addition to the most recent search query. Enter a name 

and repeat steps 1–5. 

Deleting Search Queries
Click on  to the left of the name for the search query to delete a search query.

Reloading Searches
A new search is performed on the Smart Data on the camera with the filter when the search query is 
reloaded. The search results are displayed again. Click on  to reload a search query.

Displaying Search Results
The search results are displayed with preview images in a list with a detailed display of the cash point data 
or in tiles, depending on the selected display format from the Command bar (List view  or Tile view ).

 Previous Image
You first set the desired mode for browsing the recordings in the Playback mode, for example, using one 
hour or all highlighted events.  Depending on this setting, this button will jump to the previous image in the 
recording (starting from the current image). 

Camera Date and Camera Time
If the date and time display is flashing, the system time of the computer deviates from the system time of the 
camera by more than one minute. If this happens, make sure that the correct time is set on the computer. In 

Context Help
Previous Image
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addition, you need to make sure that the camera is attached to a time server and that it gets valid time 
information.

 Switching Lights
If a camera is connected to a light switch and has been configured accordingly, you can click on           to 
switch the lights on or off in the Live view. The light icon in the status display is blue as long as the lights are 
on.
Switching the Lights of Other Cameras
 Right-click on . All cameras connected to a light switch are listed in the context menu. To switch indi-
vidual lights on or off, activate/deactivate the Lights function next to the camera name.
          To switch all lights on, click on All on. To switch all lights off, click on All off.     

 Undo the Last Change
Click on  to undo the last change.

 Applying Modified Values
You can make changes by pressing Enter or selecting the new value in the Configuration view. The changes 
made here are not automatically adopted because it could potentially cause problems with the network set-
tings. 
 When a value is changed and the background of the white checkmark is red, it indicates that the change has 
not been implemented yet. Click  to make this change.

General Settings
The general topics on operating the cameras are found in the general settings. 
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Arming
The main arming feature needs to be activated in order to process events, execute actions and notifications 
and record images and audio data. 

Parameter Explanation

Activated The camera is always armed.

Off  The camera is not armed: no image storage, actions or messages.

CS Arming is controlled via a custom signal that needs to be previously configured on the cam-
era. The camera can use a signal input or connected MX-GPS-Box, for example, as the main 
switch for arming by using the custom signal.               

From master The camera is armed only when the master camera is armed.

See also:  n Recording/Arming

 n MxActivitySensor

Frequency of Power Supply
If the camera’s exposure control is not matched to the frequency of the power supply, sources of artificial 
lighting may lead to image interference. This parameter sets the camera to the power supply frequency of the 
respective country to prevent interference.

Parameter Explanation

No artificial 
light

If the camera is used in daylight conditions (rather than with artificial lighting), you can also 
use the No artificial light setting.

50 Hz  The factory default setting for Europe is 50 Hz.

60 Hz  Set the power supply frequency to 60 Hz for Canada, the U.S. and Japan. 

Audio Source
Select the desired audio source. It is also possible to integrate an external audio source, in addition to using 
the camera’s microphone. The audio source is used for two-way communication and recording audio data, 
for example. 

Context Help
General Settings

355 / 375



Context Help
Image Settings

Image Settings

Resolution
You can select a predefined resolution or determine a user-defined size to determine the image size of the 
live image. If you select the User-defined size option, the image size that was defined for this option in the 
camera web interface is used. Dual images (right and left image sensor) automatically require twice the 
width. 

JPEG Quality
The JPEG quality influences both the image quality as well as the file size of the JPEG and MxPEG files gen-
erated by the camera. 
 Using a compression of 60% (default) will usually deliver good-quality images that are suitable for most pur-
poses. If the value is lower than 20%, you can see pixelation within the image. For values higher than 70%, 
differences to the uncompressed original image are hardly visible. The file size, however, may increase to 
more than 100 kB (for a 640x480 pixel image).

Camera Selection
On Dual cameras, select the image sensor to use when displaying the images: right image sensor, left image 
sensor, both image sensors or automatic day/night switching.
 When configuring the image settings for both sensors, first select the sensor you want to configure using the 
left or right checkbox in the live image preview window and enter the settings you want.       

Display Mode
There are various display modes available depending on the camera model.

All Cameras Except Hemispheric Models
 n Full image: The entire live image from the camera is displayed.

 n Lens correction: This option displays a portion of the live camera image (with lens correction). 
This option is only available for L22 lenses, provided that the camera configuration is adjusted 
accordingly.

 n Picture-in-Picture: This option displays a small image from one camera sensor inset in the 
large image of the other. This setting is available on MOBOTIX Dual models only.

 n Picture in Zoom: This option displays a small version of the entire live camera image in the 
lower right corner of the large live camera image. This way, the entire image is visible even 
when the live image is zoomed.

 n Event in Picture: This option displays a small version of the latest event image in the lower 
right corner of the large live camera image.
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Hemispheric Models
 n Full image: The entire (distorted) full image of the image sensor is displayed.

 n Normal: A corrected image is displayed. This image can be panned and tilted. This is the factory 
default for hemispheric cameras.

 n Surround: This option shows four image sections (one for each cardinal direction: N, E, S, W) in 
one joint view. Note that you can use PTZ actions to modify all four views independently from 
one another.

 n Panorama: This option shows the distortion-corrected image of an entire room (corrected 180° 
panorama view) from the left to the right wall. The aspect ratio (width to height) is 8:3.

 n Panorama focus: This display mode combines the panorama view (aspect ratio 8:3) with two 
smaller images (each with aspect ratio 4:3) in one large image.

 n Double panorama: This mode shows a panorama view for the North half of the image and a 
second panorama view of the South half of the image using an aspect ratio (width to height) of 
4:3. This view only makes sense for the ceiling-mounted MOBOTIX Hemispheric model. Both par-
tial views (North and South) can be changed independently of each other using PTZ commands.

Installation
You can set the mounting position of a MOBOTIX Hemispheric camera: wall, ceiling or floor. The mounting 
positions are set separately for the left and right lenses for cameras with two active image sensors.

Exposure Window
Exposure windows are used to ensure the proper exposure/brightness for the live camera image. 

Custom
Creating and editing custom exposure windows. Select the Custom option and click in the live image 
at the bottom. You can execute the following actions with the icons that appear:              

 n Create exposure windows: Draw a window using the mouse pointer.

 n Move exposure windows: Left-click with the mouse pointer on the exposure window and drag 
it to the desired position.

 n Modify exposure windows: Place the mouse pointer on one of the white squares until you see 

the  icon. Left-click with the mouse and drag the window making it larger or smaller.

 n Delete exposure windows: Click .

Visible Image Area
This setting enables you to use the current visible image section as the exposure window.           
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Predefined
You can use a number of predefined exposure windows: When you select the corresponding window, 
it will be displayed in the live image for review. A predefined exposure window is always applied to 
the full-image area, that is, the entire image of the sensor.                             

 n Full image: Entire area of the image.

 n Quarter: An exposure window at the image center that covers a quarter of the viewable image 
area.

 n Center: One exposure window at the image center.

 n Spot: One small exposure window at the image center.

 n Top: One horizontal exposure window at the top of the image.

 n Center: One horizontal exposure window at the image center.

 n Bottom: One horizontal exposure window at the bottom of the image.

 n Right: One vertical exposure window at the right border of the image.

 n Vertical: One vertical exposure window at the image center.

 n Left: One vertical exposure window at the left border of the image.

 n Right AND left: Two vertical exposure windows at the left and right borders of the image.

Exposure Program
These parameters influence the balance between an exposure time that is as short as possible and hardware 
amplification that is as low as possible. The objective is to reach a fair compromise between clear images of 
moving objects (short exposure time, high amplification) and as little image noise as possible (long exposure 
time, low amplification).

 n 0: Default program.

 n Negative: The programs will reduce exposure times to decrease motion blurring; could increase image 
noise.

 n Positive: The programs will increase exposure times to reduce image noise; exposure in very bright 
environments is not impacted.

Maximum Exposure Time
This parameter determines the longest exposure time used by the camera. This setting enables you to either 
avoid motion blurring as lighting conditions decrease, or even specifically allow it.   Select shorter maximum 
exposure times if you do not want motion blurring. You can use a longer maximum exposure time (max. of 
1/1 = 1 second, for example) if you want the camera to produce images with good exposure (with motion 
blurring), even in low light situations.           
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Time
The date and time can be manually set, adopted from the computer, or continuously synchronized through a 
time server. If you use a time server, the clock can be synchronized using a time server over the Internet, a 
time server service in the local network or another MOBOTIX camera. In this case, you need to access the 
camera web interface (Admin > Camera Administration > Time and Date > Use Camera as Time Server) 
in the Admin menu and activate the time server.       

Automatically Synchronize Using a Time Server
Two protocols are available for synchronizing the camera using a time server: NTP and Time Protocol.           

Parameter Explanation

Time 
Server
 and 
 Time 
Server 
Address

 n NTP: With this protocol, the camera continuously synchronizes with one or more NTP 
time servers. If the NTP protocol has been selected, you can enter up to five time servers 
under Time server address. Theses servers must support the protocol specified in RFC 
1305. A green dot to the right of the time server address indicates that the time server is 
accessible and offers an NTP service. It can take a moment for the camera to connect to 
the time server and the dot to turn green.

 n Time Protocol: With this protocol, the camera synchronizes every six hours (and when it 
is rebooted). If Time Protocol (RFC 868) is selected, enter the Time server address in 
this box. The server must support the protocol specified in RFC 868.

Current 
Time

Display time of the current camera

Time Zone Select the correct time zone for the camera location.

Do Not Adjust Automatically
Deactivate automatic synchronization if the date and time are set automatically or if they are adopted from 
the computer. 

Parameter Explanation

Current Time Display time of the current camera
 If the camera’s time deviates from the computer’s time, click on Use PC time to adopt the 
computer’s time.

Set time manu-
ally

Capture the desired data to manually set the date and time and click on Set time to con-
firm the entry.

Time Zone Select the correct time zone for the camera location.
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 Expert Settings
Various sections of the configuration contain additional settings for handling special aspects of camera beha-
vior. For everyday use, however, these settings are not really needed in MxMC.

Note:
that these settings have been combined as expert settings in the different sections. Click on   to open the 

expert settings.

 Save Configurations
Changes to the configuration are only temporary. To use the current settings after the next reboot of the cam-
era, you have to permanently store the configuration. To do so, click on Store configuration . The pro-
gram opens a system prompt. In the prompt, click on Save.
If you have modified the configuration temporarily and do not intend to keep the changes, you can retrieve 
the last configuration that has been stored permanently. To do so, click on Save configuration . The pro-
gram opens a system prompt. In the prompt, click on Discard.

   Resetting to Factory Settings
Click  to reset all parameters for the current camera to the factory settings.

Configuration Bar
You can enter parameters for a camera in the Configuration view. If you want, you can display the parameters 
available for the other cameras in the group by viewing them in the Configuration Bar.
You can also change the settings of one or more cameras in the group, without having to switch to a dif-
ferent camera or camera group.
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Displaying the Settings of Other Cameras in the Group
Click on the corresponding name of the parameter in the Configuration view to displaying the settings of 
other cameras in the group. It turns yellow and the Configuration bar shows all values associated with this 
parameter for this group. The cameras for which this value is set are assigned to the individual values.

Changing Parameters
You can also change the parameters of one or more cameras in the Configuration bar, without having to 
switch to a different camera in the group. To do so, highlight the desired camera and drag it onto the para-
meter value you want to set. The destination area turns yellow.
If you want to change the value that is used by more than one camera, select the desired value in the para-
meter selection box.           

MxActivitySensor
The MxActivitySensor is a camera-internal video motion detector that can identify direction of motion detec-
tion and object size while blocking out any undesired interference (such as trees swaying in the wind) when 
detecting motion. There is an MxActivitySensor profile that is preset in the factory settings and contains all 
settings necessary to operate the MxActivitySensor.
 You can activate and deactivate this profile here, change the name of the profile, adjust the event dead time, 
change the detection range and define new areas. 

Active
The MxActivitySensor profile is also activated when the Arming feature is enabled in the general settings. 

Profile Name
You can change the preset profile name.

Event Dead Time
The event dead time defines a period of time (0–3600 sec.) after an event during which no new events from 
the same profile are detected. By defining an event dead time you can avoid, for example, that a complex 
action (person walks through the active image area) triggers multiple events. You can adjust the preset event 
dead time (5 sec.).

Context Help
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Edit Detection Area
Proceed as follows to adjust the default detection area or to define additional image areas:
 Click in the green detection area. You can execute the following actions with the icons that appear:

Action Explanation

Change Size of 
Detection Area

Place the mouse pointer on one of the white squares until you see the  icon. Then left-

click with the mouse and resize the detection area making larger or smaller.

Move Detec-
tion Area

Place the mouse pointer on the detection area. Then left-click with the mouse to drag the 
detection area to the desired position.

Rotate Detec-
tion Area

Click on  and right-click with the mouse to rotate the detection area clockwise or coun-

terclockwise.

Change Shape 
of Detection 
Area

Switch to polygon mode by clicking on . You will see white corner points on the 

corners. Drag the corner points to the desired position. You can insert new corner points by 
right-clicking on the white line or in the detection area. Right-click on a dot to delete a 
corner point. Then click on .

Deleting a 
Detection Win-
dow

Click on .

Creating Addi-
tional Detec-
tion Window

Draw a new window with the mouse. 

Blocking Areas 
Within the 
Detection Area 
from Analysis

You can define an area within the detection area that is blocked from the analysis.
 Drag a window corresponding to the size and position to the area that should be blocked 
from the analysis. Click in the window and keep the mouse button depressed until two 
icons appear. Click on  to determine the exclusion window. The window turns red. 

Drag another window and position it so that it covers the desired detection area.

Network
Your network interface settings determine how the camera can communicate with the “outside” world and 
how the camera can be accessed from outside of the local network.
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Internal Host Name
The host name is the unique camera name in the network under which it is accessible.

BOOTP/DHCP
BOOTP and DHCP are protocols with which IP addresses can be managed in a network and automatically 
assigned. The camera can use them to automatically obtain its network configuration.            

Parameter Explanation

Off The camera’s network configuration is manually established. Enter the appropriate information 
in the IP address and subnet mask boxes and, if necessary, change the standard route or gate-
way and the DNS server.

IP Address
You can access the camera in the network via its IP address. Ask your network administrator 
which IP address is available.

Subnet Mask
A matching subnet mask needs to be entered for the IP address in order for computers to be 
able to communicate in a network. Again, it is your network administrator who will tell you 
which subnet mask to use.

Default Gateway
The gateway acts a relay between individual networks and it coordinates the data traffic 
between these networks. Enter the IP address of the gateway that should be used.

DNS Server
A Domain Name Service (DNS) resolves computer names to IP addresses. If you have a DNS on 
your network, you can specify up to three IP addresses of DNS servers. This is only necessary if 
you want to address computers using their name instead of their IP address for other con-
figurations (FTP, email). 

On
 client 
mode  

Use BOOTP/DHCP to set the IP address and network configuration automatically. The gateways 
and the default route are automatically determined via BOOTP/DHCP and configured.

On
 server 

This camera provides DHCP service to clients on the local network. The IP address of the cam-
era will be 192.168.0.19 with subnet mask 255.255.255.0 by default.
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mode 

Default Gateway
Enter the IP address of the gateway that should be used.

DNS Server
A Domain Name Service (DNS) resolves computer names to IP addresses. If you have a DNS on 
your network, you can specify up to three IP addresses of DNS servers. This is only necessary if 
you want to address computers using their name instead of their IP address for other con-
figurations (FTP, email). 

Additional IP Address
The camera can manage two different network configurations. If you enable this checkbox, the factory 
default IP address and the subnet mask will also be used, ensuring that the camera remains accessible at all 
times.

Recording
You can make the most important settings for recordings in this dialog box.

Arming
The arming feature for event control handles camera recording. However, the main arming of the camera 
needs to be activated in order to make the recordings in the first place.

Parameter Explanation

Off  The recording feature is deactivated.
 No further parameters will be displayed.

Activated The recording features of the camera are activated (default setting). 

CS The recording is activated by a custom signal (CS).

From master The recording feature of the camera will only be enabled if recording has also been activated 
on the master camera.
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Recording Mode
You can select the type of recording for events and story images. The availability of the parameters will 
depend on the recording mode you select.

Recording 
Type

Parameter

Snap Shot 
Recording

This option will save individual pre- and post-alarm images (JPEG images), but without sound. 

Snap Shot Interval
This option determines the amount of time between the individual pre-alarm and post-alarm 
images. You can set values from zero to ten minutes (max.). 

Pre-alarm Images
Number of the image that are recorded before the event.

Post-alarm Images
Number of the image that are recorded after the event.

Recording Time Unlimited
The time to keep is set to unlimited by default. You can select a maximum time to keep, 
expressed in hours and days, if you deactivate this option. 
 The maximum value for time to keep indicates how long images and video clips need to be 
stored. 

Event 
Recording

This option stores clip files for every event using the MxPEG codec with variable frame rate 
and optional audio data.

Record Audio Data
Audio data can be recorded if it is available in the camera. Set this option to active to activ-
ate the microphone.

Event Frame Rate
Recording speed if an event is detected, expressed in frames (fps) or seconds (s).

Recording Time Before Event
Time (in seconds) to include in recorded stream before an event has occurred.
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Recording Time After Event
Time (in seconds or minutes) to include in recorded stream after an event has occurred.

Recording Time Unlimited
The time to keep is set to unlimited by default. You can select a maximum time to keep, 
expressed in hours and days, if you deactivate this option. 
 The maximum value for time to keep indicates how long images and video clips need to be 
stored. 

Continuous 
Recording

Continually saves video and (optionally) audio data as MxPEG clips. 

Record Audio Data
Similar to Event Recording, audio data from the camera be recorded with the same quality, 
regardless of the frame rate. Set this option to active to activate the microphone.

Frame Rate
Recording speed for continuous recording. 

Recording Time Unlimited
The time to keep is set to unlimited by default. You can select a maximum time to keep, 
expressed in hours and days, if you deactivate this option. 
 The maximum value for time to keep indicates how long images and video clips need to be 
stored. 

 Redo the Last Change
Click on  to redo the last change.

License Management
You can view a list of all licenses that have been activated on this computer in License management.
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Name Explanation

Product Name of the licensed function.

Expiration The license is either valid indefinitely or it expires on a specific date, which is listed in this 
column.

Quantity Number of licenses that were purchased for a product. 

Device ID Unique identifier that is determined by MxMC for the used device. Note the device ID and keep it 
accessible if you should run into any problems during licensing.

Activate Licenses

 1. Click on Activate licenses to activate licenses. The dialog box used for activating licenses appears.
 2. Enter a valid activation ID and establish the number of licenses that will be installed on this computer.
 3. Click on  if you want to license an additional product. Enter the corresponding activation ID in the 

new line and enter the number of desired licenses.
 4. Click on  to delete a line.

 5. When you are finished entering all activation IDs, click on Activate.
 n Activation successful

If activation was successful, you can return to License Management, p. 366 or relaunch MxMC for the 
changes to be applied.

 n Activation failed (no Internet connection)
MxMC connects to the license server for activation. It needs to establish an Internet connection. An 
error message appears if there is no Internet connection. It will then save an offline request file (*.lic).
A partner/installation technician can generate a capability response file (*.bin file) using this file. If 
you have received on, open the Activate licenses window (menu Window > Licenses > Activate 
licenses) and click on Load capability response file.
If the capability response file was successfully loaded, you can return to License Management, p. 366 
or relaunch MxMC for the changes to be applied.

Update
When launching the program, it does not automatically compare the licenses on the computer with the 
license server. For this reason, you need to click on Update to reload the licenses from the server. 
Note: You need administrator rights to activate or update licenses.
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   Edit Network Data
The camera list allows editing the network data not only of one camera (by double-clicking on the URL), but 
also of several cameras at once. To do so, select the desired cameras and click on . It would make sense to 
have the DHCP server also assign the camera’s IP addresses if your computer gets its IP address automatically 
from a DHCP server (your DSL router, for example). To do so, activate the Automatic IP address option. If 
you have assigned a fixed IP address to your computer, you will certainly prefer to assign fixed IP addresses 
to the cameras as well. To do so, enter the first camera’s IP address and the subnet mask. The IP addresses 
are incremented automatically for all selected cameras.

   Add Cameras
Use this wizard to quickly and easily integrate your cameras and door stations into MxManagementCenter. To 
do so, click on  and complete the individual steps.

   Rename a Camera 
The camera list allows renaming not only one camera (by double-clicking on the camera name), but also sev-
eral cameras at once. To do so, select the desired cameras and click on . Enter a new camera name, such 
as “Parking lot.” All selected cameras are renamed to "Parking Lot_001", "Parking Lot_002", etc.

   Change the Camera Access Data
The camera list allows editing the access data not only of one camera (by double-clicking on the user name 
and password), but also of several cameras at once. To do so, select the desired cameras and click on . 
Enter the new user name and password. All selected cameras get the new access data.
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   Next Page
Click on  to show the next page.

   Importing *.mxu files
You can conveniently add large numbers of cameras, camera groups, devices and recordings/clips using a list 
that you manually generate in MxMC as an *.mxu file. You need to adhere to specific rules for the format 
when creating the list in order to correctly export the contents of the *.mxu file. 
Important: When you import *.mxu files, it does not replace the project import, in which program settings, 
such as settings for the cameras and camera groups with assigned layouts, are imported. 

Format for Simple Imports
An *.mxu file needs to use the following format for a simple import of cameras:

 n Unformatted UTF-8 text

 n One or more camera lines with the following structure:
Name<TAB>IP<TAB>Username<TAB>Password<CR LF/LF>

 n Elements in a camera line need to use TABs as separators.

 n Line breaks are either CR LF (Windows) or LF (UNIX).

 n Comment lines are preceded by a //.

 n Camera names need to be unique and cameras using the same name will not be added more than 
once.

Example:       Main Entrance   10.6.37.25   admin   meinsm
       Side Entrance   10.6.15.206  admin   meinsm

       Entrance Gate   10.6.23.132  admin   meinsm

Format for Advanced Imports
The file needs to adhere to additional rules for the format when importing cameras, groups, clips and set-
tings for graphics and grid view.
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Importing MXU Files

 1. Click on Import MXU to import cameras and camera groups in the Welcome wizard. You can save the 
existing project, if necessary.

 2. Open the *.mxu file.
 3. Decide whether the cameras and groups from the *.mxu file should replace the entire configuration or 

they should be only added.

Creating MXU Files for Imports
You can conveniently add large numbers of cameras, camera groups, devices and recordings/clips using a list 
that you manually generate in MxMC as an *.mxu file. There are several format specifications that need to be 
followed when generating an *.mxu file.       

Format for Simple Imports
An *.mxu file needs to use the following format for a simple import of cameras:

 n Unformatted UTF-8 text

 n One or more camera lines with the following structure:
Name<TAB>IP<TAB>Username<TAB>Password<CR LF/LF>

 n Elements in a camera line need to use TABs as separators.

 n Line breaks are either CR LF (Windows) or LF (UNIX).

 n Comment lines are preceded by a //.

 n Camera names need to be unique and cameras using the same name will not be added more than 
once.

Example:       Main Entrance   10.6.37.25   admin   meinsm
       Side Entrance   10.6.15.206  admin   meinsm

       Entrance Gate   10.6.23.132  admin   meinsm
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Format for Advanced Imports

Expanded Format
The file needs to use the following format for the advanced import of cameras, groups, clips and settings for 
graphics and grid view:

 n The first line must contain the string #EXTMXU

 n Any additional commands must start with #EXT. Parameters use “:” as separators. 
Example:#EXTGROUP:Doorstations

Commands for advanced imports
#EXTMXU Markers for beginning of file 

#EXTGROUP:name:f:r:icon:map:info Group “name” is created and all further cameras will be added to this 
group. 

f: Large focus window (0=0x, 1=1x, 2=2x ...) 

r: Tile ratio (0=4:3, 1=HD, 2=8:3) 

icon: If numeric, index of the internal group icons; otherwise, file name 
corresponding to the *.mxu file. 

map: File name of the background image 

info: File name of the information page 

#EXTGROUP: All further cameras will not be added to a group if no name is specified 
(unless “All cameras”). 

#EXTCLIP:clipMXG Camera demo clip is added. Clips need to be stored in the same dir-
ectory as the *.mxu file.

#EXTMXPEG:name<TAB>clipMXG MxPEG clip with “name” is added. clipMXG is the absolute path of the 
clip file to be imported.

#EXTCURRENTCAMERA:name Select camera. 

#EXTCURRENTGROUP:name Select group. 

#EXTSUBGROUPS:name The following groups (each with the name in a line) are added to the 
group “name” as a subgroup.

#EXTMXFSS:name<TAB>folder_
path

MxFileServer recording with “name” is added. folder_path is the abso-
lute path of the recording.

#EXTMXFFS:name<TAB>folder_path MxFFS recording with “name” is added. folder_path is the absolute 
path of the recording.

#EXTTHINCLIENT:name<TAB> MxThinClient is added. The parameters use TAB as separators.

Context Help
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serNo<TAB>url<TAB>username
<TAB>password<TAB>duration 
<TAB>resolution 

#EXTINFO:Comment Comment line. 

#EXTEND End of file, all further lines are ignored. 

Example:       #EXTMXU
       #EXTGROUP:Doorstations:2:2:2

             Main Entrance           10.6.37.25        admin   meinsm

             Side Entrance           10.6.15.206       admin   meinsm

 

       #EXTGROUP:Indoor:2:2:3

             Building East           10.3.31.251       admin   meinsm

             Building West           10.7.25.186       admin   meinsm

             Staircase               10.6.115.57       admin   meinsm

             Canteen                 10.12.32.65       admin   meinsm

 

       #EXTGROUP:Outdoor:2:2:4

             Parking Visitors        10.5.46.39        admin   meinsm

             Parking Employees       10.10.231.107     admin   meinsm

 

       #EXTGROUP:Dual Cams:2:2:10

             Checkout1               10.10.106.26      admin   meinsm

             Checkout2               10.10.152.225     admin   meinsm

             Checkout3               10.13.242.195     admin   meinsm

 

       #EXTGROUP:Faststreams:2:0:11

             Ground Floor            10.2.2.169        admin   meinsm

             First Floor             10.2.104.130      admin   meinsm

             Second Floor            10.3.11.51        admin   meinsm

             Elevator                10.3.209.198      admin   meinsm

 

       #EXTGROUP:Clips:2:2:groupIcon.png:groupMap.jpg

       #EXTCLIP:FiremanMXG

       #EXTCLIP:PoleMXG

 

       #EXTCURRENTCAMERA:Main Entrance

       #EXTCURRENTGROUP:Doorstations
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   Import MxControlCenter
If you have already used MxControlCenter, you can import the existing configurations from MxControlCenter 
into MxManagementCenter. This speeds up things because you will not have to add the cameras or recon-
figure the program settings.

   Import MxEasy
If you have already used MxEasy and you want to use the same cameras and the same settings, you can 
import the existing configurations from MxEasy into MxManagementCenter. This speed up things because 
you will not have to add the cameras or reconfigure the program settings.

   List View
The cameras found on the local network using Bonjour can be displayed either in a list or as tiles. Click on 

 to display the camera in a list.

   Open and Integrate an Existing Project
MxManagementCenter allows saving the current cameras and camera groups with all settings as a "project" 
at any time. If a project had been stored by a different installation of MxManagementCenter, you can integ-
rate this project into your own MxManagementCenter installation. Click on   to do so.

   Previous Page
Click on  to show the previous page.
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   Search Cameras
The Welcome wizard automatically starts searching for MOBOTIX cameras when it is launched. Click on  
to stop the camera search. All found cameras are displayed either in a list  or as tiles . The counter near 
the  button shows the number of cameras that have been found, but not yet integrated into the system. 
Note: If you are using encryption to access the cameras under Windows, it can happen that no cameras are 
found. In this case you should change the search mode by right-clicking on  and selecting the SSL option.

Search Filters
You can narrow down the list of displayed cameras by entering a filter in this field.   Possible filters in this 
field are the camera name, IP address and camera model.               

   Log in User
If several users have been configured on this installation, the log in dialog opens after starting the program. 
Click on your user name  and enter the password.

   Removing All Cameras and Camera Groups
Click on  to remove all cameras and camera groups from MxManagementCenter.

   Update Software
If a camera uses an older software, the program will indicate this in the camera list. To update the software 
on all devices, click on .
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   Tile View
The cameras found on the local network using Bonjour can be displayed either as tiles or as a list. Click on 

 to display the camera as tiles.

Activate Licenses
 1. Enter a valid activation ID and establish the number of licenses that will be installed on this computer.
 2. Click on  if you want to license an additional product. Enter the corresponding activation ID in the 

new line and enter the number of desired licenses.
 3. Click on  to delete a line.

 4. When you are finished entering all activation IDs, click on Activate.
 n Activation successful

If activation was successful, you can return to License Management or relaunch MxMC for the changes 
to be applied.

 n Activation failed (no Internet connection)
MxMC connects to the license server for activation. It needs to establish an Internet connection. An 
error message appears if there is no Internet connection. It will then save an offline request file (*.lic).
A partner/installation technician can generate a capability response file (*.bin file) using this file. If 
you have received on, open the Activate licenses window (menu Window > Licenses > Activate 
licenses) and click on Load capability response file.
If the capability response file was successfully loaded, you can return to License Management or 
relaunch MxMC for the changes to be applied.

Context Help
Tile View
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